
Oracle® Applications Desktop Integrator
User Guide 

Release 7.2 for Windows

Part No. B13840-01

August 2004



Oracle Applications Desktop Integrator User Guide, Release 7.2 for Windows

Part No. B13840-01

Copyright © 1996, 2004, Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; 
they are provided under a license agreement containing restrictions on use and disclosure and are also 
protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, 
disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability 
with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems 
in the documentation, please report them to us in writing. This document is not warranted to be 
error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of 
these Programs may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the 
Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical 
data delivered to U.S. Government customers are "commercial computer software" or "commercial 
technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific 
supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the 
Programs, including documentation and technical data, shall be subject to the licensing restrictions set 
forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set 
forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle 
Corporation, 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and we disclaim liability for any damages caused by such use of the Programs.

The Programs may provide links to Web sites and access to content, products, and services from third 
parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web 
sites. You bear all risks associated with the use of such content. If you choose to purchase any products 
or services from a third party, the relationship is directly between you and the third party. Oracle is not 
responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the 
agreement with the third party, including delivery of products or services and warranty obligations 
related to purchased products or services. Oracle is not responsible for any loss or damage of any sort 
that you may incur from dealing with any third party. 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be 
trademarks of their respective owners.



Contents

Send Us Your Comments ...................................................................................................................    ix

Preface............................................................................................................................................................    xi

1 Introduction to Oracle ADI

1.1 Overview ................................................................................................................................    1-2
1.2 Oracle ADI Key Features......................................................................................................    1-3
1.3 Oracle ADI Integrations .......................................................................................................    1-3
1.4 What’s New in this Release..................................................................................................    1-3
1.5 Signing onto ADI...................................................................................................................    1-4
1.6 Using the ADI Toolbar .........................................................................................................    1-5
1.7 Selecting an Applications Database....................................................................................    1-6
1.8 Choosing a Responsibility....................................................................................................    1-7
1.8.1 Changing Responsibility ...............................................................................................    1-8
1.9 Terms and Definitions ..........................................................................................................    1-8

2 Using the Budget Wizard

2.1 Overview of ADI Budget Wizard .......................................................................................    2-2
2.2 Working with Budget Worksheets .....................................................................................    2-2
2.2.1 Creating a Budget Worksheet ......................................................................................    2-2
2.2.2 Inserting a New Budget Account.................................................................................    2-3
2.2.3 Opening a Budget Worksheet ......................................................................................    2-4
2.2.4 Saving the Budget Worksheet to a Disk .....................................................................    2-4
2.2.5 Using Notes.....................................................................................................................    2-4
 iii



2.3 Changing Budget Parameters ..............................................................................................    2-6
2.3.1 Specifying Budget Criteria ............................................................................................    2-6
2.3.2 Limiting Number of Accounts in the Budget Worksheet.........................................    2-7
2.3.3 Changing Display Characteristics of Account Segments .........................................    2-7
2.3.4 Specifying Worksheet Options.....................................................................................    2-8
2.4 Working with Open Budget Worksheets...........................................................................    2-9
2.5 Updating Budget Balances .................................................................................................    2-10
2.5.1 Updating Budget Balances Manually........................................................................    2-10
2.5.2 Updating Budget Balances Using Budget Rules......................................................    2-10
2.6 Uploading Budgets from ADI to GL ................................................................................    2-12
2.6.1 Uploading Budget Balances from Worksheet to Interface Table ..........................    2-12
2.6.2 Importing Budget Balances from Interface Table to GL.........................................    2-14
2.7 Viewing Budgets Graphically Using ADI........................................................................    2-15
2.7.1 Creating a Graph with Budget Values ......................................................................    2-15

3 Using the Journal Wizard

3.1 Overview of Journal Wizard................................................................................................    3-2
3.2 Working with Journal Worksheets .....................................................................................    3-2
3.2.1 Creating a Journal Worksheet ......................................................................................    3-2
3.2.2 Creating Additional Journal Worksheets in the Same Session................................    3-4
3.2.3 Saving the Journal Worksheet to a Disk .....................................................................    3-4
3.2.4 Opening a Saved Journal Worksheet ..........................................................................    3-4
3.3 Customizing Journal Worksheets .......................................................................................    3-4
3.4 Creating Journal Entries .......................................................................................................    3-7
3.4.1 Creating Functional Actuals, Budgets or Encumbrances .........................................    3-8
3.4.2 Creating Foreign Actuals ..............................................................................................    3-8
3.5 Uploading Journal Entries..................................................................................................    3-10
3.5.1 Profile Options that Determine the Journal Upload Process .................................    3-10
3.5.2 Uploading Journal Entries from Worksheet to Interface Table .............................    3-12
3.5.3 Importing Journals from the Interface Table to GL.................................................    3-14

4 Using the Report Wizard

4.1 Overview of ADI Report Wizard ........................................................................................    4-2
4.2 Report Wizard Interface and Tools.....................................................................................    4-2
4.2.1 Report Wizard Interface ................................................................................................    4-2
iv



4.2.2 Report Wizard Tools......................................................................................................    4-3
4.3 Working with Reports ..........................................................................................................    4-4
4.3.1 Creating a Blank Report ................................................................................................    4-5
4.3.2 Creating a Report Using Report Components ...........................................................    4-6
4.3.3 Loading an Existing Report ..........................................................................................    4-8
4.3.4 Opening a Saved Report ...............................................................................................    4-8
4.3.5 Adding or Deleting Rows and Columns ....................................................................    4-8
4.3.6 Changing Row/Column Properties ............................................................................    4-9
4.3.7 Adding Account Assignments to Row/Columns.....................................................    4-9
4.3.8 Performing Row/Column Calculations ...................................................................    4-10
4.3.9 Defining Column Exceptions .....................................................................................    4-12
4.3.10 Saving Reports to the Database..................................................................................    4-12
4.3.11 Saving Reports to the Local Disk ...............................................................................    4-13
4.4 Managing Content Sets.......................................................................................................    4-13
4.4.1 Creating Content Set....................................................................................................    4-13
4.4.2 Adding Hierarchy to Existing Content Set...............................................................    4-14
4.4.3 Specifying Hierarchy Attributes ................................................................................    4-15

5 Analyzing Financial Statement Generator Reports

5.1 Overview of Analysis Wizard .............................................................................................    5-2
5.2 Prerequisites for Using Analysis Wizard...........................................................................    5-2
5.2.1 Profile Options................................................................................................................    5-3
5.2.2 Published Reports from Request Center ....................................................................    5-3
5.3 Using the Analysis Wizard ..................................................................................................    5-4
5.3.1 Starting Analysis Wizard ..............................................................................................    5-4
5.3.2 Selecting Effective Account Range ..............................................................................    5-5
5.3.3 Viewing Summary and Detail Accounts ....................................................................    5-5
5.3.4 Creating Pivot Information...........................................................................................    5-6
5.3.5 Filtering Information .....................................................................................................    5-6
5.3.6 Viewing Subledger Detail .............................................................................................    5-7

6 Using the Account Hierarchy Editor

6.1 Overview of Account Hierarchy Editor.............................................................................    6-2
6.2 Prerequisites for Using Account Hierarchy Editor ..........................................................    6-2
6.3 Using the Account Hierarchy Editor..................................................................................    6-2
v



6.3.1 Opening the Account Hierarchy Editor ......................................................................    6-3
6.3.2 Adding New Parent Values ..........................................................................................    6-3
6.3.3 Adding New Child Values............................................................................................    6-4
6.3.4 Adding Parent/Child Ranges ......................................................................................    6-5
6.3.5 Merging Child Ranges...................................................................................................    6-6
6.3.6 Modifying Segment Value Description.......................................................................    6-7
6.3.7 Viewing Account Hierarchies.......................................................................................    6-8
6.3.8 Adding Hierarchies........................................................................................................    6-8
6.3.9 Duplicating Parent Hierarchies....................................................................................    6-9
6.3.10 Finding Segment Values..............................................................................................    6-11
6.3.11 Creating Rollup Groups ..............................................................................................    6-12

7 Using the Create Asset Wizard

7.1 Overview of Create Asset Wizard.......................................................................................    7-2
7.2 Creating Asset Worksheets ..................................................................................................    7-2
7.3 Creating Layout Templates..................................................................................................    7-4
7.4 Uploading Asset Data to Oracle Assets .............................................................................    7-5
7.4.1 Uploading Asset Data to the Interface Table .............................................................    7-6
7.4.2 Posting Assets from the Interface Table to Oracle Assets ........................................    7-7

8 Using the Record Physical Inventory Wizard

8.1 Overview of Record Physical Inventory Wizard ..............................................................    8-2
8.2 Prerequisites for Using the Wizard.....................................................................................    8-2
8.3 Creating Physical Inventory Worksheet ............................................................................    8-2
8.4 Uploading Physical Inventory Data to Oracle Assets ......................................................    8-4
8.4.1 Uploading Inventory Data from the Worksheet........................................................    8-5
8.4.2 Viewing Results of the Comparison Program............................................................    8-7

9 Using the Request Center

9.1 Overview of Request Center ................................................................................................    9-2
9.2 Using the Request Center .....................................................................................................    9-3
9.2.1 Starting Request Center.................................................................................................    9-3
9.2.2 Specifying Request Center Options .............................................................................    9-3
9.3 Submitting Reports................................................................................................................    9-3
vi



9.3.1 Submitting Standard Reports .......................................................................................    9-4
9.3.2 Submitting Financial Statements or Ad Hoc Reports ...............................................    9-5
9.3.3 Submitting an RXi Report .............................................................................................    9-7
9.4 Publishing Reports and Changing Template Options.....................................................    9-8
9.5 Specifying Publishing and Submission Options...............................................................    9-9
9.5.1 Opening the Publishing Page .....................................................................................    9-10
9.5.2 Applying Themes.........................................................................................................    9-10
9.5.3 Specifying Output Type Options...............................................................................    9-10
9.5.4 Applying Attributes.....................................................................................................    9-13
9.5.5 Specifying Submission and Printing Options ..........................................................    9-14
9.6 Specifying Report Options .................................................................................................    9-15
9.6.1 Specifying Report Objects for Ad Hoc Reports .......................................................    9-15
9.6.2 Specifying Report Publishing Options......................................................................    9-16
9.7 Using Themes.......................................................................................................................    9-17
9.7.1 Changing Current Theme ...........................................................................................    9-18
9.7.2 Creating a Theme .........................................................................................................    9-18
9.7.3 Customizing Themes ...................................................................................................    9-19
9.8 Formatting Themes with Tokens ......................................................................................    9-21
9.8.1 Placing a Token in Report Themes ............................................................................    9-21
9.8.2 Formatting with Line Item Tokens ............................................................................    9-23
9.8.3 Formatting with Line Item Image Tokens ................................................................    9-24
9.9 Applying Cell Level Formatting .......................................................................................    9-25
9.9.1 Applying Cell Level Formatting for Release 11.x....................................................    9-25
9.9.2 Applying Cell Level Formatting for Release 10.7....................................................    9-27
9.9.3 Applying Formatting for Expanded Rows...............................................................    9-27
9.10 Viewing Report Output and Logs ....................................................................................    9-28
9.11 Monitoring and Cancelling Requests ...............................................................................    9-28
9.11.1 Monitoring Requests....................................................................................................    9-28
9.11.2 Cancelling Requests .....................................................................................................    9-31

A Oracle ADI Frequently Asked Questions

A.1 Technical Issues .....................................................................................................................    A-2
A.2 Functional Issues ...................................................................................................................    A-8
vii



B Importing Text Files

B.1 Overview of Importing Text Files .......................................................................................   B-2
B.2 Importing Data into a Worksheet .......................................................................................   B-2
B.3 Creating Mapping Templates ..............................................................................................   B-2
B.3.1 Creating Mapping Templates.......................................................................................   B-3

C Toolbar and Other Options

C.1 Specifying Toolbar Options .................................................................................................   C-2
C.2 Specifying General Options .................................................................................................   C-2
C.3 Specifying Ledger Options...................................................................................................   C-4
C.4 Specifying Request Center Options ....................................................................................   C-7
C.5 Specifying Language Options..............................................................................................   C-8

D Command Line Submission and Publishing Options for FSG Reports

D.1 Overview of Submission and Publishing Options ...........................................................   D-2
D.1.1 Specifying Default Values .............................................................................................   D-2
D.2 Prerequisites ...........................................................................................................................   D-2
D.3 Input Parameters ...................................................................................................................   D-3
D.3.1 Usage Examples..............................................................................................................   D-5

E ADI Toolbar and Request Center Shortcut Keys

E.1 ADI Toolbar Shortcut Keys ..................................................................................................    E-2
E.2 Request Center Shortcut Keys .............................................................................................   E-4

Index
viii



ix

Send Us Your Comments

Oracle Applications Desktop Integrator User Guide, Release 7.2 for Windows

Part No. B13840-01

Oracle welcomes your comments and suggestions on the quality and usefulness of this document. 
Your input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document 
title and part number, and the chapter, section, and page number (if available). You can send com-
ments to us in the following ways:

■ Electronic mail: appsdoc_us@oracle.com 
■ FAX: (650) 506-7200 Attn: Oracle Applications Documentation Manager
■ Postal service:

Oracle Corporation 
Oracle Applications Documentation Manager
500 Oracle Parkway
Redwood Shores, CA 94065
USA

If you would like a reply, please give your name, address, telephone number, and (optionally) elec-
tronic mail address.

 If you have problems with the software, please contact your local Oracle Support Services.



x



                                                                                xi

Preface

Welcome to the Oracle Applications Desktop Integrator User Guide, Release 7.2.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle General Ledger (GL)

■ Oracle Assets

If you have never used GL, Oracle Assets or Oracle Applications, Oracle 
suggests you attend one or more of the Oracle Applications training classes 
available through Oracle University.

See Other Information Sources for more information about Oracle Applications 
product information.

Compatibility
Oracle Applications Desktop Integrator (ADI) is an integral part of Oracle 
Applications. ADI is a spreadsheet-based extension of GL and Oracle Assets that 
offers full-cycle accounting and asset management within the comfort and 
familiarity of a spreadsheet.

ADI works with any of the following Oracle databases:

■ Oracle RDBMS version 7.1.6 or higher (7.1.5 for Open VMS)

ADI works with any of the following Oracle Applications:

■ Release 10.7 or higher
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How To Use This Guide
The Oracle Applications Desktop Integrator User Guide contains the information you 
need to understand and use ADI. This guide includes the following chapters and 
appendices:

■ Chapter 1 provides an overview of ADI, discusses its key features, and explains 
how to get started with ADI.

■ Chapter 2 contains an overview of the Budget Wizard and discusses how to use 
this wizard to create a budget worksheet. 

■ Chapter 3 contains an overview of the Journal Wizard and discusses how to use 
this wizard to create journal entries.

■ Chapter 4 contains an overview of the Report Wizard and discusses how to use 
this wizard to create a report or content set. 

■ Chapter 5 provides an overview of the Analysis Wizard and discusses how to 
use this wizard to analyze Financial Statement Generator (FSG) reports.

■ Chapter 6 contains an overview of the Account Hierarchy Editor and discusses 
how to use it to view and create hierarchies, and create rollup groups.

■ Chapter 7 contains an overview of the Asset Wizard and discusses how to use it 
to create asset worksheets.

■ Chapter 8 contains an overview of the Record Physical Inventory wizard and 
discusses how to use it to create inventory worksheets.

■ Chapter 9 contains an overview of the Request Center and discusses how to use 
it to submit and publish requests, specify publishing options, use themes, and 
view and cancel requests.

■ Appendix A attempts to answer some of the frequently asked questions that 
you might have related to technical and functional issues.

■ Appendix B contains an overview of the Import Text File feature and it 
discusses how to use it to import data into a worksheet and create mapping 
templates for future conversions. 

■ Appendix C discusses how to specify toolbar options, general options, ledger 
options, request center options and language options.
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■ Appendix D discusses the command line submission and publishing options for 
financial statement (FSG) reports.

■ Appendix E provides a description of the ADI toolbar and Request Center 
shortcut keys.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites. 

Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
ADI.

Related User’s Guides

Applications Desktop Integrator Tutorial
This tutorial is designed to help you quickly learn about all of ADI’s features. The 
tutorial is available for the Vision demonstration database.
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Oracle General Ledger User Guide
This guide is a complete source about GL. It contains overviews as well as task and 
reference information about the GL accounting cycle, journal entry, budgeting, 
consolidation, financial reporting, multi-currency, encumbrance accounting, 
standard reports and listings, and setting up GL.

Oracle Assets User Guide
This guide provides information on using Oracle Assets to maintain your assets, 
including information on Mass Additions, the Mass Additions interface, Physical 
Inventory, and the Physical Inventory interface.

Oracle Applications Flexfields Guide
This manual provides flexfields planning, setup, and reference information for the 
ADI and GL implementation team, as well as for users responsible for the ongoing 
maintenance of Oracle Applications product data. This manual also provides 
information on creating custom reports on flexfields data. 

Oracle Report Manager User Guide
This guide provides information on publishing reports to Report Manager. With 
this report distribution solution, reports can be unrestricted and available to all 
users via their personal home pages, or a variety of security models can be applied 
that allow only authorized users to view entire reports or parts of reports. Reports 
published to the Report Manager are accessed via the Oracle Business Intelligence 
System and the E-Business Suite Home Page.

Installation and System Administration

Oracle Applications Desktop Integrator Installation Guide
This manual contains information you need to successfully install ADI. It provides 
step-by-step information on how to install ADI, discusses post-install tasks, 
information on how to enable security in ADI, and how to configure ADI for Citrix 
and Windows Terminal servers.

Oracle Applications Installation Manual
This manual and the accompanying release notes provide information you need to 
successfully install Oracle Financials, Oracle Public Sector Financials, Oracle 
Manufacturing, or Oracle Human Resources in your specific hardware and 
operating system software environment.
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Oracle Applications Upgrade Manual
This manual explains how to prepare your Oracle Applications products for an 
upgrade. It also contains information on finishing the upgrade procedure for each 
product. See this manual and the Oracle Applications Installation Manual when 
you plan to upgrade your products.

Oracle Applications System Administrator’s Guide
This manual provides planning and reference information for the Oracle 
Applications System Administrator. It contains information on how to define 
security, customize menus and online help, and manage concurrent processing.

Oracle General Ledger Technical Reference Manual
This manual contains database diagrams and a detailed description of GL and 
related applications database tables, forms, reports, and programs. This information 
helps you convert data from your existing applications, integrate GL with 
non-Oracle Applications, and write custom reports for GL.

Oracle Assets Technical Reference Manual
This manual contains database diagrams and a detailed description of Oracle Assets 
and related applications database tables, forms, reports, and programs. This 
information helps you convert data from your existing applications, integrate 
Oracle Assets with non-Oracle Applications, and write custom reports for Oracle 
Assets.

Oracle Applications Product Update Notes
This book contains a summary of each new feature added since Oracle Applications 
Release 10.7, as well as information about database changes and seed data changes 
that may affect your operations or any custom report you have written. If you are 
upgrading from Release 10.6 or earlier, you should read this book.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
ADI and reach full productivity quickly. These courses are organized into 
functional learning paths, so you take only those courses appropriate to your job or 
area of responsibility.
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You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.
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Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep ADI working for you. This 
team includes your technical representative, account manager, and Oracle’s large 
staff of consultants and support specialists with expertise in your business area, 
managing an Oracle server, and your hardware and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use Oracle MetaLink, register at (http://metalink.oracle.com/).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools that you can use to create, store, change, retrieve, 
and maintain information in an Oracle database. But if you use Oracle tools, such as 
SQL*Plus, to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

http://metalink.oracle.com/
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When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.

Your Feedback
Thank you for using ADI and this user guide.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about ADI or this user 
guide. Mail your comments to the following address or call us directly at (650) 
506-7200. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
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1
Introduction to Oracle ADI

This chapter provides an overview of ADI, discusses its key features, and explains 
how to get started with ADI. Sections in this chapter include:

■ Section 1.1, "Overview"

■ Section 1.2, "Oracle ADI Key Features"

■ Section 1.3, "Oracle ADI Integrations"

■ Section 1.4, "What’s New in this Release"

■ Section 1.5, "Signing onto ADI"

■ Section 1.6, "Using the ADI Toolbar"

■ Section 1.7, "Selecting an Applications Database"

■ Section 1.8, "Choosing a Responsibility"

■ Section 1.9, "Terms and Definitions"
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1.1 Overview
Oracle ADI is a spreadsheet-based extension to Oracle Applications that offers full 
cycle accounting and asset management within the comfort and familiarity of a 
spreadsheet. Oracle ADI combines a spreadsheet’s ease of use with the power of 
Oracle Applications, to provide true desktop integration during every phase of 
your accounting cycle. You can create budgets, record transactions, add assets, 
reconcile inventory, and run financial statements and inventory reports all without 
leaving your spreadsheet.

You can run Oracle ADI as a stand-alone application, without installing the full 
client version of Oracle General Ledger (GL) or Oracle Assets on your PC. This 
gives you the ability to confirm and reconcile inventory, revise budgets, create 
journal entries, and define financial and asset reports from any location, without 
being connected to your server. You only need to connect when you want to 
transfer data to or from Oracle Applications.

Figure 1–1 describes how ADI integrates with other applications.

Figure 1–1 ADI Integration with Other Applications
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1.2 Oracle ADI Key Features
Oracle ADI key features are as follows:

■ Budget Wizard, Journal Wizard, Report Wizard, and Analysis Wizard to 
simplify your work with GL. 

■ Account Hierarchy Editor to graphically create, maintain, and review account 
structure hierarchies.

■ Spreadsheet-based interface to simplify asset creation and physical inventory 
process.

■ Request Center for submitting, monitoring, and publishing your reports.

1.3 Oracle ADI Integrations
Oracle ADI integrates with the following modules:

Oracle General Ledger
GL is a comprehensive financial management solution that enhances financial 
controls, data collection, information access, and financial reporting throughout the 
enterprise. It is part of the Oracle E-Business Suite, an integrated set of applications 
that are engineered to work together.

Oracle Assets
Oracle Assets is a comprehensive asset management solution that ensures 
maintenance of accurate property and equipment inventory as well as optimal 
accounting and tax strategies. It is part of the Oracle E-Business Suite, an integrated 
set of applications that are engineered to work together.

1.4 What’s New in this Release
This document describes functionality to be delivered in the Oracle ADI Release 7.2. 
If you are using this product prior to the release, some new functionality may be 
dependent on integration with other Oracle products. See Oracle MetaLink for 
relevant product patches and documentation.

The following new features have been added to Oracle ADI in this release. 
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Drill Down to AX Sub-Ledger Details
If you are using the Global Accounting Engine (AX), you can use the Analysis 
Wizard to see the accounting engine details of AX journal entries in GL.

XBRL Support
eXtensible Business Reporting Language (XBRL) is an open specification for 
software that uses eXtensible Markup Language (XML) data tags to publish and 
exchange financial information across different kinds of software and technologies. 
ADI provides XBRL output option for generating reports using the Request Center.

Command Line Submission and Publishing Options
ADI provides the ability to submit and publish FSG reports by specifying the 
required parameters to a command line utility, and allowing the process to be 
integrated with a third-party scheduler.

1.5 Signing onto ADI
You can access ADI directly from the PC on which you have installed it. 
Alternatively, if you have installed it on a Citrix or Window Terminal server, you 
can access it from other PCs. For more information, see Citrix or Windows Terminal 
Server documentation.

To use Oracle Applications, you need an Oracle Applications sign on, which 
consists of a unique username and password. These are different from the 
username and password you use to sign on to your computer. If you are not sure of 
your Oracle Applications sign on, consult your system administrator.

Oracle Applications security is based on your sign on since this connects you to 
your responsibilities, which control your access to applications, functions, reports, 
and data.

To sign on to ADI:

1. Start ADI, and then click the Sign On icon from the toolbar.

2. From the Database list, select the applications database to which you want to 
connect. For details, see Section 1.7, "Selecting an Applications Database".

Note: You must define at least one database before you can 
successfully sign on to Oracle Applications.
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3. Enter your username and password.

4. Select the Use Last Responsibility check box if you want to use the same 
responsibility you used during your last session, and then choose OK. For 
details, see Section 1.8, "Choosing a Responsibility".

1.6 Using the ADI Toolbar
When you start ADI, a toolbar appears. After you sign on, the system determines 
the functions you are authorized to access. Icons for these functions appear on the 
toolbar, if you have enabled them in your options settings. Figure 1–2 describes the 
main toolbar icons. For more details about using the toolbar, see Appendix C, 
"Toolbar and Other Options". 

Figure 1–2 Applications Desktop Integrator — Toolbar Icons

Until you successfully sign on to ADI, you have access only to those icons and 
functions that do not interact with your applications database. For example, you can 
perform any of the daily work you need to do in an Excel spreadsheet; open a saved 
budget worksheet, apply budget rules, work with Oracle Assets data, or create a 
graph. You can also sign on to Oracle Applications, change your ADI options, and 
access the Help functions. You cannot download budget balances, use Budget 
Wizard, Journal Wizard, or Report Wizard, upload balances to the interface tables, 
monitor requests, or submit processes, because these functions require that ADI be 
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connected to your applications database. You also do not have access to Oracle 
Assets until you successfully sign on.

After you sign on to ADI, you may not have access to specific features and 
functions. ADI compares security options, set by your system administrator, to 
those set for your responsibility to determine which ADI features you can use. If 
you have trouble accessing certain ADI features, contact your system administrator 
for assistance.

1.7 Selecting an Applications Database
The Select Database window allows you to select a database, edit database 
specifications, and add or delete a database. Note that you will not have access to 
this window if your system administrator has defined a fixed list of database 
connections.

To use an applications database with ADI, you must specify the following 
parameters:

■ Current database name and description. You can choose any name and 
description.

■ GWYUID (Gateway User ID), FNDNAM, and Connect String, which are system 
level parameters for your database. 

Note: ADI observes the same password security as the application 
you are accessing. If your password has expired or you experience 
problems with your password, contact your system administrator 
for assistance.

Note: For a complete list of ADI toolbar shortcuts, see 
Appendix E, "ADI Toolbar and Request Center Shortcut Keys".

Note: The database name you choose must have at least six 
characters.
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■ NCA Connection. If you want to launch NCA applications from the ADI 
toolbar, you must specify the entire name and directory location of the applet 
bat file. 

■ Server ID. This is required only if the database is using Applications Server 
Security.

Selecting Applications Database
To select an applications database:

1. From the Signon window, click Define Databases.

2. In the Select Database window, select the appropriate applications database 
from the Current Database list.

While adding or editing a database, specify the appropriate database 
parameters as discussed in Section 1.7, "Selecting an Applications Database".

■ To add a database, click Add. 

■ To edit the current database, click Edit. 

■ To delete the current database, click Delete.

1.8 Choosing a Responsibility
A responsibility is the level of authority you have been given to access functions 
and data in Oracle Applications. Depending on your job requirements, you may 
have more than one responsibility, each of which is associated with one set of books 
in GL or Oracle Assets. Typically, your system administrator sets up your 
responsibilities.

You can use ADI to upload journals to the set of books to which you have been 
given access under a responsibility. You can also download budgets from GL, 

Note: Check with your system administrator for specifying 
information such as, system level parameters, NCA connections, 
and server ID.

Note: This option will not be available if your system 
administrator has defined a fixed list of database connections.
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modify them, and upload changes if your responsibility allows you to do so. You 
can generate and submit reports, and create assets, log physical inventory, and 
upload asset data for that set of books associated with your responsibility. 

1.8.1 Changing Responsibility
You can change responsibility before signing on to ADI or after signing on to ADI.

To change responsibility before signing on to ADI:

1. Sign on to ADI after deselecting the Use Last Responsibility check box in the 
Signon window.

2. In the Select Responsibility window, choose the appropriate responsibility.

1.9 Terms and Definitions
■ AutoSelection

■ AutoReduction or reduction criteria

■ row set

■ column set

■ content set

■ display group

AutoSelection
A feature in the list window that allows you to choose a valid value from the list 
with a single keystroke. When you display the list window, you can type the first 
character of the choice you want in the window. If only one choice begins with the 
character you enter, AutoSelection selects the choice, closes the list window, and 
enters the value in the appropriate field.

Note: If your responsibility is not associated with a set of books, 
you will not be able to use ADI’s features.

Note: To change responsibility after you have signed on to ADI, 
click the Change Responsibility icon on the ADI toolbar.
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AutoReduction or reduction criteria
In addition to AutoSelection, you can also use a feature called AutoReduction to 
help you further simplify and accelerate your data entry. For example, you might 
want to shorten a list so that you have to only scan a subset of values before 
choosing a final value. Type in the first character or characters of the subset you 
want in the reduction criteria window. If there are several values that match, 
AutoReduction shortens the list to just those matching values. For details, see the 
AutoReduction section in the Oracle Applications User Guide.

row set
A report component that you can build within GL by defining all of the lines in 
your report. For each row, you can control the format and content, including line 
descriptions, indentations, spacing, page breaks, calculations, units of measure, 
precision and so on. A typical row set includes row labels, accounts and calculation 
rows for totals. For example, you might define a standard income statement row set 
or standard balance sheet row set.

column set
A report component you can build within GL by defining all of the columns in a 
report. You can control the format and content of each column, including column 
headings, spacing and size, calculations, units of measure, and precision. A typical 
column set includes a header column for headings and subheadings, currency 
assignments, amount types, and calculation columns totals. You can also define a 
column set with each column representing a different company to enhance 
consolidation reporting.

content set
A report component you can build within GL that defines the information in each 
report and the printing sequence of your reports. For example, you can define a 
departmental content set that prints one report for each department.

By assigning a content set to a report request, you can generate hundreds of similar 
reports in a single run. The content set controls how the numerous reports differ 
from each other. For example, assume your organization has 50 departments and 
that department is one of your account segments. Also assume that you already 
have an FSG report for travel expenses, which you run weekly. By using a content 
set with your existing report definition, you can print a travel expense report for 
each department, in one report request. You can then distribute the reports to the 50 
department managers for review purposes. For more information, see Oracle General 
Ledger User Guide.
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display group
An optional report component in GL’s Financial Statement Generator. Display 
groups determine the range of rows in a row set or columns in a column set that 
will be displayed or hidden in a financial report. Display groups are assigned to 
display sets. For more information, see Oracle General Ledger User Guide.
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2
Using the Budget Wizard

This chapter contains an overview of the Budget Wizard and discusses how to use 
this wizard to create a budget worksheet. Sections in this chapter include:

■ Section 2.1, "Overview of ADI Budget Wizard"

■ Section 2.2, "Working with Budget Worksheets"

■ Section 2.3, "Changing Budget Parameters"

■ Section 2.4, "Working with Open Budget Worksheets"

■ Section 2.5, "Updating Budget Balances"

■ Section 2.6, "Uploading Budgets from ADI to GL"

■ Section 2.7, "Viewing Budgets Graphically Using ADI"
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2.1 Overview of ADI Budget Wizard
With the ADI Budget Wizard, you can download an existing budget from GL into 
Microsoft Excel, modify it in Excel, and then automatically upload revised budgets 
to GL.

You can also analyze budgets by downloading both actual and budget balances 
from GL, and then use Excel to perform comparisons between the actual and 
budget values. 

Since ADI uses Excel to create budget worksheets, you can easily save your 
worksheets to your local hard disk or floppy disk, making it possible to edit them 
later, or perform budget analysis work, on a different PC, even when you are 
disconnected from your corporate database.

2.2 Working with Budget Worksheets
Topics in this section include:

■ Section 2.2.1, "Creating a Budget Worksheet"

■ Section 2.2.2, "Inserting a New Budget Account"

■ Section 2.2.4, "Saving the Budget Worksheet to a Disk"

■ Section 2.2.3, "Opening a Budget Worksheet"

■ Section 2.2.5, "Using Notes"

2.2.1 Creating a Budget Worksheet
To create a budget worksheet:

1. From the ADI toolbar, choose Ledger > Enter Budgets. The Create Budget 
Worksheet window opens.

2. In the Criteria pane of this window, select the organization for which you want 
to create a budget worksheet. For more details, see Section 2.3.1, "Specifying 
Budget Criteria".

3. Optionally, click Limit Accounts to limit the number of accounts in the budget 
worksheet. For details, see Section 2.3.2, "Limiting Number of Accounts in the 
Budget Worksheet".

4. Optionally, click Set Characteristics to change the display characteristics of 
account segments. For details, see Section 2.3.3, "Changing Display 
Characteristics of Account Segments".
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5. Select the appropriate budget from the Budget menu, currency from the 
Currency menu, and the appropriate period range.

For details about budget, currency and period range, see Section 2.3, "Changing 
Budget Parameters".

6. In the Worksheet Options pane of the Create Budget Worksheet window, select 
the appropriate option. For details, see Section 2.3.4, "Specifying Worksheet 
Options".

7. Click OK to create the budget worksheet. ADI creates the budget worksheet 
and downloads any existing budget balances from GL.

2.2.2 Inserting a New Budget Account
You can insert a new budget account into a budget worksheet. To do so:

1. Place the cursor anywhere in the row that is to follow the new budget account 
row.

2. From the ADI toolbar, choose Ledger > Insert Budget Account. 

The Select Account Segment Values window appears. 

3. From the Account Alias menu, select the appropriate alias. 

In GL, you can define aliases for accounts or combinations of account segments. 
In an account alias, some or all of the account segments have assigned values, 
providing a shortcut method for entering accounts. If you have defined such 
aliases in GL, ADI displays these in the Account Alias list of values.

When you select an Account Alias, ADI automatically inserts predefined values 
for the Segment, Value and Description fields in this window.

4. Choose OK to create the new budget account.

Note: If you change your budget criteria and the Update Budget 
Status option is not selected in the Budget page of the Ledger 
Option window, you must manually refresh your statistics display. 
For details, see Section 2.3.1, "Specifying Budget Criteria".
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2.2.3 Opening a Budget Worksheet
To open a budget worksheet:

1. Choose File > Open from the Excel menu.

2. Select the path where the budget worksheet is located. 

3. Select OK to open the file.

If ADI is installed, but not running, ADI starts automatically when you open 
the budget worksheet.

2.2.4 Saving the Budget Worksheet to a Disk
To save the budget worksheet to a disk:

1. Choose File > Save As from the Excel menu.

2. Enter a name and specify a path for the budget worksheet file.

3. Choose OK to save the file.

2.2.5 Using Notes
You can add notes or comments to the amounts and accounts in your budget 
worksheet. You can also add a note for the entire budget. You may use notes and 
comments to annotate budget amounts, explain how an amount is calculated, or 
describe accounts.

Note: The Budget Wizard validates the new account before 
creating it. If the segment values you specify are not for a valid 
account, the account is not created in your budget worksheet.

Note: Budget Notes uses the cell note feature of Microsoft Excel. 
For more information about cell notes, see Excel user’s guide or 
online help.
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To add budget notes to a budget worksheet:

1. Position your cursor within the budget worksheet to one of these locations:

■ On a budget amount cell — to add a budget note to a specific amount in 
your budget worksheet.

■ On any cell within an account row — to add a budget note for a specific 
account in your budget worksheet.

■ Anywhere — to add a budget note for the entire budget worksheet.

2. From the ADI toolbar, choose Ledger > Add Budget Notes. The Add Budget 
Note window opens.

3. In this window, select one of the following:

■ Budget to add a budget note.

■ Account to add an account note.

■ Amount to add an amount note.

4. Click OK and then enter the text of your budget note in the Text Note region.

A small red triangle appears at the upper right corner of the cell where the 
budget note is attached. 

■ To edit or delete a note, right-click the worksheet cell where the note is 
attached, and then select Edit Comment or Delete Comment as appropriate.

See Appendix C, "Toolbar and Other Options" for more details about changing the 
information displayed in a worksheet.

Note: To see the note indicator in your budget worksheet, you 
must enable the Comment indicator only or Comment & indicator 
radio button in the Microsoft Excel Options window (Tools > 
Options > View). 
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2.3 Changing Budget Parameters
When you use the Budget Wizard to create a budget worksheet or edit budget 
criteria, you must specify certain parameters. After you specify these parameters, 
ADI creates a budget worksheet or modifies the currently open budget worksheet, 
based on the parameters you have provided.

There are two groups of parameters you can specify: budget criteria and worksheet 
options. In addition, you can view the budget status. 

2.3.1 Specifying Budget Criteria
To specify budget parameters:

1. From the ADI toolbar, choose Ledger > Enter Budgets. The Create Budget 
Worksheet window opens.

2. From the Organization menu, select the appropriate budget organization. 
Budget organizations are defined in GL, and it determines the accounts against 
which you can budget.

3. Click Limit Accounts if you want to limit the number of accounts in the budget 
worksheet. For details, see Section 2.3.2, "Limiting Number of Accounts in the 
Budget Worksheet".

4. Click Set Characteristics if you want to change display characteristics of account 
segments. For details, see Section 2.3.3, "Changing Display Characteristics of 
Account Segments".

5. From the budget menu, select the appropriate budget. Budgets are defined in 
GL.

Note: If the budget organization you select is password protected, 
ADI prompts you to enter the password. Enter the password, and 
then click OK.

Note: You can download data from frozen budgets or budgets 
that require Budget Journals; however, you cannot upload any 
changes to GL.
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6. From the Currency menu, select the currency defined for your selected budget 
organization.

7. From the Period Start/End Range, select the starting and ending period for 
your selected budget. 

8. From the Worksheet options, select the appropriate worksheet. For details, see 
Section 2.3.4, "Specifying Worksheet Options".

9. In the Status pane, click the question mark icon beside the Number of Accounts 
field. ADI displays the number of accounts you can download to the worksheet. 

If you change your budget criteria and the Update Budget Status option is not 
selected in the Budget page of the Ledger Options window, you must manually 
refresh your statistics display. To do so, click the question mark button beside 
the Number of Accounts field.

The Allows Update field displays whether you can update a budget or not. If a 
budget cannot be updated, the Reason field displays the reason why it cannot 
be updated.

2.3.2 Limiting Number of Accounts in the Budget Worksheet
To limit the number of accounts in a budget worksheet:

1. From the ADI toolbar, choose Ledger > Enter Budgets. The Create Budget 
Worksheet window opens. 

2. Click Limit Accounts to open the Select Account Segment Ranges window. 

3. In this window, you can limit the number of accounts in the budget worksheet 
by selecting the appropriate segments, and then choosing an appropriate range 
(high or low) for the segments you have selected.

4. Enter or choose your account segment values, and then click OK.

2.3.3 Changing Display Characteristics of Account Segments
To change display characteristics of account segments:

1. From the ADI toolbar, choose Ledger > Enter Budgets. The Create Budget 
Worksheet window opens. 

2. Click Set Characteristics to open the Set Display Characteristics window. In this 
window, there are four columns. Table 2–1 discusses the display characteristics 
in detail.
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3. In the Display Order column, select the account segment whose display order 
you want to change, and then move it up or down.

4. Select the check box for each account segment (shown in the Display Order 
column) whose description you would like to display in your budget 
worksheet.

5. In the Sort Order column, select the account segment whose sort order you 
want to change, and then move it up or down.

6. For each account segment, select a Sort Direction from the related list, and then 
click OK.

2.3.4 Specifying Worksheet Options
Worksheet options control the information that appears in your budget worksheet.

To specify worksheet options:

1. From the ADI toolbar, choose Ledger > Enter Budgets. The Create Budget 
Worksheet window opens. 

2. In this window, select the appropriate options:

■ Workbook/New to create your budget worksheet as a new Excel 
workbook.

■ Workbook/Current to create your budget worksheet as a new worksheet 
within the current Excel workbook. (This option is available only when you 
already have an Excel workbook open.)

■ Include/Budgets Only to create a single Excel worksheet that contains 
values for the budget you defined with your budget criteria selections.

Table 2–1 Create Budget Worksheet window — Setting Display Characteristics

This column... Determines...

Display Order The sequence in which your account segments appear (as 
columns) in your budget worksheet.

Show Desc Description of account segment values you can display in your 
budget worksheet.

Sort Order The sorting order of your account. 

Sort Direction Whether an account segment is sorted in ascending or 
descending order.
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■ Include/Budgets and Actuals to create two Excel worksheets in the same 
Excel workbook. One sheet contains budget values; the other, actual values, 
based on your budget criteria selections.

2.4 Working with Open Budget Worksheets
Even while you are working on an open budget worksheet, you can use the Budget 
Wizard to create budget worksheets, refresh budget values and edit budget criteria.

To create worksheets, refresh worksheet values or change budget criteria:

1. While viewing a budget worksheet, choose Ledger > Enter Budgets. The ADI 
Budget Wizard window opens.

2. Select one of the following radio buttons in this window:

■ Create Budget Worksheet to create additional budget worksheets in the 
same session. The Create Budget Worksheet window opens. For details on 
entering information in this window, see Section 2.2.1, "Creating a Budget 
Worksheet".

■ Refresh Budget Values to refresh budget worksheet values with existing 
GL budget balances. 

ADI replaces the worksheet budget values with the existing budget 
balances from GL, based on the current edited budget worksheet 
parameters. ADI prompts you to replace any worksheet budget values that 
have changed since you last uploaded amounts to GL.

■ Edit Budget Criteria to change the budget, budget organization, currency, 
or period range for a budget worksheet. The Edit Budget Worksheet 
window opens. This window is similar to the Create Budget Worksheet 
window. For details on entering information in this window, see 
Section 2.2.1, "Creating a Budget Worksheet".

Note: If you choose Budgets and Actuals, you can update your 
budget balances and view your actual balances. You cannot update 
actual balances.

Note: If your budget organization is password-protected, ADI 
prompts you to enter the password.
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2.5 Updating Budget Balances
You can use Excel functions, such as copy and paste, and values and formulas, to 
update the values in your budget worksheet. You can easily insert new budget 
accounts into your budget worksheet, and use budget rules to divide a value among 
a range of cells or multiply the values in a range of cells by a constant. Finally, you 
can perform additional budget modeling by inserting new worksheets.

If you manually replace existing values in a budget worksheet, the system flags 
modified rows by placing a flag character in the Upload column. When you upload 
your budget worksheet to GL, you can choose to upload all rows in the worksheet, 
or only those marked with the flag character. 

2.5.1 Updating Budget Balances Manually
To update budget balance manually:

1. While viewing a budget worksheet, edit your budget balances by entering new 
values, copying and pasting values from other cells, or by entering Excel 
formulas. 

If you copy and paste values from other cells, remember to manually enter a 
flag character in the Upload column.

2. Upload the budget worksheet from ADI to GL. For details, see Section 2.6, 
"Uploading Budgets from ADI to GL".

2.5.2 Updating Budget Balances Using Budget Rules
When you are building your budget with ADI, you can use the Apply Budget Rule 
feature to quickly generate entries in your budget. This feature is quite useful when 
the values in a range of cells remain the same or are computed in the same manner. 
You apply a budget rule to a range of cells in your worksheet.

Note: If you use Excel’s copy and paste functions to replace an 
existing value, ADI does not enter a flag character in the Upload 
column. You can manually enter one by placing your cursor in the 
upload column cell where you want the flag character, and then 
enter any character or number from your keyboard.
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To update budget balance using budget rules:

1. While viewing a budget worksheet, to quickly generate entries in your budget, 
choose Ledger > Apply Budget Rule. The Apply Budget Rule window opens. 

2. From the Rule menu in this window, select the appropriate rule. There are four 
budget rules. Each performs a different operation on your range of specified 
cells. Table 2–2 provides a description of the budget rules.

3. In the Amount field, enter the amount for which you want to apply the budget 
rule. 

4. Click OK to apply the budget rule. 

Table 2–2 Apply Budget Rule window — Budget Rules

Rule Description

Divide Evenly by Row Takes an amount you specify, divides it by the number of 
columns in your specified range, and then enters the result in 
each cell of the specified range.

For example, consider a range that consists of three columns 
and five rows (15 total cells). If the amount you specify is 
1,500, the result placed in each cell is 500.

Divide Evenly by Cells Takes an amount you specify, divides it by the number of cells 
in your specified range, and then enters the result in each cell.

For example, consider the same range noted in the previous 
example. If you select Divide Evenly by Cells, the result placed 
in each cell is 100.

Repeat per Cell Takes an amount you specify, and then places it in every cell 
of the specified range.

Multiply Each Cell by a 
Factor

Multiplies each cell in the specified range by an amount you 
enter.

Note: The Range field is view-only.
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2.6 Uploading Budgets from ADI to GL
Topics in this section include:

■ Section 2.6.1, "Uploading Budget Balances from Worksheet to Interface Table"

■ Section 2.6.2, "Importing Budget Balances from Interface Table to GL"

After entering or modifying budget balances in a worksheet, you must upload the 
amounts to GL for posting. You can choose to replace or increment the existing GL 
budget balances.

Uploading budgets is a two-step process. First, you must upload worksheet budget 
balances to the interface table. Second, you must import the balances from the 
interface table to GL.

2.6.1 Uploading Budget Balances from Worksheet to Interface Table
To upload budget balances from the budget worksheet to the interface table:

1. While viewing a budget worksheet that has been modified, choose Ledger > 
Upload to Interface. The Upload Budgets to Interface window opens.

2. Select the appropriate upload option. You can select four options to upload and 
import your budgets. Table 2–3 describes these options in detail.

Note: If the budget name, budget organization name, or any such 
information that you enter contains an apostrophe, budget upload 
can fail. Rename the information to upload the budget successfully.

Note: If the budget organization is password-protected, ADI 
prompts you to enter the password. 

Table 2–3 Upload Budgets to Interface window — Budget Upload Options

Option Description

Rows to Upload Select:

■ Flagged Rows to upload only those rows that are marked 
with a flag character in the upload column of your 
worksheet.

■ All Rows to upload all values in your worksheet, 
regardless of whether changes have been made.
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Upload Mode Determines whether the values in GL are replaced or 
increased by the values in your budget worksheet. Select:

■ Replace to replace the GL amounts.

■ Increment to increase them.

Pre-Validation You can pre-validate your budget data before you upload it to 
GL. By pre-validating, you can minimize the possibility of the 
GL budget import process failing because of a validation error.

Note: Regardless of whether you choose to pre-validate 
your budget data, the GL budget import process still 
performs the usual server-side validation activities.

You can choose one of the two pre-validation options for your 
budget data:

■ Full to pre-validate all budget data for which a list of 
values is available, and to perform segment security 
checking.

■ None to perform segment security checking only.

Note: Segment security checking is performed only if you 
have defined segment security rules.

If the GL profile option, GLDI: Force Full Validation, is set 
to yes, ADI performs full validation of your budget data. 
You cannot change this option from the Budget Wizard.

Duplicate Rows in 
Interface Table

Determines whether the system warns you before older rows 
of duplicate values, already in the GL Budget Interface table, 
are deleted by values in the new rows being uploaded. Select:

■ Prompt Before Deletion of Existing Row for ADI to 
display a warning message. 

■ Always Delete Existing Row for ADI to perform the 
deletion automatically.

Start Budget Import Select this check box to automatically start the budget import 
concurrent request after uploading your budget amounts. The 
budget import process will not start if you do not select this 
check box or if there are errors in the budget upload.

Table 2–3 Upload Budgets to Interface window — Budget Upload Options

Option Description
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3. Click OK to initiate the upload process. 

After the budget upload completes, ADI displays a window with the following 
information:

■ Number of rows successfully uploaded.

■ Number of errors in the upload to the GL Budget Interface table.

■ Budget import request ID (if there are no errors in upload).

Additionally, it displays a message indicating that a watch request has been 
submitted for the budget post request ID (if there are no errors in upload).

If there were no errors in the budget upload, ADI:

■ Submits your budget import concurrent request.

■ Submits a watch request to monitor your concurrent request.

When the process completes, ADU displays the completion status. For budget lines 
which were not uploaded successfully, ADI provides an explanation in the 
Messages section of the budget worksheet. If you have selected Show Upload 
Success Indicator in the General Options window, ADI displays status indicators in 
the Messages section for each budget line.

2.6.2 Importing Budget Balances from Interface Table to GL
To import budget balances from the interface table to GL:

1. From the ADI toolbar, choose Ledger > Submit Process > Budget Import. The 
Select Process Type window opens.

2. In this window, select the Budget Import radio button, and then click Query. 
The Parameters region displays the budgets that are available for import.

3. Select the budget whose balances you want to import to GL.

4. Click OK to start a budget import concurrent request. When the process 
completes, ADI displays the completion status.
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2.7 Viewing Budgets Graphically Using ADI
You can use ADI to view your budget balances as area charts, bar graphs, column 
graphs, line graphs, or pie charts. If you download both budget and actual balances 
from GL, you can plot both values on your graph.

2.7.1 Creating a Graph with Budget Values
To create and display a graph of your budget values:

1. Select the contiguous range of cells you want to view as a graph.

2. From the ADI toolbar, choose Ledger > Create Graph.

ADI creates your graph in a new worksheet in your Excel workbook. The 
appearance of the graph depends on your budget worksheet parameters, as 
well as the default settings you have defined for graphs.

The system gives the graph a name relative to the budget worksheet. For 
example, if the worksheet is named Budget1, the graph is named Chart1A. A 
second graph for the same budget worksheet is named Chart1B, and so on. 
There is a limit of 26 graphs for any single budget worksheet.

3. To delete a graph, choose Edit > Delete Sheet from the Excel menu.

Note: Select only those worksheet cells that contain budget 
values. Do not select column headings and row labels when you 
specify the range. ADI automatically uses the column headings and 
row labels from your budget worksheet as labels in your graphs.
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3
Using the Journal Wizard

This chapter contains an overview of the Journal Wizard and discusses how to use 
this wizard to create journal entries. Sections in this chapter include:

■ Section 3.1, "Overview of Journal Wizard"

■ Section 3.2, "Working with Journal Worksheets"

■ Section 3.3, "Customizing Journal Worksheets"

■ Section 3.4, "Creating Journal Entries"

■ Section 3.5, "Uploading Journal Entries"



Overview of Journal Wizard

3-2 Oracle Applications Desktop Integrator User Guide

3.1 Overview of Journal Wizard
With the Journal Wizard, you can create journal entries using Microsoft Excel, and 
then automatically upload them to GL. You can make journal entries using journal 
worksheets created automatically by the Journal Wizard. These journal worksheets 
include fields for all of the journal entry information required by your 
organization’s specific implementation of GL.

With the Journal Wizard you can:

■ Customize journal worksheets by adding supplemental journal entry 
information.

■ Use the powerful spreadsheet features of Excel. For example, you can use 
formulas to calculate journal amounts.

■ Save a journal worksheet to a file, which can then be transferred to another PC 
for further changes, even while being disconnected from the GL database.

■ Open one or more accounting periods for a set of books.

3.2 Working with Journal Worksheets
You can use the Journal Wizard to create customized journal worksheets in 
Microsoft Excel. From a journal worksheet, you can enter journal entries, and then 
upload and post them to GL.

Topics in this section include:

■ Section 3.2.1, "Creating a Journal Worksheet"

■ Section 3.2.2, "Creating Additional Journal Worksheets in the Same Session"

■ Section 3.2.3, "Saving the Journal Worksheet to a Disk"

■ Section 3.2.4, "Opening a Saved Journal Worksheet"

3.2.1 Creating a Journal Worksheet
To create a journal worksheet:

1. From the ADI toolbar, choose Ledger > Enter Journals. The Create Journal 
Worksheet window opens.
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2. In this window, select a journal type. The options are:

■ Functional Actuals to create actual journal entries using the functional 
currency for your selected set of books.

■ Foreign Actuals to create actual journal entries using a foreign currency. A 
foreign currency is one which is different from the functional currency for 
your selected set of books.

■ Budgets to create journal entries that are to be posted against a budget.

■ Encumbrances to create journal entries to update encumbrance balances.

For specific information about creating various journal types, see 
Section 3.4.1, "Creating Functional Actuals, Budgets or Encumbrances" and 
Section 3.4.2, "Creating Foreign Actuals".

3. From the Number of Journals pane of the Create Journal Worksheet window, 
select the number of journals. The options are:

■ Single to prepare an individual journal entry. Information common to all 
lines in the journal entry is reflected in the journal worksheet header. This 
includes Category, Source, Currency, and Accounting Date. For each line of 
the actual entry, you can enter information such as account, debit amount, 
and credit amount.

■ Multiple to prepare multiple journal entries. All information pertaining to 
a journal entry, even that which is common to more than one line, is 
entered on each line of a multiple journal entry.

With multiple journal entries, you can combine journal entries that have 
different categories, sources, and currencies in a single journal worksheet. 
You can then upload these different journal entries at the same time. When 
GL imports the entries from the GL interface table, it separates the lines into 
appropriate entries and batches.

4. Select the appropriate worksheet options. The options are:

■ New Workbook to create the journal worksheet as a new Excel workbook.

■ Current Workbook to create the journal worksheet as a new worksheet 
within the current Excel workbook. This option is available only when you 
have an open worksheet.

5. Click OK to create the journal worksheet.
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3.2.2 Creating Additional Journal Worksheets in the Same Session
To create additional journal worksheets in the same session:

1. While viewing a journal worksheet, from the ADI toolbar, choose Ledger > 
Enter Journals. The Create Journal Worksheet window opens.

2. Repeat Steps in Section 3.2.1, "Creating a Journal Worksheet".

3.2.3 Saving the Journal Worksheet to a Disk
To save the journal worksheet to a disk:

1. Select File > Save As from the Excel menu.

2. Enter a name and specify a path for the journal worksheet file.

3. Choose OK to save the file.

3.2.4 Opening a Saved Journal Worksheet
To open a save journal worksheet:

1. Select File > Open from the Excel menu.

2. Select the path where the journal worksheet is located. 

3. Choose the journal worksheet name and select OK to open the file.

If ADI is installed, but not running, ADI starts automatically when you open 
the journal worksheet.

3.3 Customizing Journal Worksheets
To customize journal worksheets:

1. While viewing a journal worksheet, from the ADI toolbar, choose Ledger > 
Enter Journals. The Create Journal Worksheet window opens.

2. Click Edit Layout to open the Define Worksheet Layout window. This window 
comprises the Worksheet, Header and Lines pages.

Note: You can create additional journal worksheets using 
different applications databases or responsibilities. To do so, sign 
on to the desired database and responsibility before creating your 
new worksheet.
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3. In the Worksheet page, select the appropriate options. The Worksheet page is 
similar to the Create Journal Worksheet window. When you select the 
appropriate option, the Create Journal Worksheet window opens. For details on 
entering/selecting information in this window, see Section 3.2.1, "Creating a 
Journal Worksheet".

4. In the Header page, select the appropriate fields. Table 3–1 describes the details 
of the required, optional and moving fields of the Define Worksheet Layout 
window — Header page.

5. Select the Database Columns check box to display the database columns in the 
Optional fields pane of the Define Worksheet Layout window.

Table 3–1 Define Worksheet Layout window — Header page

Field Type Description

Required fields ■ Headers for functional actual and foreign actual journals 
always display the journal Category, Source, Currency, 
and Accounting Date. 

■ Budget journal headers include the budget name, but not 
the accounting date. 

■ Encumbrance journal headers include the encumbrance 
type.

You cannot change the required fields that appear in your 
journal header; however, you can rearrange their sequence. 
For details, see Moving fields (field type).

Optional fields You can include additional fields in your journal worksheet. 
Optional fields include: Group ID, Batch Name, Batch 
Description, Journal Name, Journal Description, Journal 
Reference, Reverse Journal, Reversal Period, and Clearing 
Company. 

To display any of the optional fields as a row in your header, 
select the check box beside its name. 

The Reversal Period field can be added to functional actual, 
foreign actual and encumbrance journals, and used to upload 
journals to adjustment periods.

Moving fields Use the directional buttons to change the display sequence of 
required or optional fields in your journal worksheet. First, 
select the field whose sequence you want to change. Then, 
choose one of the four directional buttons. The field 
description moves immediately in the Required fields list or 
Optional fields list.
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When you select the Database Columns check box, the information in the 
required and optional fields changes. You can see the GL_INTERFACE column 
names, rather than the descriptions of what those columns represent. The 
column names display option is provided for technical users of GL. Unless 
absolutely necessary, leave this check box deselected.

6. Select the Sample check box to see a preview of your custom journal worksheet. 
The preview window is dynamic and reflects your changes immediately.

7. In the Lines page, select the appropriate fields. Table 3–2 describes the details of 
the required, optional and moving fields of the Define Worksheet Layout 
window — Lines page.

Table 3–2 Define Worksheet Layout window — Lines page

Field Type Description

Required fields ■ Journal lines for functional actual and foreign actual 
journals always display Account, Debit, and Credit 
columns. 

■ Budget journal lines include the Period column. 
Multiple-entry budget journals include the Budget Name, 
but not Accounting Date. 

■ Multiple-entry journals include journal category, source, 
currency, and accounting date fields.

■ Multiple-entry encumbrance journal lines include the 
Encumbrance type field.

You cannot change the required fields that appear in your 
journal lines; however, you can rearrange their sequence. For 
details, see Moving fields (field type).
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3.4 Creating Journal Entries
Topics in this section include:

■ Section 3.4.1, "Creating Functional Actuals, Budgets or Encumbrances"

■ Section 3.4.2, "Creating Foreign Actuals"

You can enter four types of journal entries in your journal worksheet: functional 
actuals, foreign actuals, budgets, or encumbrances. There are only slight variations 
in the information you need to enter for each type of journal entry. Sections that 
follow describe how to enter the information in detail.

Optional fields You can include additional fields of information in your 
journal worksheet. Optional fields include: Description, Stat 
Amount, Reconciliation Reference, Invoice Date, Tax Code, 
Invoice Identifier, Invoice Amount, VAT Context, Line DFF 
Context, Line DFF 1 to 10, Captured Info Context, Captured 
Info DFF 1 to 10, Line Detail Report, Source Detail Report, 
Additional Line Info 1 to 8.

■ Multiple-entry journal worksheets include: Group ID, 
Batch Name, Batch Description, Journal Name, Journal 
Description, Journal Reference, Reverse Journal, Reversal 
Period, and Clearing Company.

■ Foreign Actuals journal worksheets include Converted 
Debit and Converted Credit.

To display any of the optional fields as a column in your 
journal lines, select the check box beside its name. 

The Reversal Period field can be added to functional actual, 
foreign actual and encumbrance journals, and used to upload 
journals to adjustment periods.

Moving fields Use the directional buttons to change the display sequence of 
the required or optional fields in your journal worksheet. First, 
select the field whose sequence you want to change. Then, 
choose one of the four directional buttons. The field 
description moves immediately in either the Required fields 
list or Optional fields list.

Note: You can enter journals only for adjusting periods in GL. For 
non-adjusting periods, see Oracle General Ledger User Guide.

Table 3–2 Define Worksheet Layout window — Lines page

Field Type Description
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3.4.1 Creating Functional Actuals, Budgets or Encumbrances
To create functional actuals, budgets, or encumbrances journal entries:

1. Create a journal worksheet. For details, see Section 3.2.1, "Creating a Journal 
Worksheet".

2. Enter the journal header information.

Note that:

■ Journal worksheets support entering effective and reversal dates for sets of 
books that have average balance processing enabled.

■ Accounting date is not required for Budget journals.

■ If the GL profile option, GLDI: Journal Source, is enabled, the journal 
source specified in the profile option is inserted automatically into the 
journal worksheet. You cannot change this value.

3. Enter the following information:

■ Budget for budget journal entries.

■ Encumbrance type for encumbrance journal entries.

4. Enter an account for each journal line by entering the account directly or by 
choosing from the list of values.

5. Enter a debit or credit amount for each journal line. You can use Excel formulas 
to enter your amounts.

6. If you have customized the journal worksheet, enter information for any 
optional fields as appropriate.

7. To insert additional rows into the journal template, unprotect your worksheet 
by selecting Tools > Protection > Unprotect from the Excel menu.

8. Upload your journals to GL.

3.4.2 Creating Foreign Actuals
To create foreign actuals journal entries:

1. Create a journal worksheet. For details, see Section 3.2.1, "Creating a Journal 
Worksheet".

2. Enter the category and source information as appropriate. By default, the 
worksheet displays Adjustment (for category) and Spreadsheet (for source 
information).
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3. Enter the accounting date, currency, and conversion type as appropriate.

4. Enter the conversion date and/or conversion rate, as required:

■ If you select the User conversion type, you must enter a conversion rate; 
however, do not enter the conversion date.

■ If you selected a conversion type other than User, you must enter a 
conversion date; however, do not enter the conversion rate. GL provides 
the rate when you import your journals.

5. Enter account, debit or credit amount for each journal line as appropriate.

Note that:

■ GL automatically calculates the converted value for foreign currency 
amounts. You can override this by selecting the Converted Debit and 
Converted Credit check boxes on the Lines page of the Define Worksheet 
Layout window. GL uses the converted value you enter.

■ Journals uploaded from ADI to GL must pass Euro currency validation 
checks.

EMU Fixed is the only type currency that can be used for ADI journals with 
a Euro derived rate. The exchange rate is derived from rate tables, 
maintained by GL. For details, see Oracle General Ledger User Guide.

6. If you have customized the journal worksheet, enter information for any 
optional fields as appropriate.

7. To insert additional rows into the journal template, unprotect your worksheet 
by selecting Tools > Protection > Unprotect from the Excel menu.

8. Upload your journals to GL.

Note: With the MRC Account Type Specific Conversion feature, 
you no longer have to repeatedly run revaluation and translation to 
get your most current reporting currency balances. With ADI 
Release 7.0 and above, this functionality can be extended to foreign 
currency journals entered in the primary set of books. 

For more information, see MRC Account Type Specific Conversion, 
Oracle Multiple Reporting Currencies in Oracle Applications, posted on 
Oracle MetaLink.
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3.5 Uploading Journal Entries
Topics in this section include:

■ Section 3.5.1, "Profile Options that Determine the Journal Upload Process"

■ Section 3.5.2, "Uploading Journal Entries from Worksheet to Interface Table"

■ Section 3.5.3, "Importing Journals from the Interface Table to GL"

After creating journal entries in a journal worksheet, you must upload them to GL 
for posting. Uploading is a two-step process. First, you must upload your journal 
entries to the interface table. Second, you must import the journal entries from the 
interface table to GL.

Note that:

■ If you specify a Reversal Period, but leave the Reverse Journal field blank, 
the journal upload process will fail for that journal. In a multiple journal 
worksheet, only the specific journal row will fail during uploading.

■ The Journal Wizard interprets three adjoining blank rows in a journal 
worksheet as the end of the journal entry. Therefore, any journal lines that 
appear after three blank rows are ignored when you upload your journals.

■ If your account includes multiple segments with the same name, you 
should rename them so that the segment names are unique. 

■ If any information you enter, such as journal source or journal category, 
includes an apostrophe, the upload process will fail. In such a case, you 
must rename the information.

3.5.1 Profile Options that Determine the Journal Upload Process
Table 3–3 describes the profile options (set by your system administrator) that can 
determine the success or failure of the journal upload process.
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Table 3–3 Profile Options for Journal Upload Process

Profile Option Description

Create Group ID When enabled, ADI creates a group ID for every journal 
upload. ADI then creates a message in the Template Type 
row in the context region of the worksheet after you 
upload journals. The message indicates the type of journal 
and the last group ID number used. 

A sample message: Functional Journal (Last 
upload Group ID was 1310).

If you create a customized journal worksheet with a 
group ID column when this profile option is enabled, ADI 
does not override any group ID values that you enter in 
the worksheet when you upload. Instead, a message 
appears in the message box after every journal entry, 
stating: Group ID has been replaced with a 
system generated value. In addition, the standard 
Group ID message appears in the context region of your 
worksheet.

GLDI: Force Journal to Balance When enabled, journals must balance or upload to GL 
will fail.

GLDI: Balance by Accounting 
Date

When enabled, journals for a non-average daily balance 
set of books must balance by accounting date or upload to 
GL will fail. 

GLDI: Converted Entry 
Threshold

When enabled, the difference between converted debit 
and credit entry amounts must be less than or equal to a 
specific amount. The difference is posted to the largest 
journal entry line amount.

When the difference exceeds the threshold amount, 
journal upload will fail.

GLDI: Force Full Validation When set to Yes, ADI performs full validation of the 
journal data. You cannot change this option from the 
Journal Wizard.

Flexfields: Validate On Server When set to Yes, cross-validation checking is performed.
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3.5.2 Uploading Journal Entries from Worksheet to Interface Table
You can prevalidate journal data before uploading it to GL. By pre-validating, you 
can minimize the possibility of import errors. 

Note that:

■ Regardless of whether you choose to prevalidate your journal data, the GL 
journal import process performs server-side validation activities.

■ If you copy and paste a journal line, ADI does not place a flag character in the 
Upload column for the new journal line. You can manually enter a flag by 
placing your cursor in the upload column cell where you want the flag 
character, and then typing any character or number from the keyboard.

■ The Journal Wizard interprets three adjoining blank rows in a journal 
worksheet as the end of the journal entry. Therefore, any journal lines that 
appear after three blank rows are ignored when you upload your journals.

■ Segment security checking is performed only if you have defined segment 
security rules.

Upload Procedure
To upload journal entries from a journal worksheet to the interface table:

1. While viewing your journal worksheet, from the ADI toolbar, choose Ledger > 
Upload to Interface. The Upload Journals to Interface window opens.

2. Select or enter upload options as appropriate. Table 3–4 discusses the various 
upload options for importing journal data.

Table 3–4 Upload Options for Importing Journal Data

Screen Element Description

Flagged Rows (radio button) You can upload only those rows that are marked 
with a flag character in the upload column.

All Rows (radio button) You can upload all rows in your worksheet, 
regardless of whether changes have been made.

Full (radio button) You can validate all journal data, including journal 
category, journal source, currency, date, and other 
journal fields for which a list of values is available. 
The system also performs cross-validation and 
segment security checking.

Partial (radio button) You can validate all journal data except for accounts. 
Segment security checking is also performed.
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None (radio button) Performs segment security checking only.

Start Journal Import (check box) If selected, starts the journal import process 
automatically after the upload completes.

If you choose to start the journal import process 
automatically after the upload completes, the system 
will do the following:

■ Submits your journal import request 

■ Submits a watch request to monitor your journal 
import request

■ Displays errors in the upload to the interface 
table and the journal import request ID.

■ Displays a message indicating that a watch 
request has been submitted for the Journal 
Import Request ID.

Post Account Errors to Suspense 
(check box)

If selected, journal entry lines with account errors are 
posted to a predefined suspense account. 

Note: To use this function, suspense posting 
must be enabled in GL.

Create Summary Journals (check 
box)

■ If selected, GL summarizes all transactions that 
share the same account, period, and currency. 

■ If not selected, GL creates a journal line for every 
row in your journal worksheet.

Descriptive Flex (list) Select:

■ Do Not Import to prevent importing descriptive 
flexfields.

■ Select With Validation for GL to validate 
descriptive flexfield values.

■ Select Without Validation for GL to import 
descriptive flexfield values without validating 
them.

Table 3–4 Upload Options for Importing Journal Data

Screen Element Description
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3. Click OK to start the journal upload.

For rows that are not uploaded successfully, the system provides an 
explanation in the Messages section of the journal worksheet. If you select the 
Show Upload Success Indicator check box from the General Options window, 
the system also displays status indicators in the Messages section for each 
journal line.

3.5.3 Importing Journals from the Interface Table to GL
To import journals from the interface table to GL:

1. From the ADI toolbar, choose Ledger > Submit Process > Journal Import. The 
Select Process Type window opens.

2. Select the Journal Import (process type) radio button, and then click Query. The 
Parameters region displays the journals available for import.

3. Select the journal you want to import.

4. Optionally, select the Create Summary Journals check box if you want GL to 
summarize all transactions that share the same account, period, and currency. If 
you don’t select this check box, GL creates a journal line for every row in your 
journal worksheet.

5. Optionally, select the Post Errors to Suspense Account check box if you want 
journal entry lines with account errors to be posted to a predefined suspense 
account.

6. Optionally, from the Import Descriptive Flexfields menu, choose one of the 
following:

■ Do Not Import to prevent importing descriptive flexfields.

■ Import with Validation for GL to import flexfield values after validating 
them.

Note: You can upload a journal worksheet more than once, 
effectively creating multiple journals from the same spreadsheet.

Note: To use this function, suspense posting must be enabled in 
GL.
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■ Import without Validation for GL to import descriptive flexfield values 
without validating them.

7. Optionally, from the Date Range Start and End menus, select the appropriate 
date range for the journal you want to import.

If the record you have selected for import has journal lines with different 
accounting dates, the system displays the range of accounting dates included in 
your journal lines. To limit the lines imported, enter a different date range.

8. Choose OK to submit your request.
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4
Using the Report Wizard

This chapter contains an overview of the Report Wizard and discusses how to use 
this wizard to create a report or content set. Sections in this chapter include:

■ Section 4.1, "Overview of ADI Report Wizard"

■ Section 4.2, "Report Wizard Interface and Tools"

■ Section 4.3, "Working with Reports"

■ Section 4.4, "Managing Content Sets"
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4.1 Overview of ADI Report Wizard
With the ADI Report Wizard, you can define reports graphically in Microsoft Excel, 
and then upload the report definitions to GL as Financial Statement Generator 
(FSG) report objects. You can also download existing FSG reports, modify them 
using the Report Wizard, and then save the modified definitions to GL.

From the Report Wizard, you can directly access the Request Center’s Report 
Submission and Publishing window to submit your report. You can also choose to 
download, format, and publish your report output as a spreadsheet, web page, or 
text file.

You can save reports or the report output to a file, which can then be transferred to 
another PC for further changes or review, even while being disconnected from the 
GL database.

4.2 Report Wizard Interface and Tools
Topics in this section include:

■ Section 4.2.1, "Report Wizard Interface"

■ Section 4.2.2, "Report Wizard Tools"

4.2.1 Report Wizard Interface
Reports appear as a graphical layout within an Excel worksheet. The report 
worksheet displays the report title, column headings, and line items that appear in 
the report. It also includes number placeholders to indicate where the main body of 
report information will appear.

The report worksheet displays report indicators (left of rows and above the 
columns), that instantly tell you whether:

■ Account ranges have been assigned to a row or column. The indicator is the 
actual number of assigned account ranges.

Note: You can use ADI to distribute custom reports worldwide to 
your subsidiaries. Create a row and column set in GL and use the 
Report Wizard to create reports in Excel format. Zip the Excel 
reports and distribute it via the web. Your subsidiaries can open the 
Excel report and transfer the definitions to their own GLs. 
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■ Calculations have been defined. The indicator is a ’C’.

■ Column exceptions have been defined. The indicator over the related column 
will be an ’E’.

4.2.2 Report Wizard Tools
You can use the Report Wizard tools to make changes to your report.

When you define a new report or open an existing report, the Reports Toolbar 
opens. Figure 4–1 describes the icons on the Reports Toolbar.

Figure 4–1 Reports Toolbar

The Report Wizard includes many useful features and tools to make it easy for 
users to create reports. You can create or modify row and column properties, 
column headings, account assignments, and row and column calculations. You can 
also create and assign content sets and row orders, and assign display sets.
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If you choose to define a report by making entries directly in the report worksheet, 
the ADI toolbar provides several convenient buttons that makes report creation and 
editing easier:

■ Build: Creates a report heading definition based on your column properties, 
such as amount type and period offset. Has the same effect as creating default 
headings in FSG.

■ Trim: Removes leading and trailing spaces from column headings.

■ Refresh: Applies changes made to column properties to the main body of the 
report worksheet.

4.3 Working with Reports
The Report Wizard provides step-by-step help for creating a report worksheet. 
Once you specify what task you want to accomplish, the wizard asks you a series of 
questions related to that task. After it has all of the information it needs, the wizard 
creates and displays the report worksheet in Excel. Topics in this section include:

■ Section 4.3.1, "Creating a Blank Report"

■ Section 4.3.2, "Creating a Report Using Report Components"

■ Section 4.3.3, "Loading an Existing Report"

■ Section 4.3.4, "Opening a Saved Report"

■ Section 4.3.5, "Adding or Deleting Rows and Columns"

■ Section 4.3.6, "Changing Row/Column Properties"

■ Section 4.3.7, "Adding Account Assignments to Row/Columns"

■ Section 4.3.8, "Performing Row/Column Calculations"

■ Section 4.3.9, "Defining Column Exceptions"

■ Section 4.3.10, "Saving Reports to the Database"

■ Section 4.3.11, "Saving Reports to the Local Disk"

■ Section 4.4.1, "Creating Content Set"

■ Section 4.4.2, "Adding Hierarchy to Existing Content Set"

■ Section 4.4.3, "Specifying Hierarchy Attributes"
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4.3.1 Creating a Blank Report
To create a blank report:

1. From the ADI toolbar, choose Ledger > Define Report. 

The Report Wizard — Step 1 Select Report Task to Perform window opens.

2. In this window, select the Define Report to define a new report. 

The Report Wizard — Step 2 Select Source of Report Definition window opens. 

3. In this window, select the Blank Report radio button, and then click Next. 

The Report Wizard — Step 3 Create a Blank Report window opens. 

4. Enter a Report Name, and then enter values for the following fields:

■ Number of Rows: The number of rows to use in your report.

■ Number of Columns: The number of columns to use in your report.

■ Default Column Width: The width to use for each column. 

■ Line Item Width: The width of the report area where the row labels will 
appear.

5. Select New Workbook as the destination for the report worksheet.

6. Click Next.

7. From the Format menu, select the appropriate format. For example, 999,999 or 
999,999.99.

8. From the Factor menu, select the appropriate factor. For example, millions or 
billions.

9. Optionally, select Yes to create a trend report. The Report Wizard — Step 5 
Report Trend Defaults window opens. 

10. In this window, select one of the following balance types:

■ Actual to select actual balance type.

■ Budget to select budgeted balance type.

■ Encumbrance to select encumbrance balance type.

With GL you can record pre–expenditures commonly known as 
encumbrances. The primary purpose of tracking encumbrances is to avoid 
overspending a budget. Encumbrances can also be used to predict cash 
outflow and as a general planning tool.
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11. In Trend Options, select Forward or Backward to create a forward or backward 
looking report. This is an offset value.

12. In Increment, select Daily, Monthly or Quarterly to increment each column of 
the report.

13. Click Finish to create the report.

4.3.2 Creating a Report Using Report Components
To create a report using report components:

1. From the ADI toolbar, choose Ledger > Define Report. 

The Report Wizard — Step 1 Select Report Task to Perform window opens.

2. In this window, select the Define Report to define a new report. 

The Report Wizard — Step 2 Select Source of Report Definition window opens. 

3. In the Report Wizard — Step 2 Select Source of Report Definition window, 
select the Report Components radio button, and then click Next. The Report 
Wizard — Step 3 Build Report Using Existing Components window opens.

4. In the Row Set field, select the appropriate row set.

5. In the Column Set field, select the appropriate column set.

6. Optionally, in the Content Set field, select the appropriate contents set.

7. Optionally, in the Row Order field, select the appropriate row order. You can 
order rows by segment values, column values, descriptions, or you can change 
the display sequence of segments.

8. Optionally, select the Make Copy check box beside each field to copy a report 
object, rather than use the original. 

9. Optionally, in the Display Set field, select the appropriate display set. 

With display sets and groups you can produce report variations which omit 
sensitive information or which include information normally not included in a 
report. For more information, see Oracle General Ledger User Guide.

Note: This check box is not available when you create new report 
objects.
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10. Click Next to continue creating the report. The Report Wizard — Step 4 
Additional Component Report Options window opens. 

11. Enter a Report Name, and then enter values for the following fields:

■ Number of Rows: The number of rows to use in your report.

■ Number of Columns: The number of columns to use in your report.

■ Default Column Width: The width to use for each column. 

■ Line Item Width: The width of the report area where the row labels will 
appear.

12. Select New Workbook as the destination for the report worksheet.

13. Choose Next.

14. From the Format menu, select the appropriate format. For example, 999,999 or 
999,999.99.

15. From the Factor menu, select the appropriate factor. For example, millions or 
billions.

16. Optionally, select Yes to create a trend report. The Report Wizard — Step 5 
Report Trend Defaults window opens. 

17. In this window, select one of the following balance types:

■ Actual to select actual balance type.

■ Budget to select budgeted balance type.

■ Encumbrance to select encumbrance balance type.

With GL you can record pre–expenditures commonly known as 
encumbrances. The primary purpose of tracking encumbrances is to avoid 
overspending a budget. Encumbrances can also be used to predict cash 
outflow and as a general planning tool.

18. In Trend Options, select Forward or Backward to create a forward or backward 
looking report. This is an offset value.

19. In Increment, select Daily, Monthly or Quarterly to increment each column of 
the report.

20. Click Finish to create the report.
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4.3.3 Loading an Existing Report
To load an existing report:

1. From the ADI toolbar, choose Ledger > Define Report. 

The Report Wizard — Step 1 Select Report Task to Perform window opens.

2. In this window, select the Define Report to define a new report. 

The Report Wizard — Step 2 Select Source of Report Definition window opens. 

3. In the Report Wizard — Step 2 Select Source of Report Definition window, 
select the Load Existing Report radio button, and then click Next. The ADI 
Reduction Criteria window opens.

4. In this window, enter the appropriate reduction criteria, and then select OK. 
The Report Wizard — Step 3 Load an Existing Report window opens.

5. Select the appropriate report, and then click Finish.

4.3.4 Opening a Saved Report
To open a saved report:

1. Select File > Open from the Excel menu.

2. Select the path where the report worksheet is located. 

3. Choose the report worksheet name, and then select OK to open the file.

If ADI is installed, but not running, ADI starts automatically when you open 
the report worksheet.

4.3.5 Adding or Deleting Rows and Columns
To add rows/columns or delete rows/columns in the report worksheet:

1. Place your cursor in the row/column that precedes the new row/column.

2. To add a row, from the Reports toolbar, choose Insert/Delete Row Object, and 
then choose Insert a Line Item. Alternatively, right-click, and then choose Insert 
Object > Line Item.

3. To delete a row, from the Reports toolbar, choose Insert/Delete Row Object, 
and then choose Delete Selected Line Item. Alternatively, right-click, choose 
Delete Object > Line Item.
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4. To add a column, from the Reports toolbar, choose Insert/Delete Column 
Object, and then choose Insert a Column. Alternatively, right-click, and then 
choose Insert Object > Column.

5. To delete a column, from the Reports toolbar, choose Insert/Delete Column 
Object, and then choose Delete Selected Column. Alternatively, right-click, 
choose Delete Object > Column.

4.3.6 Changing Row/Column Properties
To change row/column properties:

1. Choose the row/column you want to change.

2. From the Reports toolbar, select the Row Properties or Column Properties icon 
as appropriate, and then click Properties. The Row Properties or Column 
Properties window opens.

3. Select the appropriate amount type, and then select an appropriate value for the 
amount type you have chosen. For example, if you select Currency, you can 
choose Any or Euro.

4. Click OK or Apply. 

4.3.7 Adding Account Assignments to Row/Columns
Many of the fields in the Row Account Assignments window have lists where you 
can select from a list of values.

To easily change the actual account range, choose an existing account assignment 
from the Low Account or High Account columns. The Select Account Segment 
Ranges window appears, where you can select values for your account range.

If you plan to use the Analysis Wizard to perform account drill-downs, you can use 
null ranges for detail account ranges rather than using ranges that include ’T’ for 
parent segment values.

To add account assignments to rows or columns:

1. Choose the row/column to which you want to add an account assignment.

2. From the Reports toolbar, choose Row Properties > Account Assignments or 
Column Properties > Account Assignments, as appropriate. The Row or 
Column Account Assignments window opens.

3. Enter/select appropriate information. Table 4–1 describes the account 
assignments window. For details about some of the fields in this window, see 
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the FSG Tasks section in the Financial Reporting chapter of the Oracle General 
Ledger User Guide.

4. Click OK to exit this window or Apply to apply account assignments.

4.3.8 Performing Row/Column Calculations
To perform row/column calculations:

1. Choose the row/column for which you want to perform calculations.

2. From the Reports toolbar, choose Row Properties > Calculations or Column 
Properties > Calculations, as appropriate. The Row or Column Calculations 
window opens.

Table 4–1 Row/Column Account Assignments window

Screen Element Description

Row/Column menu Select a row or column as appropriate.

Sign Select a mathematical Sign (+ or –) to tell FSG whether to 
cumulatively add or subtract the balances for each account in 
the specified account range.

Low Account/High 
Account

Range of accounts assigned to the row or column.

Display Enter a display type for each account segment.

You must use a display type of T (Total) for each segment if 
you assign:

■ Accounts to a column.

■ Multiple account ranges to a row.

For details, see the FSG Reference Information section in the 
Financial Reporting chapter of the Oracle General Ledger User 
Guide.

Smry Select this option if you want to report only summary balances 
for the accounts in the specified range.

Activity Select an Activity type (Dr, Cr or Net) to specify the types of 
balances to use for the accounts in each account range.

Set of Books For each account range being assigned, enter a Set of Books 
from which FSG will derive account balances. If you do not 
enter a value, FSG will use the current set of books.
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3. Enter/select appropriate information. Table 4–2 describes the calculations 
window. For details on some of these calculations, see Accounting For Multiple 
Companies Using a Single Set of Books in the Oracle General Ledger User 
Guide.

4. Click OK to exit this window or Apply to apply row calculations.

Note: Many of the fields in the Row/Column Calculations 
window have lists where you can select from a list of values.

Table 4–2 Row/Column Calculations window

Screen Element Description

Row/Column menu Select a row or column as appropriate.

Seq Enter a sequence number for each step of your calculation. This 
controls the order FSG follows when performing the 
mathematical operations required to complete the calculation.

Operator Valid operators include + (add), – (subtract), * (multiply), / 
(divide), % (percent), ENTER (enter value), AVERAGE (average 
of listed values), MEDIAN (median of listed values), STDDEV 
(standard deviation of listed values), and ABSTVAL (absolute 
value of listed values).

Constant Enter a number to use as a Constant value. For example, as part 
of an earnings–per–share calculation, you might enter the 
number of outstanding common shares as the constant by which 
you divide net income.

Low Instead of a constant, you can enter the Low sequence numbers 
corresponding to the range of rows or columns to use in your 
calculation.

High Instead of a constant, you can enter the High sequence numbers 
corresponding to the range of rows or columns to use in your 
calculation.

Row Name Instead of a constant or a sequence range, you can enter the name 
of a specific row or column to use in a calculation.



Working with Reports

4-12 Oracle Applications Desktop Integrator User Guide

4.3.9 Defining Column Exceptions
To define column exceptions:

1. Choose the column for which you want to perform calculations.

2. From the Reports toolbar, select the Column Properties icon, and then click 
Exceptions. The Column Exceptions window opens.

3. In this window, select the appropriate column.

4. In the Flag field, set a flag by entering a single character to flag exceptions in 
your report.

5. In the Description field, enter a description for the column exception you’re 
defining.

6. From the Condition field, select a condition (< , > , =, <= , >= or < >) and enter 
the constant to define your exception. You can enter as many conditions for 
your exception as you want. For details, see the Defining Column Exceptions 
section in the Oracle General Ledger User Guide.

7. Click OK to exit this window or Apply to apply column exceptions.

4.3.10 Saving Reports to the Database
After creating or modifying a report in the Report Wizard, you can save it directly 
to GL by using the Report Wizard or Reports Toolbar. Optionally, you can save a 
report as an Excel workbook file, perform further modifications in Excel (even while 
disconnected from your applications database), and then save the report to GL later.

From the Report Wizard
To save a report from the Report Wizard:

1. From the ADI toolbar, choose Ledger > Report Wizard. The Report Wizard 
appears.

2. Do one of the following:

■ Select the Save Report to Database radio button, and then click Finish; OR

■ Click the Save Report to Database icon on the Reports toolbar.

Note: When you save a report to GL, ADI validates any control 
values specified in your report.
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4.3.11 Saving Reports to the Local Disk
To save a report worksheet to the local disk:

1. Select File > Save As from the Excel menu.

2. Enter a name and specify a path for the report worksheet file.

3. Click OK to save the file.

4.4 Managing Content Sets
The Report Wizard allows you to create content sets to use with your financial 
reports. You can automatically maintain content sets that you may want to 
subsequently use to produce reports for all levels of your reporting hierarchy (for 
example, cost center, department, and fund). When the reporting hierarchy 
changes, you can easily create a content set to produce reports based on the 
changed reporting hierarchy. By maintaining multiple ’point-in-time’ content sets, 
you can easily perform time-based reporting by simply selecting the appropriate 
point-in-time content set when you run the financial report.

When generating a content set with the Report Wizard, you can specify one or more 
hierarchies, based on different parent segment values. The Report Wizard expands 
each hierarchy, beginning with the parent segment value, to create the individual 
rows of the content set. You can then control how each hierarchy is expanded by 
defining hierarchy attributes and filtering options.

4.4.1 Creating Content Set
To create a content set:

1. From the ADI toolbar, choose Ledger > Define Report. The Report Wizard — 
Step 1 Select Report Task to Perform window opens.

2. In this window, select Generate Content Set, and then click Next. The Report 
Wizard - Step 2 Generate Content Set window appears.

To replace existing content set, in the Name field, enter the name of the content 
set you want to replace, and then select Replace existing Content Set.

3. In the Name field, enter a name for the content set. Click the Find icon to enter a 
reduction criteria for the content set you’re creating.

4. From the Segment menu, select the appropriate segment. For example, the 
company or department for which you are creating the content set.
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5. From the Parent Value menu, choose the appropriate parent value for the 
segment you have chosen.

Report Wizard expands the parent to all of its detail levels and creates the 
necessary rows in the content set definition. All parent values below the root 
parent node are found, even if they are technically part of a child range.

6. Click Next. The Report Wizard - Step 3 Generate Content Set window appears.

7. Enter your hierarchy attributes. For details, see Section 4.4.3, "Specifying 
Hierarchy Attributes".

8. Click Next. The Report Wizard - Step 4 Generate Content Set window appears.

9. Enter your hierarchy filtering options.

10. Click Finish. The Report Wizard displays a graphical representation of the 
hierarchy you just created in your content set definition.

11. Click Finish to create the content set.

4.4.2 Adding Hierarchy to Existing Content Set
To add a hierarchy to an existing content set:

1. From the ADI toolbar, choose Ledger > Define Report. The Report Wizard — 
Step 1 Select Report Task to Perform window opens.

2. In this window, select Generate Content Set, and then click Next. The Report 
Wizard - Step 2 Generate Content Set window appears.

3. In the Name field, enter the name of the content set to which you want to add 
the hierarchy.

4. Select Add as the action you want to take.

5. Specify the segment and related parent value for the new hierarchy.

6. Enter your hierarchy attributes, and then click Next.

7. Enter your hierarchy filtering options.

8. Click Finish. The Report Wizard displays a graphical representation of the 
hierarchy you just created in your content set definition.

9. Click Finish to complete adding hierarchy to the existing content set.
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4.4.3 Specifying Hierarchy Attributes
For each hierarchy that you add to a content set definition, you can enter the 
hierarchy attributes that control how the hierarchy is expanded. You can also 
specify whether you want the separate reports generated by the content set to be 
run sequentially or in parallel. Table 4–3 describes the hierarchy attributes.

Table 4–3 Hierarchy Attributes

Screen Element Description

Include Parents 
(check box)

You can generate a separate report for each parent value in the 
hierarchy.

A parent value is a value that has one or more child values associated 
with it. A parent value can be assigned to a rollup group. You create 
parent–child relationships by defining a range of child values that 
belong to a parent value. You can use parent–child relationships for 
reporting and other application purposes. For details, see Parent and 
Child Values and Rollup Groups section in the Oracle General 
Ledger User Guide.

Include Children 
(check box)

Select to generate a separate report for each child value in the 
hierarchy.

A child value is a value that lies in a range of values belonging to a 
parent value. It can belong to more than one parent value, and is not 
a dependent value; that is, the actual value of the child does not 
depend on the value of another segment. You create parent–child 
relationships by defining a range of child values that belong to a 
parent value. For details, see Parent and Child Values and Rollup 
Groups section in the Oracle General Ledger User Guide.

Sort by Branch 
(radio button)

Select to sort reports by organization branch.

Sort by Level 
(radio button)

Select to sort reports by organization level.

Display Type 
(menu)

Allows you to select the content set display type. This display type 
applies to all of the rows that Report Wizard generates in the content 
set definition for the parent segment specified in your hierarchy.

For more information, see Content Set Display Types, Oracle General 
Ledger User’s Guide.

Run Reports — 
Sequentially (radio 
button)

Select to process multiple reports in sequential order.
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Run Reports — In 
Parallel (radio 
button)

Select to process multiple reports at the same time.

Note: The run reports option operates on the entire content set, 
rather than for each hierarchy within the content set.

Table 4–3 Hierarchy Attributes

Screen Element Description
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5
Analyzing Financial Statement Generator

Reports

This chapter contains an overview of the Analysis Wizard and discusses how to use 
this wizard to analyze Financial Statement Generator (FSG) reports. Sections in this 
chapter include:

■ Section 5.1, "Overview of Analysis Wizard"

■ Section 5.3, "Using the Analysis Wizard"

■ Section 5.3, "Using the Analysis Wizard"
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5.1 Overview of Analysis Wizard
The Analysis Wizard helps you to drill down to relevant financial information 
within Oracle Applications to analyze spreadsheet-based FSG reports in detail and 
perform multidimensional data analysis. While drilling down, you can use 
drag-and-drop capabilities to pivot accounting dimensions and quickly reorganize 
financial data to perform ’what-if’ and ’what-happened’ analysis of both summary 
and detailed financial information. The Analysis Wizard helps you quickly detect 
trends and exceptions in the financial data that underlies your reported amount.

The wizard provides access to the complete range of accounts that support a 
particular reported amount. You can select an individual account and drill down to 
its summary balances, detail balances, journal lines, and down to the subledger 
details. You can view journal entries — including translated transaction details 
created by the Global Accounting Engine — and associated details that originate 
from Oracle subledgers, including Payables, Receivables, Assets, Projects, 
Purchasing, Inventory, WIP, and AX.

It provides full support for average balances, ensures segment security (using the 
GL profile option, FSG: Enforce Segment Value Security), and supports multiple 
database access. 

5.2 Prerequisites for Using Analysis Wizard
Prerequisites are discussed in the sections that follow.

■ Section 5.2.1, "Profile Options"

■ Section 5.2.2, "Published Reports from Request Center"
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5.2.1 Profile Options
Table 5–1 describes the profile options for which your system administrator may 
grant you responsibilities.

5.2.2 Published Reports from Request Center
You must use the Request Center to publish a financial (FSG) report’s output to an 
Excel spreadsheet. Only such reports (that is, reports published using the Request 
Center) can be analyzed using the Analysis Wizard. 

Table 5–1 Profile Options for using the Analysis Wizard

Profile Option Description

GLDI: Analysis Wizard 
Privileges

If enabled for your responsibility, allows you to use Analysis 
Wizard.

GLDI: Allow Drilldown 
Across Books

If enabled for your responsibility, allows you to drill down 
across sets of books. You can see account balances that make 
up an FSG report amount, even if they are from different sets 
of books.

Note: This profile option does not allow users to drill 
down from a consolidated parent set of books to a 
subsidiary set of books.

GLDI: Maximum Effective 
Ranges for Drilldown

If specified, allows you to drill down across maximum account 
ranges. This setting, a positive integer greater than zero, 
specifies the maximum account ranges that can be drilled 
down with the Analysis Wizard.

Note: Check with your System Administrator to optimize 
this setting to meet your drill down and system 
performance needs.

Note: If these profile options are not available in your Release of 
GL, all ADI users are given access to the Analysis Wizard 
automatically. For details, see the Enabling Security chapter in the 
Oracle Applications Desktop Integrator Installation Guide.

Note: When you define your FSG report rows and columns, use 
null ranges for detail account ranges rather than use ranges that 
include ’T’ for parent segment values. This generally makes the 
Analysis Wizard drill down operations more efficient.



Using the Analysis Wizard

5-4 Oracle Applications Desktop Integrator User Guide

5.3 Using the Analysis Wizard
Topics in this section include:

■ Section 5.3.1, "Starting Analysis Wizard"

■ Section 5.3.2, "Selecting Effective Account Range"

■ Section 5.3.3, "Viewing Summary and Detail Accounts"

■ Section 5.3.4, "Creating Pivot Information"

■ Section 5.3.5, "Filtering Information"

■ Section 5.3.6, "Viewing Subledger Detail"

5.3.1 Starting Analysis Wizard
The Analysis Wizard includes a toolbar and the Context window. The Context 
window displays detailed information about the amount you have selected to drill 
down. 

To start Analysis Wizard:

1. Use the Request Center to publish a financial (FSG) report’s output to an Excel 
spreadsheet. For more details, see Chapter 9, "Using the Request Center".

2. Select a financial amount in the report output worksheet.

3. From the ADI toolbar, select Ledger > Analyze Report.

The Context window opens, and displays details pertaining to the amount you 
have selected.

4. Optionally, change attributes such as, amount, period, and effective range to 
view details without returning to the FSG report output.

5. Optionally, click Drill Options to change the options for the current drill.

6. Optionally, click Data Source to open the Drill Source window. It displays 
reference information pertaining to the amount in the Context window. The 
information includes the GL database, application, workbook name, worksheet 
name, and worksheet cell.
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5.3.2 Selecting Effective Account Range
The effective account ranges are based on the row/column account assignments, 
content set, report segment override, and column segment override used to 
generate the FSG report.

The profile option, GLDI: Maximum Effective Ranges for Drilldown, controls the 
number of effective ranges you can drill down upon. 

To select an effective account range in subsequent drill downs:

1. From the Context window, click View/Filter. 

The Effective Ranges window opens.

2. For each effective account range you want to include in your drill downs, select 
the Include check box. You must select at least one effective account range. 

3. Click OK to save your changes.

5.3.3 Viewing Summary and Detail Accounts
You can drill down to view the summary accounts and amounts if summary 
account ranges have been defined for the amount in the Context window. Similarly, 
you can view detail accounts and amounts if detail account ranges have been 
defined for the amount. From the summary accounts and detail accounts windows, 
you can drill down further to view journal details. Within any drill down window, 
you can pivot and filter the displayed information for analysis purposes.

5.3.3.1 Summary Accounts
To drill down to summary accounts:

1. From the Context window, click Show Summary Accounts. 

The Summary Balances window appears.

2. To drill down further, select a summary balance, and then click Show Detail 
Accounts. This displays the balances of the detail accounts associated with the 
summary balance.

Note: If there are any missing columns in your FSG report output, 
the Analysis Wizard context information may be displayed 
incorrectly. You can change the period in the Context window to 
display the correct information.
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5.3.3.2 Detail Accounts
To drill down to detail accounts:

1. From the Context window, click Show Detail Accounts. 

The Detail Balances window appears.

2. To view the summary balances for the detail account, click Show Summary 
Accounts. 

5.3.4 Creating Pivot Information
To create pivot information in drill down windows:

1. From the drill down window, select one of the relocatable grey heading boxes 
from the row headings, column headings, or page areas.

2. Drag the heading box to a new location in one of the three areas, and then drop 
it. Alternatively, right-click to access the shortcut menu, and then choose the 
desired pivot action. You can choose Move to Page, Move to Column, or Move 
to Row.

The Analysis Wizard rearranges the data to give you a different view for 
analysis.

5.3.5 Filtering Information
To filter information in drill down windows:

1. In the drill down window, place the cursor in the area directly below the row or 
column heading whose displayed values you want to filter.

2. Right-click to access the shortcut menu, and then choose Filter Values. The 
Filter Values window appears.

3. Select the Show check box for each value you want to display in your drill 
down window. 

4. Click OK to save your changes.

Note: You can drill down to journal details from the Summary 
Balances or Detail Balances window, by clicking Journal Details.
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5.3.6 Viewing Subledger Detail
You can view subledger transactions that originated from Oracle Payables, 
Receivables, Assets, Projects, Purchasing, Inventory and WIP. Table 5–2 describes 
the subledgers you can drill down to depending on the version of ADI and Oracle 
Applications you are using.

To drill down to subledger detail:

1. From the Detail Accounts window, select a detail balance and click Show 
Journal Details.

The Journal Details window appears.

2. Select a journal entry and click Show Subledger Details.

The Subledger Details window appears.

You can view the details for transactions that originated from the Oracle 
subledger.

Note: To remove filters in drill down windows, place the cursor in 
the area directly below the row or column heading whose 
displayed values are currently filtered. Right-click to access the 
shortcut menu, and then choose Show All Values.

Table 5–2 Subledger Drill Down Options

ADI Version Oracle Applications 
Version

Subledger you can drill to

7.1 11i AX, AR, AP, Assets, Projects, 
Purchasing, Inventory, and WIP.

7.0 11i AR, AP, Assets, Projects, Purchasing, 
Inventory, and WIP

7.0 11.0 AR, AP

6.0 11.0 and earlier AR, AP
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6
Using the Account Hierarchy Editor

This chapter contains an overview of the Account Hierarchy Editor and discusses 
how to use it to view and create hierarchies, and create rollup groups. Sections in 
this chapter include:

■ Section 6.1, "Overview of Account Hierarchy Editor"

■ Section 6.2, "Prerequisites for Using Account Hierarchy Editor"

■ Section 6.3, "Using the Account Hierarchy Editor"
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6.1 Overview of Account Hierarchy Editor
The Account Hierarchy Editor allows you to graphically create, maintain, and 
review account structures. You can use this editor to define new parent and child 
segment values, and change parent/child dependencies. It also permits you to 
create rollup groups. Rollup groups are parent segment value groups that you can 
use to create summary accounts.

Instead of using the Key Segment Values feature in GL, you can use the Account 
Hierarchy Editor, to define a hierarchy for a segment of your chart of accounts. In 
addition to building multiple hierarchies, you can use it to change existing 
hierarchies, regardless of whether you have defined them in GL or ADI. When you 
create hierarchies — using the drag and drop feature of this editor — ADI 
automatically updates parent segment attributes, as you build hierarchies.

6.2 Prerequisites for Using Account Hierarchy Editor
The prerequisites for using Account Hierarchy Editor are as follows:

■ The View Account Hierarchy option is available only if your responsibility 
allows you to modify account structures.

■ The GL profile option, GL AHE: Saving Allowed, must be set to Yes if you want 
to modify and save account hierarchies. If you change parent/child 
relationships that affect existing summary accounts, you must delete and 
recreate your summary templates in GL or run the Incremental Add/Delete 
Summary Accounts program.

■ If you use budgetary control with summary accounts, you cannot change child, 
parent, and rollup summary account relationships with the Account Hierarchy 
Editor.

■ If you want to create rollup groups, the groups must be unfrozen for the current 
chart of accounts. For details, see Defining Key Flexfields in Oracle Applications 
Flexfields Guide.

6.3 Using the Account Hierarchy Editor
Parent levels are displayed in Account Hierarchy Editor in a top-down fashion. A 
parent level contains a parent segment value that has one or more child segment 
values. When you select a parent level in Account Hierarchy Editor, you are 
selecting the parent segment value and all of its child values, which include lower 
level parents and their associated child values.
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The Account Hierarchy Editor comprises two windows: Segment Values and 
Hierarchy Diagram. While Segment Values displays segment values, Hierarchy 
Diagram displays your account hierarchies graphically in one or more windows. To 
build a hierarchy, you must select values from Segment Values, and then drag and 
drop them into Hierarchy Diagram.

6.3.1 Opening the Account Hierarchy Editor
To open the Account Hierarchy Editor:

1. From the ADI toolbar, choose Ledger > View Account Hierarchy.

When you start the Account Hierarchy Editor, ADI displays the following 
message: Do you plan on saving changes in this Account Hierarchy Editor 
session?

2. Select one of the following options:

■ Yes to prevent other users from modifying the segments you are working 
on.

■ No to allow other users to modifying the segments you are working on.

The Account Hierarchy Editor opens. 

3. From the Chart of Accounts menu, select the appropriate accounts. For 
example, Corporate Accounting Flex.

4. From the Segment menu, select the appropriate segment. For example, 
Company or Department.

The Account Hierarchy Editor displays the Segment Values window and 
Hierarchy Diagram window.

6.3.2 Adding New Parent Values
To add new parent values:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

Note: The View Account Hierarchy option is available only if 
your responsibility allows you to modify account structures.
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2. In the Segment Values window, click New parent value.

The Parent Attributes window opens.

3. In the Segment Value field, enter a new segment value. 

The segment value must conform to the security rules you have defined for the 
value set associated with the segment. The Account Hierarchy Editor validates 
the value you enter.

4. Optionally, in the Description field, enter a description for the hierarchy you are 
creating.

5. Optionally, from the Rollup Group menu, select the appropriate rollup group. 
For creating a rollup group, see Section 6.3.11, "Creating Rollup Groups".

6. If you are creating a parent value for the natural account segment, select an 
Account Type. 

7. Optionally, select the Enable check box if you want to use this segment value. 

8. Optionally, in the Effective field, enter a start and end date for this parent value.

9. Optionally, click New to open the Range window. This window allows you to 
define a new parent or child range for the hierarchy you’re creating. For details, 
see Section 6.3.4, "Adding Parent/Child Ranges".

10. Optionally, click Merge to open the Preview Merged Ranges window. This 
window allows you merge child ranges. For details, see Section 6.3.5, "Merging 
Child Ranges".

11. Click OK to create the parent value.

6.3.3 Adding New Child Values
To add new child values:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. In the Segment Values window, click New child value.

The Child Attributes window opens.

Note: You cannot delete segment values. You can only disable 
segment values by deselecting the Enabled check box.
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3. In the Segment Value field, enter the segment value for this child value.

4. Optionally, in the Description field, enter a description for this child value.

5. From the Account type menu, select the appropriate account type. 

6. Optionally, in the Effective region, enter a start date and end date for this child 
value.

7. Optionally, select the Enabled check box to enable this child value. 

8. Optionally, select the Allow Budgeting and Allow Posting check box(es).

9. Click OK to create the child value.

6.3.4 Adding Parent/Child Ranges
The Parent Attributes window permits you to add one or more parent/child ranges 
to the parent range you have currently selected in the Segment Values window. 
When you add/parent child ranges, they maintain their earlier hierarchy.

After you add parent/child ranges, you can drag and drop the parent value into the 
Hierarchy Diagram to view them graphically.

To add parent or child ranges to an existing parent range:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

Note: You cannot delete segment values. You can only disable 
segment values by deselecting the Enabled check box.

Note: You can also set Allows Budgeting and Allow Posting for 
the individual segment values. However, the account Allow 
Posting and Allow Budgeting attributes do not override the 
attributes for the individual segment values. For example, if you 
allow posting to an account containing a segment value that does 
not allow posting, you will not be able to post to that account. For 
details, see the Defining Accounts section in the Oracle General 
Ledger User Guide.
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2. In the Segment Values window, double-click a parent value.

The Parent Attributes window opens. 

3. Click New to open the Range window. This window allows you to define a new 
parent or child range for the hierarchy you are creating. 

4. Select the Parent Range or Child Range option, and then specify a start and end 
range.

Range segment values must conform to security rules you have defined for the 
value set associated with the segment. Values are validated when you close the 
Parent Attributes window.

5. Click OK to add this new parent or child range to the existing parent range.

6.3.5 Merging Child Ranges
The Parent Attributes window permits you to merge the child range of one or more 
parent ranges to the parent range you have currently selected in the Segment 
Values window. When you merge child ranges, they no longer maintain hierarchies 
with their former parent values.

After you merge child ranges, you can drag and drop the parent value into the 
Hierarchy Diagram to view them graphically.

To merge child ranges to an existing parent value:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. In the Segment Values window, double-click a parent value.

The Parent Attributes window opens. 

Note: You can enter overlapping child ranges for a parent 
segment value; however, each segment value in the overlapping 
ranges is assigned to the parent only once. 

If you change parent/child relationships that affect existing 
summary accounts, you must delete and recreate your summary 
templates in GL or run the Incremental Add/Delete Summary 
Accounts program.



Using the Account Hierarchy Editor

Using the Account Hierarchy Editor 6-7

3. Click Merge to open the Preview Merged Ranges window. This window 
displays the current child ranges and merged child ranges (if any).

4. Click Accept Merge to merge the current child ranges.

5. Click OK to merge the child range to the existing parent range.

6.3.6 Modifying Segment Value Description
In the Modify Node Descriptions window, you can change the description of 
groups of parent and child segment values within a hierarchy. You can also search 
and replace groups of description, isolate changes to a specific hierarchy level, or 
modify individual segment value descriptions. 

To modify segment value descriptions:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. In the Hierarchy Diagram window, drag and drop an existing hierarchy (parent 
value) from the Segment Values window. 

3. Select the entire hierarchy by choosing the top most parent or sub-parent within 
the hierarchy.

4. Right-click to open the shortcut menu. From this menu, choose Modify Node 
Descriptions.

The Modify Node Descriptions window opens. 

5. In the Find What field, enter the description you want to change.

6. In the Replace With field, enter the new description.

7. From In Level menu, select the appropriate value. Options are: ALL, 1 or 2. 

For example, if you select 2 for the second level, your description changes apply 
only to the segment values in the second level.

8. Optionally, limit your description by selecting the Parent or Child check box. 

9. Click Find to start your search. The Replacement Description region appears.

Use the Replacement Description region to review new and original 
descriptions before you apply any changes. 

10. Click Replace to apply changes.

11. Click Save to record your changes.
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6.3.7 Viewing Account Hierarchies
To view account hierarchies:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. Drag and drop the parent segment from the Segment Values window to the 
Hierarchy Diagram window.

3. Optionally, to display multiple hierarchies simultaneously, from the File menu, 
choose New. A new Hierarchy Diagram opens. Drag and drop the parent 
segment from Segment Values to the new Hierarchy Diagram.

6.3.8 Adding Hierarchies
Instead of using the Key Segment Values feature in GL, you can use the Account 
Hierarchy Editor to define a hierarchy for a segment of your chart of accounts. In 
addition to building new hierarchies, you can use the Account Hierarchy Editor to 
change existing hierarchies, regardless of whether you have defined them in GL or 
ADI.

To add hierarchies:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. Drag and drop the parent value into the Hierarchy Diagram to view the 
hierarchy graphically.

3. Double-click the parent segment value representing the top-most node of your 
hierarchy. 

The Parent Attributes window opens. 

Note: If you drag and drop new child values on to a parent in the 
Hierarchy Diagram window, ADI automatically updates the 
assigned child ranges in the Parent Attributes window.

Note: You can use the Account Hierarchy Editor only for 
segments with value sets using Independent validation.
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4. Click New to open the Range window. Repeat Steps in Section 6.3.4, "Adding 
Parent/Child Ranges".

5. Optionally, click Merge to open the Preview Merged Ranges window. Repeat 
Steps in Section 6.3.5, "Merging Child Ranges".

6. Click OK to add this new parent or child range to the hierarchy in the 
Hierarchy Diagram window.

7. Click Save to save your account hierarchy.

6.3.9 Duplicating Parent Hierarchies
You must have an existing hierarchy before you can duplicate a hierarchy. To create 
a hierarchy, see Section 6.3.7, "Viewing Account Hierarchies".

The duplicated hierarchy inherits all of the attributes from the source hierarchy, 
such as account type, rollup groups, effective dates, enabled status, and lower level 
parents and children. However, the new hierarchy is completely independent of the 
source hierarchy. Any changes that you make to the new hierarchy will not affect 
the source hierarchy unless both hierarchies share the same parent and child values.

When you duplicate a hierarchy, you can replace lower-level parent segment values 
using wild card searches, or you can specify the new parent segment values 
directly.

To duplicate hierarchies:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. In the Hierarchy Diagram window, select the appropriate node you want to 
duplicate.

3. Right-click to open the shortcut menu. From this menu, choose Duplicate 
Hierarchy to open the Duplicate Hierarchy window.

4. In the New Top Level Parent field, enter the new top level parent.

Note: You can replace lower level parent values when you 
duplicate hierarchies; however, you cannot replace child values. 

To change child segment values in the duplicate hierarchy, delete 
the child segment value, and then create a value or drag and drop 
an existing one from the Segment Values window.
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5. Optionally, in the Description field, enter a description for the new top level 
parent you are creating.

6. In Replace Lower Level Parent Values region, select the following options:

■ Find Parent to enter the lower level parent segment value you want to 
replace. You can enter a single parent segment value or use the wildcard 
symbol (?) to select multiple parent segment values.

■ Replace With to specify the value you want to replace. 

■ From In Parent Level menu, choose the appropriate option. You must 
replace higher level parent segment values first. For example, you must 
replace level 2 parent segment values before replacing level 3 parent 
segment values.

To build your duplicate hierarchy one step at a time, repeat Step 6 as often as 
necessary, making small changes each time. To see the effect of each 
incremental change, click Preview before making the next change.

7. After you specify the replacement parameters, click Add to add the 
replacement criteria in the Replacement Order pane. 

You can add as many replacement criteria as you want. When you click 
Preview, the Account Hierarchy Editor applies your replacement criteria in the 
order that they appear in the Replacement Order pane.

8. Click Preview to review your duplicate hierarchy, which appears in a new 
hierarchy diagram window. 

9. When you review the duplicate hierarchy, choose one of the following options 
from the Duplicate Hierarchy window:

Note: If you do not complete Step 6, you will get an exact 
duplicate of the original hierarchy.

Note: The order of your replacement criteria is important. You 
must replace higher level parent segment values before you replace 
any lower level parent segment values. The Account Hierarchy 
Editor warns you if you try to replace lower level parent segment 
values first.
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■ Undo to reverse the last change you made while replacing lower level 
parent values. It also restores the replacement criteria to the Replacement 
Order list. You can remove the criteria, and then define new replacement 
criteria.

■ Undo All to reverse all changes and close the duplicate hierarchy diagram 
window.

■ Accept to save the duplicate hierarchy locally. Note that it does not save the 
duplicate hierarchy to the database.

10. Click Save to save changes to the database.

6.3.10 Finding Segment Values
In the Account Hierarchy Editor, you can quickly search a segment value by 
specifying the segment value or description. To narrow your search, you can 
specify whether the segment value or description is a parent or child value. 

To search for segment values or segment value descriptions:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. Select any segment value in the Segment Values window. Right-click to open 
the Find menu. 

3. Choose Find to open the Find Segment window.

4. In the Find What field, enter the segment value or description of the segment 
value you want to find.

5. Optionally, select the Parent and/or Child check box to limit your search to 
parent and child values respectively.

6. In the Search for Segment region, choose the Value or Description check box 
depending on the parameter you have entered in the Find What field.

7. Click Find Next to find the segment value or description.

Note: Select both Parent and Child check boxes to find all values.
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6.3.11 Creating Rollup Groups
Rollup groups are groups of parent segment values that you can use to create 
summary accounts. In the Rollup Groups window, you can create, edit and delete 
rollup groups.

To create a rollup group:

1. Open the Account Hierarchy Editor. For details, see Section 6.3.1, "Opening the 
Account Hierarchy Editor".

2. From the Edit menu, choose Rollup Groups. The Rollup Groups window 
appears.

3. Click New to open the Rollup Group window.

4. Enter a name and description for the new rollup group.

5. Click OK to create the rollup group.

6. Optionally, to edit the description of a group, select the rollup group in the 
Rollup Groups window, and then click Edit. In the Description field, make the 
appropriate changes.

7. Optionally, to delete a group, select the rollup group in the Rollup Groups 
window, and then click Delete.

8. Click Save on the Account Hierarchy toolbar.

Note: When you change the contents of a rollup group used in a 
summary template, you must delete and recreate your summary 
accounts.
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7
Using the Create Asset Wizard

This chapter contains an overview of the Asset Wizard and discusses how to use it 
to create asset worksheets. Sections in this chapter include:

■ Section 7.1, "Overview of Create Asset Wizard"

■ Section 7.2, "Creating Asset Worksheets"

■ Section 7.3, "Creating Layout Templates"

■ Section 7.4, "Uploading Asset Data to Oracle Assets"
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7.1 Overview of Create Asset Wizard
The Create Asset Wizard provides a spreadsheet-based interface to simplify asset 
creation in a disconnected environment. You can use this wizard to automatically 
build personalized asset entry spreadsheets based on the information required by 
your organization’s specific implementation of Oracle Assets. You can enter your 
asset data manually, use list values, and take advantage of Excel’s data entry 
shortcuts. You can also import data files from legacy systems or third party 
payables applications into the asset worksheet. After you have finished your 
worksheet, you can upload it to Oracle Assets.

7.2 Creating Asset Worksheets
To create an asset worksheet:

1. From the ADI toolbar, choose Assets > Create Asset.

The Create Asset wizard starts.

2. From the Select Corporate Depreciation Book menu, select the appropriate 
book.

3. Optionally, from the Select Layout menu, choose the appropriate layout. 

If you do not choose a layout option, the wizard automatically selects the 
default layout. For more details, see Section 7.3, "Creating Layout Templates".

4. Click OK to create the Asset Worksheet.

ADI displays the Asset Worksheet. It comprises two main areas: header and 
context.

Note: If you have a locally-saved asset worksheet, double-click to 
open the worksheet. If ADI is installed, but not running, the ADI 
toolbar starts automatically when you open the asset worksheet.

Note: The Oracle Assets profile option, FA: Security Profile, 
extends to users working with Oracle Assets in ADI. Your list of 
choices may be limited to sets of books associated with your 
responsibility. For more information, see Oracle Assets User Guide.
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The header region contains details such as Corporate Book, Database, 
Accounting Date, Asset Type, Depreciate, and In Physical Inventory. Some of 
these cells will be locked and your choices may be limited to sets of books 
associated with your responsibility.

The context region consists of columns for Upl (upload), Asset Number, 
location details, categories, units and cost.

5. In the Context region, enter the asset number in the Asset Number column.

6. In the Location column, enter appropriate information. Double-click inside any 
row to open the Account Segment Values window, and select the appropriate 
segment values (country, state, etc.)

7. In the Category column, enter appropriate information. Double-click inside any 
row to open the Account Segment Values window, and select the appropriate 
major and minor category (server, software, etc.).

8. Enter appropriate values in the Units and Costs columns. Double-click inside 
any row to open the Account Segment Values window, and select the 
appropriate values.

9. Optionally to, add more rows, unprotect the worksheet, and then choose Insert 
> Rows from the Excel menu.

10. Optionally to, create additional worksheets in the same session, from the ADI 
toolbar, choose Assets > Create Asset, and then continue with entering 
information as discussed in this section.

Note: ADI automatically places a flag character in the Upload 
column for every asset entry that you make.

You can enter data manually or import data from legacy systems or 
third party payables applications to your asset worksheet. For 
details, see Appendix B, "Importing Text Files".

Note: When you create additional worksheets, you can choose the 
New Workbook or Current Workbook options in the Create Assets 
wizard.
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11. Click Save to save the asset worksheet locally.

After you create an asset worksheet, you must upload the worksheet to Oracle 
Assets. For details, see Section 7.4, "Uploading Asset Data to Oracle Assets".

7.3 Creating Layout Templates
Layout templates allow you to select the fields that should be included in the asset 
worksheet. They also control the order in which the data fields appear in your 
worksheet.

You can create a new layout template or edit, view, copy, rename, or delete an 
existing layout template. Additionally, you can make layouts available to other 
users by making it public.

To create a new layout template:

1. From the ADI toolbar, choose Assets > Create Asset.

The Create Asset wizard starts.

2. In the Create Assets window, click Actions > New.

3. In the New Layout window, enter a name for the new layout, and then click 
OK.

The Edit Layout window opens.

4. Optionally, select the Public check box to make this layout template available to 
other users.

Note: The Actions button is located beside the Select Layout 
menu.

Note: The fields in the Header region are mandatory. 

The Lines region contains some mandatory fields (indicated by a 
red asterisk) that you must include in the layout template.
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5. Drag and drop the following fields to the Lines region to make them available 
in your template: 

■ Header level mandatory fields — Accounting Date, Asset Type, Depreciate, 
and In Physical Inventory.

■ Context level mandatory fields — Asset Number, Location, Category, 
Units, Cost, Description, Expense Account, and Date Placed in Service.

6. Optionally, from the Available Fields region, drag and drop required fields to 
the Lines region to make them available in your template.

7. Optionally, to omit fields in your worksheet, from the Lines region, drag and 
drop fields that you do not require to the Available Fields region.

8. Optionally, use the arrow keys above the Line region to move your columns to 
the left, right or extreme corners of the layout template.

9. Click OK to create the template. 

10. Optionally, to customize an existing layout template, from the Select Layout 
menu, choose the template you want to customize, and then choose Actions > 
View/Edit.

11. Optionally, to copy an existing layout template, from the Select Layout menu, 
choose the template you want to copy, and then choose Actions > Copy. In the 
Copy Layout window, enter a new name for the template you want to copy.

Similarly, you can rename an existing layout template by choosing Actions > 
Rename.

Continue to create an asset worksheet using the Create Asset wizard using the 
appropriate layout template.

7.4 Uploading Asset Data to Oracle Assets
After creating asset data using an asset worksheet, you must upload asset data to 
Oracle Assets. Uploading is a two-step process. First, you must upload your asset 
data to the interface table. Then, you must post the asset data from the interface 
table to Oracle Assets.

■ Section 7.4.1, "Uploading Asset Data to the Interface Table"

■ Section 7.4.2, "Posting Assets from the Interface Table to Oracle Assets"
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7.4.1 Uploading Asset Data to the Interface Table
ADI automatically places a flag character in the Upload column for every asset 
entry in your asset worksheet. When you start the asset upload process, you can 
choose to process all rows or only the rows that are marked for upload.

To upload asset data from an asset worksheet to the interface table:

1. Open the asset worksheet.

2. From the ADI toolbar, choose Assets > Upload to Interface.

The Upload Assets to Interface window opens.

3. In the Rows to Upload region, select one of the following options:

■ Flagged Rows to upload only those rows that are marked with a flag 
character in the upload column of your worksheet.

■ All Rows to upload all rows in your worksheet.

4. In the Create Assets region, select one of the following options: 

■ Create Assets Now (Post) to start the Create Assets process and create 
assets automatically after the upload completes.

5. From the Asset Status menu, select one of the following options:

■ New to upload a new asset worksheet.

■ On Hold to upload an asset worksheet that has been put on hold.

■ Post to post the information to Oracle Assets.

6. Click OK to upload your asset worksheet

Note: If you copy and paste an asset entry, ADI does not place a 
flag character in the Upload column for your new asset entry. You 
can manually enter one by placing your cursor in the upload 
column cell where you want the flag character, and then type any 
character or number.

Note: You can select the Create Assets Now (Post) check box only 
if you have also selected an asset status of Post from the Asset 
Status menu (see step that follows). 
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For rows that were not uploaded successfully, ADI provides an explanation in 
the Messages section of the asset worksheet. If you select the Show Upload 
Success Indicator check box in the General Options window, ADI displays 
status indicators in the Messages section for each asset entry.

If you have selected the Create Assets Now (Post) option, ADI submits your 
Create Assets Now request and submits a concurrent request to monitor your 
request.

7.4.2 Posting Assets from the Interface Table to Oracle Assets
You can post assets to Oracle Assets only after you upload asset data from asset 
worksheets to the interface table.

To post assets from the interface table to Oracle Assets:

1. From the ADI toolbar, choose Assets > Submit Process > Post Mass Additions.

2. Select the corporate depreciation book for which you want to post your mass 
additions.

An asset can belong to any number of depreciation books, but must belong to 
only one corporate depreciation book. You must assign a new asset to a 
corporate depreciation book before you can assign it to any tax books. You can 
only assign the asset to a book for which you defined the asset category. Oracle 
Assets defaults financial information from the asset category, book, and date 
placed in service. For more details, see the Depreciation Rules section in the 
Oracle Assets User Guide.

3. Choose OK to submit your request.

Note: The Upload process validates all asset data, and verifies 
field type and length. ADI also performs flexfield validation, 
cross-validation and segment security checking. In addition, ADI 
makes sure that required fields are entered when the asset status is 
set to Post. If the asset status is set to On Hold or New, null entries 
in the required data fields are accepted.

Note: When you post mass additions to Oracle Assets, this 
process will not submit the Mass Additions Posting Report. You 
need to submit this request separately.
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8
Using the Record Physical Inventory Wizard

This chapter contains an overview of the Record Physical Inventory wizard and 
discusses how to use it to create inventory worksheets. Sections in this chapter 
include:

■ Section 8.1, "Overview of Record Physical Inventory Wizard"

■ Section 8.2, "Prerequisites for Using the Wizard"

■ Section 8.3, "Creating Physical Inventory Worksheet"

■ Section 8.4, "Uploading Physical Inventory Data to Oracle Assets"
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8.1 Overview of Record Physical Inventory Wizard
The Record Physical Inventory wizard provides a spreadsheet-based interface to 
simplify the physical inventory process. You can use this wizard to automatically 
build personalized inventory spreadsheets based on the information required by 
your organization’s specific implementation of Oracle Assets. You can enter your 
inventory data manually, use list values, and take advantage of Microsoft Excel’s 
data entry shortcuts. You can also map files created from scanned barcode data into 
the inventory worksheet. After you have finished the inventory worksheet, you can 
upload the data to Oracle Assets.

With this wizard, you can:

■ Customize physical inventory worksheets.

■ Use the powerful spreadsheet features of Microsoft Excel to create worksheets.

■ Save a physical inventory worksheet to a file, which can then be transferred to 
another PC for further changes, even while being disconnected from the Oracle 
Assets database.

■ Generate comparison reports to determine if assets are missing or are in the 
wrong location.

8.2 Prerequisites for Using the Wizard
Prerequisites for using the Record Physical Inventory wizard are as follows:

■ You must create a physical inventory in Oracle Assets before you can use the 
ADI Inventory Wizard. 

■ Ensure that the In Physical Inventory check box is selected for all assets in 
Oracle Assets that you want to include when you generate the Physical 
Inventory Comparison report.

For more details, see the Physical Inventory section in the Asset Maintenance 
chapter of the Oracle Assets User Guide.

8.3 Creating Physical Inventory Worksheet
To create a physical inventory worksheet:

1. From the ADI toolbar, choose Assets > Record Physical Inventory.

The Record Physical Inventory wizard starts.
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2. From the Select Inventory menu, choose the appropriate inventory.

3. Optionally, from the Select Layout menu, choose the appropriate template.

If you do not choose a layout option, the wizard automatically selects the 
default layout. 

Table 8–1 describes the mandatory fields required for creating inventory 
templates. 

Inventory layout templates are similar to asset layout templates. For more 
details on creating templates, see Section 7.3, "Creating Layout Templates" in 
Chapter 7, "Using the Create Asset Wizard".

4. Click OK to create the inventory worksheet.

ADI displays the Inventory Worksheet. It comprises two main areas: header 
and context.

The header region contains details such as Inventory Name, Database, and 
Location. Some of the cells in the header area will be locked and your choices 
may be limited to sets of books associated with your responsibility.

The context region consists of columns for Upl (upload), Asset Number, Units, 
Description and Messages.

Note: If you have a locally-saved inventory worksheet, 
double-click to open the worksheet. If ADI is installed, but not 
running, the ADI toolbar starts automatically when you open the 
inventory worksheet.

Table 8–1 Mandatory Fields for Creating Inventory Templates

Field Description

Location A mandatory header level field used in the inventory template.

Units A mandatory header level field used in the inventory template.

Asset Number

Tag Number

Serial Number

Additional fields used in the inventory template. It is mandatory to use 
one of these fields when you create an inventory template.
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5. In the Location column, enter appropriate information. Double-click inside any 
row to open the Account Segment Values window, and select the appropriate 
segment values (country, state, etc.)

6. In the Units column, enter appropriate information. 

7. In the Asset Number, Tag Number and/or Serial Number columns, enter 
appropriate information. 

8. Optionally, to add more rows, unprotect the worksheet, and then choose Insert 
> Rows from the Microsoft Excel menu.

9. Optionally, to create additional worksheets in the same session, from the ADI 
toolbar, choose Assets > Record Physical Inventory, and then continue with 
entering information as discussed in this section.

10. Click Save to save the inventory worksheet locally.

11. After you create an inventory worksheet, you must upload the worksheet to 
Oracle Assets. For details, see Section 8.4, "Uploading Physical Inventory Data 
to Oracle Assets".

8.4 Uploading Physical Inventory Data to Oracle Assets
After creating inventory data using an inventory worksheet in ADI, you must 
upload the data to the FA_INV_INTERFACE table in Oracle Assets. After you have 
uploaded your physical inventory data and run the Physical Inventory comparison 
program, Oracle Assets generates a status code based on the information it has 
stored about the asset and the information you have provided during the physical 
inventory process.

Note: ADI automatically places a flag character in the Upload 
column for every asset entry that you make.

You can enter data manually in the inventory worksheet or import 
data from barcode scanner devices into your physical inventory 
worksheet. For details, see Appendix B, "Importing Text Files".

Note: When you create additional worksheets, you can choose the 
New Workbook or Current Workbook options in the Record 
Physical Inventory wizard.
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After completing the comparison, the comparison program updates the FA_INV_
INTERFACE table, indicating the assets in physical inventory that cannot be 
reconciled with the assets in Oracle Assets, and, if necessary, the type of adjustment 
that needs to be made (either a unit adjustment or location adjustment). If there are 
no differences between the Oracle Assets data and the physical inventory data for a 
particular asset, and the asset meets the other requirements for inclusion in the 
physical inventory process, the asset will automatically have a status of 
RECONCILED. If there are differences between the Oracle Assets data and the 
physical inventory data for a particular asset, or the asset does not meet the 
requirements for inclusion in the physical inventory process, another status code 
will be assigned to the asset. You can view the comparison data online using the 
Find Physical Inventory Comparison window, or by running the Physical Inventory 
Comparison Report from the Request Center.

For more details, see the Loading Physical Inventory Data and Physical Inventory 
Comparison Program sections in the Asset Maintenance chapter of the Oracle Assets 
User Guide.

After you finish running physical inventory and generating reports, you need to 
reconcile your physical inventory data with your Oracle Assets data. For more 
details, see the Reconciliation section in the Asset Maintenance chapter of the Oracle 
Assets User Guide.

8.4.1 Uploading Inventory Data from the Worksheet
ADI automatically places a flag character in the Upload column for every inventory 
entry in your worksheet. When you start the inventory upload process, you can 
choose to process all rows or only the rows that are marked for upload.

To upload inventory data from an inventory worksheet:

1. While viewing your physical inventory worksheet, from the ADI toolbar, 
choose Assets > Upload to Interface.

The Upload Physical Inventory to Interface window opens. 

Note: If you copy and paste an inventory entry, ADI does not 
place a flag character in the Upload column for your new entry. 
You can manually enter one by placing your cursor in the upload 
column cell where you want the flag character, and then type any 
character or number from your keyboard.
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2. In the Rows to Upload region, select one of the following options:

■ Flagged Rows to upload only those rows that are marked with a flag 
character in the upload column of your worksheet.

■ All Rows to upload all rows in your worksheet, regardless of whether 
changes have been made.

3. In the Duplicate Assets region, select one of the following options:

■ Do Not Upload to prevent ADI from uploading the physical inventory 
worksheet rows. An error message will be displayed on the worksheet 
indicating the rows that were not uploaded successfully.

■ Increment Units to allow ADI to add the units in the physical inventory 
worksheet row to the corresponding entry already made in the FA_INV_
INTERFACE table.

■ Replace Units to allow ADI to replace the entries in the FA_INV_
INTERFACE table with the new rows in the physical inventory worksheet.

4. In the Compare Physical Inventory region, select one of the following options:

■ Run Comparison to start the inventory comparison process automatically 
after the upload completes.

■ View Results to automatically run the inventory comparison report when 
you upload the physical inventory data.

5. Click OK to start the inventory upload.

■ If you have selected the Run Comparison option, ADI verifies whether your 
inventory data is valid and submits a concurrent request to run the 
inventory comparison program.

■ If you have selected the View Results option, ADI submits an additional 
concurrent request to generate a report so that the comparison data can be 
viewed.

■ If there are errors in the upload, ADI does not submit any concurrent 
requests. 

■ If there are no errors in the upload, ADI displays the inventory comparison 
request ID, and displays a message indicating that a concurrent request has 
been submitted for the inventory comparison process request ID.

■ If you have selected the Show Upload Success Indicator from the General 
Options window, ADI displays status indicators in the Messages section for 
each inventory entry.
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8.4.2 Viewing Results of the Comparison Program
You can view a comparison of the inventory data you have uploaded using ADI to 
Oracle Assets by checking View Results when you select your upload options. This 
triggers a concurrent request that runs the report. The report will be monitored in 
the Request Center. You can publish this report using the Request Center to 
Microsoft Excel, a text file, or html file.

For more details about the inventory comparison program, see the Physical 
Inventory Comparison Program section in the Asset Maintenance chapter of the 
Oracle Assets User Guide.

To view the results of the Physical Inventory Comparison:

1. From the ADI toolbar, choose Assets > > Submit Process > Compare Physical 
Inventory.

The Submit Physical Inventory Comparison window opens.

2. In this window, select the following options:

■ Category to run the comparison program for a particular category.

■ Location to run the comparison program for a particular location.

For more details, about category and location, see Setup Steps section of the 
System Setup chapter in the Oracle Assets User Guide.

3. Highlight the inventory records for which you wish to run the comparison 
program.

4. Select the View Results check box to automatically run the inventory 
comparison report in the Request Center.

5. Click OK to run the comparison program and view the results of the 
comparison in a report, if you have selected the View Results check box in the 
previous step. You may also double click the records for which you want to run 
the comparison program to submit your request(s).

Note: Select both options if you want to run the comparison 
program for a category and location combination.
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9
Using the Request Center

This chapter contains an overview of the Request Center and discusses how to use it 
to submit and publish requests, specify publishing options, use themes, and view 
and cancel requests. Sections in this chapter include:

■ Section 9.1, "Overview of Request Center"

■ Section 9.2, "Using the Request Center"

■ Section 9.3, "Submitting Reports"

■ Section 9.4, "Publishing Reports and Changing Template Options"

■ Section 9.5, "Specifying Publishing and Submission Options"

■ Section 9.6, "Specifying Report Options"

■ Section 9.7, "Using Themes"

■ Section 9.8, "Formatting Themes with Tokens"

■ Section 9.9, "Applying Cell Level Formatting"

■ Section 9.10, "Viewing Report Output and Logs"

■ Section 9.11, "Monitoring and Cancelling Requests"
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9.1 Overview of Request Center
You can use the Request Center as a centralized tool for submitting, monitoring, 
and publishing reports. With the Request Center, you can:

Submit Reports: You can submit Standard (Fixed Format and Variable Format) or 
Financial Statement reports from the Request Center. You can also schedule your 
reports to run at specific times and intervals using Oracle application’s request 
submission features.

Publish Report or Request Sets: Publish a set of reports, Standard Reports, or 
Financial Reports that you frequently use from GL and Oracle Assets. Additionally, 
process all reports in your Request Set based on the themes, submission, and 
publishing options that you apply to each report.

View Requests: Retrieve request submission details or logs and view them in your 
preferred text viewer.

Cancel Requests: Cancel any pending requests you have submitted.

Format Reports: Use report themes to format report output. Additionally, create 
themes or customize existing themes and apply their formatting to your reports.

Publish Output: Download and publish a selected request’s report output to a web 
page, Excel worksheet, text viewer, XBRL, or into Report Manager.

Publish Reports: Publish your reports to a spreadsheet, text file, or web pages 
stored on a local server or Report Manager.

View or Print Reports: View your reports from a spreadsheet, text viewer or web 
browser. Reports you publish to a Report Manager can be accessed via Oracle Self 
Service Web Applications or the Report Manager Kiosk.

Monitor Requests: Monitor specific requests and receive automatic notification 
when they have completed.

Sign On/Off: Sign on to or disconnect from applications databases, and change 
responsibility from within the Request Center.

Launch Other Products: Launch ADI and other Oracle Applications directly from 
the Request Center toolbar.
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9.2 Using the Request Center
The sections that follow discuss how to start the request center and specify request 
center options.

9.2.1 Starting Request Center
To start the Request Center:

1. From the Start menu, choose Programs > Oracle ADI > Request Center. 
Alternatively, from the ADI toolbar, click Application > Request Center.

2. Sign on to a database, using your Oracle Applications username and password.

9.2.2 Specifying Request Center Options
You can set various Request Center options from the Options window. 

To specify request center options:

1. Start the Request Center. For details, see Section 9.2.1, "Starting Request 
Center".

2. Click Options on the Request Center toolbar to open the Options window.

3. In this window, specify various request center options. For details, see 
Section C.4, "Specifying Request Center Options" in Appendix C, "Toolbar and 
Other Options".

9.3 Submitting Reports
Table 9–1 describes the types of reports you can submit using the Request Center.

Note: For Request Center shortcuts, see Appendix E, "ADI 
Toolbar and Request Center Shortcut Keys".

Table 9–1 Report Types Available for Submission using the Request Center

Report Type Description

Standard (Fixed Format) You can submit any of the standard reports that are available 
in Oracle Applications, if they are available for your 
responsibility.
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9.3.1 Submitting Standard Reports
The procedure for submitting a standard fixed format and variable format report is 
similar except that you have to specify reduction criteria for a variable format 
report.

To submit a standard report:

1. Click Submit Report on the Request Center toolbar. 

The Report Submission and Publishing window appears.

2. Select one of the following options:

■ Standard (Fixed Format) to submit the fixed format report.

■ Standard (Variable Format) to submit the variable format report.

3. Optionally, select the Publish Report check box if you want the report to be 
published automatically after it finishes running. 

4. Optionally, select the Prompt check box if you want ADI to prompt you before 
it publishes the report automatically. 

If you select the Publish Report check box, and if the Prompt check box is not 
selected, ADI automatically publishes the report.

Standard (Variable 
Format)

You can submit any standard (variable format) report for 
Oracle Assets, if your responsibility allows.

Financial Statement You can submit any financial statement reports (FSG) that 
have been defined, if your responsibility allows you to access 
the reports.

Ad Hoc You can define and submit an ad hoc report.

RXi Reports Submit RXi reports with attribute sets defined in Oracle 
Applications.

Note: If you do not select the Publish Report check box, the 
Publishing button will not be available. You have to manually set 
the publishing options and then publish the report. 

Table 9–1 Report Types Available for Submission using the Request Center

Report Type Description
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5. From the report list, select the standard report you want to run. Alternatively, 
click Find to query a report name.

6. ADI prompts you to enter the reduction criteria. Do one of the following:

■ For fixed format reports, click OK and do not enter any reduction criteria.

■ For variable format reports, enter the appropriate reduction criteria. 

7. Click Submission for ADI to display report parameters.

8. Select or enter standard report parameters in the region below the list.

9. Optionally, click Publishing to set your report publishing options. For details, 
see Section 9.5, "Specifying Publishing and Submission Options".

10. Optionally, click Options to set your report submission options. For details, see 
Section 9.5, "Specifying Publishing and Submission Options".

11. Click OK to submit your request. 

When you submit a request, you will receive a message containing the Request 
ID number. The request ID number is displayed on the Pending and Completed 
pages of the Request Center. Locate your request by choosing the Pending or 
Completed tabs in the Request Center. Each page displays reports by: 

■ Request ID number

■ Financial report name under the column Program Name

■ Program name under the column Program Name for Standard (Fixed 
Format) and Standard (Variable Format) reports

9.3.2 Submitting Financial Statements or Ad Hoc Reports
The procedure for submitting financial statements and ad hoc reports is similar 
except that for ad hoc reports, you must select the required and optional ad hoc 
components.

Note: For details about each report’s parameters, see Oracle 
Applications User Guide. For example, see Running Standard Reports 
and Listings (Oracle General Ledger User Guide) for description of GL 
report parameters.
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To submit a financial statement or ad hoc reports:

1. Click Submit Report on the Request Center toolbar. 

The Report Submission and Publishing window appears.

2. Select Financial Statement as the report type.

3. Optionally, select the Publish Report check box if you want the report to be 
automatically published after it finishes running. 

4. Select the Prompt check box if you want ADI to prompt you before it publishes 
the report automatically. 

If you select the Publish Report check box, and if the Prompt check box is not 
selected, ADI automatically publishes the report.

5. Do one of the following:

■ To submit a financial report, from the Existing Report list, select a report. 
Alternatively, click Find to query a report name. ADI prompts you to enter 
the reduction criteria. For financial statements, click OK and do not enter 
any reduction criteria. 

■ To submit an ad hoc report, leave the Existing Report field blank and click 
Select Components to open the Select Ad Hoc Report Components window. 
Enter the ad hoc report component details. For details, see Section 9.6.1, 
"Specifying Report Objects for Ad Hoc Reports".

6. Click Submission for ADI to display report parameters.

7. Optionally, from the Period menu, select the appropriate period. For example, 
Jan-02.

8. Optionally, from the Date, Content Set, Segment Override, Rounding Option 
and Currency menu, select the appropriate options.

9. Optionally, select the Exceptions Only check box to submit reports for 
exceptions only.

10. Optionally, click Publishing to set your report publishing options. For details, 
see Section 9.5, "Specifying Publishing and Submission Options".

Note: If you run an existing report that already has a content set 
defined, you can override the original content set by specifying a 
new one when you submit the report.
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11. Optionally, click Options to set your report submission options. For details, see 
Section 9.5, "Specifying Publishing and Submission Options".

12. Click OK to submit your request. 

When you submit a request, you will receive a message containing the Request 
ID number. The request ID number is displayed in the Pending and Completed 
pages of the Request Center. Locate your request by choosing the Pending or 
Completed tabs in the Request Center. Each page lists reports by: 

■ Request ID number.

■ Financial report name under the column Program Name.

■ Program name under the column Program Name for Standard (Fixed 
Format) and Standard (Variable Format) reports.

9.3.3 Submitting an RXi Report
You can submit any RXi Report defined in Oracle Applications from the Request 
Center. The Request Center will monitor the submission and publication of your 
report. Formatting attributes and publishing parameters, defined in Oracle 
Applications, are applied to your report. In addition, security rules, defined in 
Oracle Applications, are extended to users submitting RXi reports from the Request 
Center. 

To submit an RXi report:

1. Click Submit Report on the Request Center toolbar. 

The Report Submission and Publishing window appears.

2. Select RXi as the report type.

3. Click Publishing and Options to review how formatting and publishing options 
were applied in Oracle Applications. 

Note: Standard Request Center formatting and publishing 
options, such as report themes and output types, cannot be applied 
to RXi reports.

You must create RXi reports in Oracle Applications with applied 
attribute sets and publishing parameters.
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Formatting and publishing options will automatically be assigned by the 
Request Center. These options cannot be changed.

4. Click OK to submit your RXi report. 

The Request Center monitors the submission and publication of your RXi 
report.

9.4 Publishing Reports and Changing Template Options
You can submit report sets and request sets from any Oracle application. You can 
submit sets to group reports you frequently need, such as reports you rely on for 
month end closing.

■ Report Sets support FSG reports submitted from GL.

■ Request Sets support Financial and Standard reports submitted from any 
Oracle Application, such as GL, Oracle Assets, Oracle Receivables, or Oracle 
Payables.

For each report in your set, you can apply formatting and publishing options. You 
can save these options to a template.

To publish a report/request set or change publishing options for a defined 
template:

1. Submit a Report Set or Request Set from any Oracle application, such as GL or 
Oracle Assets. Note the Request ID.

2. Start the Request Center. For details, see Section 9.2.1, "Starting Request 
Center".

3. Click Publish Sets on the Request Center toolbar. 

The Publish Sets window opens.

4. Select one of the following options:

■ Click Publish to publish the reports. The Publish - Select a Set window 
opens.

■ Click Define to define publishing options. The Define - Select a Set window 
opens. 

5. Select one of the Financial Reports displayed in the respective windows. 
Alternatively, click Query to search for the report you want to publish, and then 
select it.
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6. Click OK to open the Select Publishing Options <for set name> window. All the 
reports and their publishing options for your set are displayed in this window.

7. Click Find beside the Publishing Template field to find the appropriate 
template. 

8. Click Find beside the Timeframe field to select the time frame for the report.

9. Select the check box for the report(s) you want to publish. You can make 
multiple selections or click Select All to select all reports.

10. Click Publishing Options beside each report to specify publishing options for 
each report separately. For example, you can select the output type as Web Page 
for one report and Spreadsheet for another. 

The Publishing Options window appears. For details, see Section 9.5, 
"Specifying Publishing and Submission Options".

11. Click OK in the Select Publishing Options window to publish all your reports.

The reports in your set will be published, and if you have selected the Define 
option, your publishing options will be saved under the template name you 
have defined.

9.5 Specifying Publishing and Submission Options
Publishing options are similar for standard and financial reports except that for 
standard variable format reports, you can specify an attribute set. You can publish 
your report output to web pages, a spreadsheet, text file, or Report Manager. 

Topics in this section include:

■ Section 9.5.1, "Opening the Publishing Page"

■ Section 9.5.2, "Applying Themes"

■ Section 9.5.3, "Specifying Output Type Options"

Note: Publishing options must be specified for all reports in your 
report set or request set. The Request Center does not process 
reports for which publishing options have not been specified.

Reports in a request set are published only when all the reports are 
complete.



Specifying Publishing and Submission Options

9-10 Oracle Applications Desktop Integrator User Guide

■ Section 9.5.4, "Applying Attributes"

■ Section 9.5.5, "Specifying Submission and Printing Options"

9.5.1 Opening the Publishing Page
To open the Publishing page:

1. Click Submit Report on the Request Center toolbar. 

The Report Submission and Publishing window appears.

2. Select the appropriate report type.

3. Optionally, if ADI prompts you to enter reduction criteria, enter the 
appropriate reduction criteria for the report.

4. Click Submission to specify report parameters.

5. Click Publishing to open the Publishing page.

In this page, you can apply themes, specify output type options, apply 
attributes, and specify publishing and printing options. For details, see the 
sections that follow.

9.5.2 Applying Themes
You create themes or customize existing themes in a spreadsheet environment 
using a combination of ADI and Microsoft Excel formatting features. For details, see 
Section 9.7, "Using Themes".

To apply a theme while publishing a report:

1. Open the Publishing page. For details, see Section 9.5.1, "Opening the 
Publishing Page".

2. Click Find above the Apply Theme field.

3. In the Request Center window, select the appropriate theme, and then click 
Open.

9.5.3 Specifying Output Type Options
You can publish your report as local web page, spreadsheet, in text format, or to the 
Report Manager.
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To specify output type options:

1. Open the Publishing page. For details, see Section 9.5.1, "Opening the 
Publishing Page".

2. Select the appropriate output type options. Table 9–2 describes the options 
available when you choose Local Web Page as your Output Type when 
publishing a report. For more details on some of the options discussed in this 
table, see Oracle Report Manager User Guide.

Table 9–2 Local Web Page Options in the Publishing Page

Option Description

Publish To (path field) Enter a path and filename for the web page you want to 
create. Optionally, click Find to locate the directory you 
want.

Note: If a Publish To value has been defined in the 
theme you’ve chosen, it overrides any value you 
enter now.

Launch Browser (check box) Select this option to display the report output in a 
browser.

Include Spreadsheet (check 
box)

Select this option to view both web page and spreadsheet 
output. When you view the report in the browser, it 
displays a link, which you can choose to retrieve the 
spreadsheet version of the report. Available for FSG and 
Ad Hoc reports only.

Include Text (Plain) File (check 
box)

Select this option to view both web page and text output. 
When you view the report in your browser, it displays a 
link, which you can choose to retrieve the text version of 
the report. Available for standard reports only.

Include Printable Copy (check 
box)

Select this option to view a web-based version of the 
report that is suitable for printing. When you view the 
report in your browser, it displays a link, which you can 
choose to display the printable version of the report. 
Available for standard reports only.

Link Reports (check box) If you have used a content set when you defined your 
report, you can select this option to include links to the 
separate report pages.

Note: If you select the Link Report check box, ADI 
creates a separate frame which contains navigation 
entries to all the report files created by ADI. 
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Separate Directories If you have used a content set when you defined your 
report, select this option to save each report page to 
distinct subdirectories. You may want to create distinct 
directories for each report for security reasons. You 
cannot define security access for files; however, you can 
define security access for directories.

Note: If you have used content sets in your report 
definition and you want to publish to the web, use 
Link Reports and Separate Directories together to 
create meaningful web reports.

New Workbook Select this option to publish the report to a new Microsoft 
Excel workbook using the theme you have selected.

Current Workbook Select this option to publish the report to the currently 
active Microsoft Excel workbook. You can choose:

■ Add Output: to create the report as a new 
worksheet.

■ Replace Output: to overwrite an existing worksheet.

Apply Formatting (check box) Select this option only if you want to apply the theme 
specified in the Apply Theme list.

If you want to create a worksheet with no formatting, 
choose the nocolor.xls theme from the Apply Theme list.

Publish To Select this option to enter a path and filename for the text 
file report. Optionally, click Find to locate the directory 
you want.

Launch Viewer Displays the specified output viewer after the report 
output is complete if you select this option.

Publish To (path field) Allows you to specify a path to publish your report.

Timeframe Allows you to choose a publishing time frame. Options 
are all based on calendars defined in GL.

Note: You can use Timeframe to distinguish between 
a series of revised reports that have the same name.

Value Security Select this option to choose a security model. This field is 
available only if you are publishing an FSG report and 
you have selected Secured in the Organize Folders 
window.

Table 9–2 Local Web Page Options in the Publishing Page

Option Description
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9.5.4 Applying Attributes
You can use attribute sets to arrange information for GL, Oracle Accounts 
Receivable, and Oracle Assets reports using the standard variable format report 
type.

To specify attributes:

1. Open the Publishing page. For details, see Section 9.5.1, "Opening the 
Publishing Page".

2. In this page, click Actions in the Attribute Sets region, and then choose one of 
the following options:

■ New to create an attribute set.

■ View/Edit to view or edit an existing attribute set.

■ Copy or Rename to copy or rename an attribute set.

■ Delete to delete an attribute set.

3. When you click New or View/Edit, the Attribute Set window opens.

Availability Allows you to specify when the report should be 
released. Options include: Now, On Hold, and Specified 
Date and Time

Previewer(s) Allows you to select one or more previewers. Previewer 
can only be used in conjunction with the On Hold 
Availability. 

Include Text (Plain) File Allows you to include a plain text file in your report.

Include Printable Copy Allows you to include a printable copy in your report.

Note: You can specify attributes for standard variable format 
reports only.

Note: You can copy or rename the default attribute set as a base 
template to create a new attribute set.

Table 9–2 Local Web Page Options in the Publishing Page

Option Description
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4. Optionally, in this window, from the Available Attributes region, drag and 
drop the required attributes to the Selected Attributes region.

5. Optionally, click Add or Delete to add or delete available attributes to and from 
the Selected Attributes grid.

6. Optionally, apply sorting and group characteristics to attributes in columns by 
using the Ascending, Descending, and Group By buttons.

7. Optionally, move columns within the Selected Attributes grid to specify the 
order in which they should appear in your report.

8. Click Save to record your changes.

9.5.5 Specifying Submission and Printing Options 
When you submit a report for processing, you can specify the Oracle Applications 
request submission options. You can schedule the report to be processed at a 
specific time and date. You can also choose to print your report to a local or 
network printer, and you can specify the number of copies to print.

To set the report submission options:

1. Open the Publishing page. For details, see Section 9.5.1, "Opening the 
Publishing Page".

2. Click Options.

3. Optionally, enter the date and time you want to submit your report. 
Alternatively, click Set Date/Time to use the graphical Calendar window to 
select a date and time.

4. Optionally, select the Local Printer check box, and then choose the printer name 
if you want to print the report to a local printer.

5. Optionally, select the Server Printer check box, and choose the printer name if 
you want to print the report to a network printer. 

6. Optionally, enter the number of copies of the report you want to print.

7. Complete the report submission process.
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9.6 Specifying Report Options
Topics in this section include:

■ Section 9.6.1, "Specifying Report Objects for Ad Hoc Reports"

■ Section 9.6.2, "Specifying Report Publishing Options"

■ Section 9.5.5, "Specifying Submission and Printing Options"

9.6.1 Specifying Report Objects for Ad Hoc Reports
Before you can submit an ad hoc report from the Report Submission and Publishing 
window, you must specify the report objects you want to use to create the report.

To specify report objects for an ad hoc report:

1. Click Submit Report on the Request Center toolbar. 

The Report Submission and Publishing window appears.

2. Select Financial Statement as the report type.

3. Click Select Components to open the Select Ad Hoc Report Components 
window.

4. Click Find beside the Row Set field, and then select a row set.

5. Click Find beside the Column Set field, and then select a column set.

6. Optionally, click Find beside the Content Set field, and then select the content 
set.

7. Optionally, from the Row Order menu, select the appropriate row order. For 
example, Drill Down or Account Format.

Note: When you click Find, ADI prompts you to enter the 
reduction criteria. You don’t have to specify reduction criteria for 
ad hoc reports. Click OK to continue.

Note: When publishing to a spreadsheet, the column set in the 
report must be <= 255 columns.
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8. From the Display Set menu, select the appropriate display set. For more 
information, see the Defining Display Sets section in the Financial Reporting 
chapter of the Oracle General Ledger User Guide.

9. Click OK to return to the Report Submission and Publishing window.

10. Complete the report submission process.

9.6.2 Specifying Report Publishing Options
You can choose to have the report automatically published after your request 
completes processing. If you do not select the automatic option, you have to 
manually publish reports that are displayed in the Completed or Hotlist pages of 
the Request Center.

9.6.2.1 Publishing Report Output Automatically
To publish report output automatically:

1. Click Submit Report on the Request Center toolbar. 

The Report Submission and Publishing window appears.

2. Select the Publish Report check box to automatically publish your report.

3. Select the Prompt check box if you want ADI to prompt you before it publishes 
the report automatically. 

If you select the Publish Report check box, and if the Prompt check box is not 
selected, ADI automatically publishes the report. 

4. Click Publishing to open the Publishing page.

5. In this page, select the appropriate options. For details, see Section 9.5, 
"Specifying Publishing and Submission Options".

6. Click Options to open the Submission Options page. 

7. In this page, select the appropriate options. For details, see Section 9.5, 
"Specifying Publishing and Submission Options".

8. Complete the report submission process.

Note: If you do not select the Publish Report check box, the 
Publishing option will not be available. In such a case, you must 
publish the report output manually.
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9.6.2.2 Publishing Report Output Manually
To publish report output manually:

1. Select the report from the Completed or Hotlist page.

2. Click Publish Report on the Request Center toolbar. 

3. From the Apply Themes list, select the report theme you want to use for the 
published report. For details, see Section 9.5, "Specifying Publishing and 
Submission Options".

4. Select the Output Type for your report and complete the appropriate 
publishing options. For details, see Section 9.5, "Specifying Publishing and 
Submission Options".

5. Choose OK to publish the report.

The Request Center Messages window opens and displays the status of the 
request ID.

9.7 Using Themes
You can apply themes to format your report output for any report request that you 
submit through the Request Center. You can create themes or customize existing 
themes in a spreadsheet environment using a combination of ADI and Microsoft 
Excel formatting features. You can define fonts, font styles, and sizes, report 
backgrounds and colors, add a corporate logo to your report, and more. 

You can fine tune your themes by using tokens and cell level formatting to control 
the appearance of your report output down to the cell level. 

Note: To publish a financial report that was submitted from GL, 
the Output Option in the Define Financial Report window in GL 
must be set to Spreadsheet.

Note: If you republish a financial report, the Request Center 
applies the last theme you have used to your republished financial 
report output. You can choose a different theme from the Apply 
Themes list.
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You can define specific report formatting options before saving them as a report 
output theme. After you save a theme, you can apply it to any report output that 
you download to Microsoft Excel or publish as a web page. You can also edit and 
create themes.

9.7.1 Changing Current Theme
When you republish a report, the Request Center automatically applies the last 
theme you applied to your report type. You can change the theme from the 
Publishing page in the Report Submission and Publishing window. For details, see 
Section 9.5, "Specifying Publishing and Submission Options".

To change the current theme:

1. Select the report you want to republish from the Completed page.

2. Click Publish Report on the Request Center toolbar. 

3. From the Apply Themes list, select the report theme you want to use for the 
published report. For details, see Section 9.5, "Specifying Publishing and 
Submission Options".

Continue publishing your report. For details, see Section 9.6.2.2, "Publishing 
Report Output Manually".

9.7.2 Creating a Theme
To create a theme:

1. Click Format Report Output on the Request Center toolbar to open the Report 
Output Themes window.

Note: When you change the theme of a spreadsheet-based report, 
use the Replace Output feature. Otherwise, you will get two copies 
of the same report, but with different formatting.

Note: Click any of the light bulb icons in the Report Output 
Themes window to display helpful tips about creating or 
customizing themes.
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2. Click Create, and then select one of the following options:

■ Financial Statement

■ Standard (Fixed Format)

■ Standard (Variable Format)

ADI creates a theme worksheet using the options specified on the New Theme 
Tab of General Ledger Options window. For details, see Appendix C, "Toolbar 
and Other Options".

3. Customize the theme worksheet. For details, see Section 9.7.3, "Customizing 
Themes".

4. Save your theme by choosing File > Save As from the Microsoft Excel menu.

9.7.3 Customizing Themes
While customizing themes, note:

■ Cell level formatting and formatting with tokens will override the general 
formats you establish using customize themes.

■ The Request Center cannot extract the names of embedded images from a 
theme that is used to publish report output to the web. Instead, the Request 
Center looks in the theme directory for a GIF or JPEG file with the same name 
as the theme. If it finds a matching GIF or JPEG file, the Request Center displays 
the image at the top of each report page. 

■ The Request Center uses the most appropriate graphics file format when 
publishing reports that include a background. For example, if you choose a 
BMP file when publishing web output, the Request Center first tries to locate a 
GIF file of the same name. If a GIF file cannot be found, Request Center uses the 
specified BMP file.

Suggestion: Store all of your themes in the same directory on 
your PC. This makes it easier to find them. Also, if you have a lot of 
themes, group them in subdirectories under your main themes 
directory.
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To customize themes:

1. Click Format Report Output on the Request Center toolbar to open the Report 
Output Themes window.

2. Click Open to open Microsoft Excel. 

3. Click Open on the Microsoft Excel toolbar to open the theme you want to 
customize.

4. Optionally, in the Report Output Themes window, click Background to choose 
to use a background for any report you create with this report theme.

5. Optionally, if you want to insert a logo in your report theme, select a cell and 
choosing Insert > Picture from the Microsoft Excel menu.

6. Optionally, format the column widths in your theme using formatting 
capabilities in Microsoft Excel.

7. Optionally, change Report Title, Report Heading, Column Headings, Line Items 
or Amounts from within Microsoft Excel or by clicking Customize in the Report 
Output Themes window.

8. Optionally, click Publish To, and then select a default path and filename to use 
for publishing web-based reports with this theme. The related HTML files for 
the report are always stored in this location, regardless of the location you 
specify when you submit the report request. Use this feature when you need to 
periodically publish reports to a consistent location.

9. Optionally, enter the name of the macro in the Spreadsheet Custom Macro cell.

10. Optionally, click the right or left Line Item position to move the line item 
column to your desired column location. 

Your report output positions the line item column based on your theme 
definition.

Note: If the macro and report theme are located in the same 
workbook, you can enter the name of the macro.

If the macro is located in a separate workbook, that workbook must 
be open. You can save the workbook that contains the macro in the 
xlStart directory so that it is always loaded when Microsoft Excel is 
launched. With this option, you must enter the name of the 
workbook and macro (workbook.xls! macro).
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11. Optionally, you can customize themes applied to financial reports, using tokens 
to place titles, set of books, reporting period, report date and more anywhere in 
your financial report. For details, see Section 9.8, "Formatting Themes with 
Tokens".

12. Save your theme.

9.8 Formatting Themes with Tokens
You can customize themes applied to financial reports, using tokens to place titles, 
set of books, reporting period, report date and more anywhere in your financial 
report. 

■ Section 9.8.1, "Placing a Token in Report Themes"

■ Section 9.8.2, "Formatting with Line Item Tokens"

■ Section 9.8.3, "Formatting with Line Item Image Tokens"

9.8.1 Placing a Token in Report Themes
To place a token in your report theme:

1. Create a new theme or modify an existing report theme. For details, see 
Section 9.7.2, "Creating a Theme" or Section 9.7.3, "Customizing Themes".

2. Select a cell and type the ampersand symbol (&) followed by the token. 
Table 9–3 describes the formatting tokens for all reports except standard 
variable format reports and Table 9–4 describes the formatting tokens for 
standard variable format reports.

3. Format the cell using Microsoft Excel's formatting features.

Your financial report output displays the formatting you specified.

Note: Enter &Blank in a cell to prevent the display of any 
information from that cell in your report output.

Enter &FastFormatting in any empty cell in your worksheet to 
disable all cell level formatting. This allows you to quickly publish 
FSG reports for large volume of reports when cell level formatting 
is not required.
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Table 9–3 Formatting Tokens for All Reports

Description Token Reference Setting

Blank &Blank n/a

Content Set Expansion 
Value

&ContentSetExpansion
Value

Report Submission and Publishing 
window

Current Period &CurrentPeriod Period, Report Submission and 
Publishing window

Day of Interest Date &DOIDATE[n] Period, Report Submission and 
Publishing window

Day of Interest Day &DOIDAY[n] Period, Report Submission and 
Publishing window

FastFormatting &FastFormatting Disables all cell level formatting

Period of Interest 
Month

&POIMonth[n] Period, Report Submission and 
Publishing window

Period of Interest 
Quarter

&POIQUARTER[n] Period, Report Submission and 
Publishing window

Period of Interest Start 
Date

&POI StartDate[n] Period, Report Submission and 
Publishing window

Period of Interest Year &POIYear[n] Period, Report Submission and 
Publishing window

Report Currency &Currency Report Submission and Publishing 
window

Report Title &ReportTitle Existing Report, Report 
Submission and Publishing 
window

Report Published by &ReportPublishedBy User Name

Request ID &ConcurrentRequestID Request Center

Set of Books &SetofBooksName Set of books name

Save In XL 95 Format &SaveInXL95Format Report accessibility: Microsoft 
Excel 97 users can publish web 
output viewable by Microsoft 
Excel 95 users

Submission Date &SubmissionDate Date, Report Submission and 
Publishing window
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9.8.2 Formatting with Line Item Tokens
You can use line item tokens to replace line item text and expanded line item text in 
your financial report output. (Table 9–5 describes the line item tokens you can use 
to format reports.) Line item tokens can be placed anywhere in the line item 
column. Formatting you apply to any cell in the Parent line item row is applied to 
expanded rows in your financial report output.

To place a line item token in your report theme:

1. Choose any blank cell in the line item column to place your token.

2. Enter &T or &R to use a token.

3. Enter a space and the Parent line item or line item text you want to replace, 
surrounded by brackets. For example, enter _<Revenue>.

4. Enter a space and the new name you wish to use. For example, _<Total 
Revenue>. 

5. Save your work.

Table 9–4 Formatting Tokens for Standard Variable Format Reports

Token Description

&AF Autofit - ADI sets the width of the column to the number of 
characters of the largest output in that column.

&default_line_format Determines the formatting for the displayed output. All other cells 
below this cell in a column assume the same formatting 
characteristics.

&printable_format Determines the formatting for the printed output. All other cells 
below this cell in a column assume the same formatting 
characteristics.

Table 9–5 Line Item Tokens

Token Description

&T <Parent Line Item> 
<Replacement Text>

Replace Total value for parent to replace the Total value for an 
expanded row.

&R <Line Item Text> 
<Replacement Text>

Replace line item text to replace any line item text.
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9.8.3 Formatting with Line Item Image Tokens
You can use line item image tokens with sequence numbers to format lines above or 
below the row you specify. 

You must enter this token information in a specific order:

&L <sequence number> <line image above the row> <line image below the row>

Where:

&L: indicates that you want to use a line item image token.

Sequence number: is the sequence number of the row you want to format.

Line image above the row: is the token indicating the line type above the row.

Line image below the row: is the token indicating the line type below the row.

For example, the token line, &L<30>ND, instructs ADI to locate the row identified 
by sequence number 30, to place no line above the row, and to add a double line 
below the row.

Table 9–6 describes the line item tokens you can use to format reports.

Note: Any line item text you wish to replace must be specified 
exactly as it appears in the report definition. Indented text and 
multiple words must be entered exactly as the original, including 
all spaces and case.

Table 9–6 Line Item Image Tokens

Description Token Reference Setting

No Line &N <first setting above the row>

<second setting below the row>

Single Line &S <first setting above the row>

<second setting below the row>

Double Line &D <first setting above the row>

<second setting below the row>
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To place a line item token in your report theme:

1. Choose any blank cell in the line item column to place your token.

2. Enter &L to use a token.

3. Enter the sequence number of the row you want to format.

4. Enter N (no line), S (single line), or D (double line) for the type of line you want 
above the row and below the row.

5. Save your work.

9.9 Applying Cell Level Formatting
You can format individual cells in your financial report themes to refine the 
appearance of your report output. This feature works for financial reports with GL 
Release 11i, 11.0, and 10.7. 

In the report title, report heading, and column heading regions of your theme, you 
can format any cell or range of cells and the formatting is applied to your report 
output. You may also enter tokens, text, or numbers in any cell within these regions 
that you want to display in your report output. 

9.9.1 Applying Cell Level Formatting for Release 11.x
The report definition, created in GL or ADI, uses sequence numbers to locate the 
position of rows and columns in your report output. You can use these sequence 
numbers in your report themes to apply formatting to specific areas of your report 
definition. The Request Center matches the formatting specified in your report 
theme with the information in your report definition to generate formatted reports.

Note: Cell level formatting overrides the formatting you have 
defined for Report Title, Report Headings, Column Headings, Line 
Items, and Amounts in customized report output themes.

Cell level formatting (for Release 11i, 11.0, and 10.7) follows 
different processes. See sections that follow.

Note: You can remove rows from the Header region in your 
theme.
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Sequence numbers also act as tokens by automatically inserting row and column 
descriptions in the Line Item and Column Heading areas of your report output. To 
view sequence numbers associated with your report, see report definition in GL, or 
choose View Output/Log > View Output File in the Request Center toolbar.

To apply individual cell formatting to financial statement reports (Release 11.0 and 
later):

1. Use your report definition or view output in the Request Center to note the row 
and column sequence numbers for the cell or range of cells you wish to format.

2. In column A of your report theme, select the row you wish to format.

3. Enter the ampersand symbol (&) followed by the row sequence number you 
wish to use. 

4. Locate the column you wish to format, and then select the cell beneath the 
column heading.

5. Enter the ampersand symbol (&) followed by the column sequence number you 
wish to use. 

6. Use Microsoft Excel's formatting capabilities to format a cell or range of cells as 
you like.

The Request Center uses sequence numbers to reference formatting instructions 
in the report theme with the information in the report definition to generate the 
formatted report output.

Note: The Request Center searches for sequence numbers in the 
report output theme to determine format. If sequence numbers are 
not specified in the report output theme, it formats the report 
output using the steps described in Section 9.9.2, "Applying Cell 
Level Formatting for Release 10.7".

If you have upgraded to ADI 4.0 or later versions, tokens, line 
items, and sequence numbers are applied to report themes you 
have created in earlier ADI releases when you first publish a 
financial report using that theme.
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9.9.2 Applying Cell Level Formatting for Release 10.7
To apply individual cell formatting to a financial statement report output (Release 
10.7):

1. In column A of the report theme, select the cell for the row you wish to format.

2. Enter the name of the line item you wish to use as a format definition. For 
example, if your financial report definition contains a line item, Net Income, 
type Net Income in the selected cell. 

3. Use Microsoft Excel's formatting capabilities to format a cell or range of cells in 
that row.

The Request Center uses the theme to format information in the Net Income row of 
the report definition. It runs a series of processes to format your financial reports.

■ It first looks for line item names in the report theme and report definition. If the 
search finds matching line item names, for example Net Income, then 
formatting for Net Income in the report theme is assigned to the designated row 
in your report output.

■ If your report definition has more rows than specified in your report theme, it 
formats those extra rows based on the following criteria:

■ High level formatting for themes is based on region styles. Your 
spreadsheet contains report title, report heading, column heading, line item, 
and amounts regions. ADI provides default styles for these regions. If all 
other format choices listed above are exhausted, the Request Center uses 
default styles to format your report output.

■ The first cell in any column in the amount region determines the formatting 
for all cells below it in that column.

9.9.3 Applying Formatting for Expanded Rows
Your report definitions may include children rows as an expansion of a parent row. 
When you format cells in the first expanded row, the expanded rows that follow 
assume the same formatting. You can also format a cell or range of cells in any 
expanded row. 

If formatting is not applied to any expanded rows, the Request Center uses the 
defaults (above) to assign formatting.
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To format an expanded row:

1. Activate the cell below the Parent row in column A of your report theme.

2. Enter the ampersand symbol (&) and sequence number of the Parent row.

3. After entering the sequence number, enter E and the number for the position of 
the child row (for example, &20E1).

4. Use Microsoft Excel's formatting capabilities to format any cell or range of cells.

9.10 Viewing Report Output and Logs
To view output or log files using the Request Center:

1. Select the completed report from the Completed page.

2. Click View Output/Log on the Request Center toolbar. A list appears. For log 
files, choose View Log File.

ADI downloads the output or log file and opens it in the default output viewer 
you have specified in the Request Center Options window. 

9.11 Monitoring and Cancelling Requests
Topics in this section include:

■ Section 9.11.1, "Monitoring Requests"

■ Section 9.11.2, "Cancelling Requests"

9.11.1 Monitoring Requests
When you start ADI, the Request Center starts automatically. Any request that you 
submit from ADI is automatically monitored. When one of these requests finishes, 
the Request Center displays the completion status, if you have selected the Notify 
When Complete check box while submitting the request.

You can choose to monitor other requests as well, including those which are 
submitted from other Oracle Applications. New requests are placed automatically 
on a ’pending’ or ’completed’ list, depending on the status. When a pending request 

Note: You must enter and format each expanded row as a 
separate row in your report theme.
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is finished, the Request Center automatically moves the monitored request from the 
pending list to the completed list.

You can use the toolbar in the Request Center window to access Request Center 
features. 

There are four tabs you can select to view different information:

■ Pending: Displays all pending requests that you have submitted. 

■ Completed: Displays all completed requests that you submitted. 

■ Hotlist: Displays any completed requests that you have added to the hotlist. 

■ Databases: Displays all applications databases you have defined. It indicates 
whether you are connected to the database and shows how many requests 
related to the database are complete, pending, and hotlisted.

9.11.1.1 Start Monitoring Requests
To monitor a request:

1. Start the Request Center if it is not already running. For details, see 
Section 9.2.1, "Starting Request Center". Alternatively, if ADI is running, from 
the ADI toolbar, click Applications > Request Center.

2. Click Monitor Request on the Request Center toolbar to open the Select Request 
to Monitor window. It displays all requests submitted under your 
responsibility.

3. Choose which requests to include in the list by specifying the following 
Selection Criteria. Table 9–7 describes the selection criteria you can use for 
monitoring requests.

Note: When you submit an FSG report request, the name of the 
report appears in the column Program Name, on the Pending or 
Completed tab.

Table 9–7 Selection Criteria for Reports

Select this Option... To...

Request Status: 
Incomplete

Include pending, running, or paused requests in the list.

Request Status: Complete Include completed requests in the list.
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4. Click Query to retrieve a list of requests that meet the selection criteria you have 
specified. 

You can limit this list to the most recent number of requests you specified on 
the Options window, by selecting the Return Last Requests check box. 

5. Select a request from the list.

6. Click Add to add the request. The Request Center places the request in the 
Pending or Completed page, depending on the status.

7. Repeat the above steps to add multiple requests.

8. Click Close when you have finished adding requests.

Request Owner: 
[username]

View only your own requests.

Note: The Request Center displays the username you 
used to sign on to Oracle Applications.

All Users View requests submitted by all users.

Note: This option is available to system administrators 
only.

Further Limit By: Nothing View all requests that meet your Request Status and Request 
Owner selections.

Program Name Specify a program name to limit the requests that appear in 
the list to only those with the same program name.

Request ID Specify a request ID to limit the requests that appear in the list 
to only those with the same request ID.

Note: To query FSG reports, choose Program Name from the 
Further Limit By list. In the second list, choose Financial Statement 
Generator. The query results present you with a list of FSG report 
names.

Note: When ADI completes monitoring requests, they are 
automatically moved from the Pending page to the Completed 
page in the Request Center window.

Table 9–7 Selection Criteria for Reports

Select this Option... To...
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9.11.1.2 Stop Monitoring Requests
To stop monitoring a request:

1. Select the request you want to stop monitoring from the Pending, Completed, 
or Hotlist page of the Request Center window.

2. Click Stop Monitoring Selected Request on the Request Center toolbar.

9.11.2 Cancelling Requests
You can cancel pending requests or requests (under your responsibility) that are 
still running from the Request Center. Anyone with a system administrator 
responsibility can cancel any pending request.

To cancel requests:

1. Select a request from the Pending page.

2. Click Cancel Request on the Request Center toolbar.

3. Select Yes to cancel the request.

4. Click the Completed tab. Verify whether the Completed page displays the 
cancelled request with a status of either Cancelled or Terminated. 

■ Cancelled status indicates that the request was still pending at the time it 
was cancelled. 

■ Terminated status indicates that the request was already running at the 
time it was cancelled.

Note: To stop monitoring all requests and remove them from the 
Pending, Completed, or Hotlist pages, click Stop Monitoring All 
Requests on the Request Center toolbar.

Note: When you submit report or request sets, a request ID is 
created for each report processed in the set. You can cancel only 
individual reports that have a request ID and request sets.
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A
Oracle ADI Frequently Asked Questions

This appendix attempts to answer some of the frequently asked questions that you 
might have related to technical and functional issues. For installation related 
questions, see the FAQ section of Oracle Applications Desktop Integrator Installation 
Guide.

Answers to frequently asked questions about this product may also be found on 
Oracle MetaLink (http://metalink.oracle.com/). The main sections in this FAQ 
include:

■ Section A.1, "Technical Issues"

■ Section A.2, "Functional Issues"

http://metalink.oracle.com/
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A.1 Technical Issues
This section attempts to answer some of the frequently asked questions on technical 
issues.

Question: What versions of Microsoft Excel can I use with ADI?
You can use Microsoft Excel 97, 2000, 2003, or XP with ADI version 7.1 or later.

Question: What versions of Oracle Applications are supported?
The following versions of Oracle Applications are supported:

■ Oracle General Ledger Release 10.7 (character mode, 10SC, NCA) or later.

■ Oracle Assets Release 10.7 or later.

Question: What should I do if I have problems signing on to ADI? 
You need to define at least one applications database. This tells ADI how to connect 
to your database. For information on defining a database, see Section 1.7, "Selecting 
an Applications Database" in Chapter 1, "Introduction to Oracle ADI".

Question: What should I do if I get a runtime error when I sign on? 
This problem can occur with older versions of ADI when you do not have a budget 
or budget organization defined for your set of books. To fix this problem, define a 
budget or budget organization, or obtain a more recent version of ADI.

Question: When I try to sign on to ADI, I receive a message stating: 
"Error: ORA-12505: TNS:listener could not resolve SID given in connect 
descriptor." I can successfully use TNSping to verify that there is a 
listener on the server. What does this error mean?
This is a SQL Net error indicating that the SID does not exist on this host. Since you 
can TNSping, there is a listener on the host server, but the SID you are trying to 
connect to does not exist on this host.

You must ensure that the SID defined in your TNSNAMES.ORA file is 
synchronized with the SID on the host.
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Question: What does it mean when I receive the message "Could not 
establish an Oracle Objects session" when I try to sign on to ADI?
This message means that ADI cannot locate the %ORACLE_HOME%BIN directory 
in the path. The Oracle Installer should have added this directory to the path when 
you installed ADI. For more information, see Installing Oracle ADI, Oracle 
Applications Desktop Integrator Installation Guide.

If this directory was not added to the path, complete the following steps to add it 
manually:

1. Log in to Windows as a user with Administrator privileges.

2. For Windows NT 4.0/2000, choose Start > Settings > Control Panel > System 
(icon). 

If you use a different Windows operating system, see the relevant 
documentation for this operating system.

3. Do one of the following:

■ For Windows NT 4.0, choose the Environment tab. 

■ For Windows 2000, choose the Advanced tab and then click Environment 
Variables.

4. Select the Path variable, located in the System Variables region.

5. Add the %ORACLE_HOME%BIN path to the beginning of the variable in the 
Value region (for example, C:\ORANT\BIN;%SystemRoot%;...)

6. Choose OK to close the System window, and then close the Control Panel 
window.

7. Shut down and restart Windows NT 4.0/2000 before running ADI.

Question: What should I do if I get runtime error 1005 when ADI builds a 
new journal or budget worksheet?
This error occurs when Microsoft Excel tries to set printed page settings, and no 
printer is installed. Make sure that you have installed at least one printer in 
Windows. Also, you must select one of your installed printers as the default printer. 
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Question: What should I do if I get a runtime error and only a partially 
built journal or budget worksheet?
Check your AUTOEXEC.BAT file to ensure that the %ORACLE_HOME%IN 
directory is present. Usually, it will appear as follows: 
"PATH=C:RAWININ;C:OS;C:INDOWS"

Question: When I'm using ADI with Microsoft Excel 97, why does 
Microsoft Excel continually ask if I want to disable macros?
Microsoft Excel 97 includes a feature to help prevent Microsoft Excel macro viruses 
from infecting your PC. This feature assumes that any macro that runs 
automatically when a worksheet is opened (including the ADI Microsoft Excel 
add-in) may be a virus. If you use up-to-date virus software to protect your PC, it is 
probably safe to disable Microsoft Excel 97's macro virus detection feature.

You can disable macro virus detection in Microsoft Excel 97 on the popup window 
that appears when Microsoft Excel 97 detects an automatically run macro. Deselect 
the Always Ask Before Opening Workbooks with Macros check box, then choose 
Enable Macros to continue.

Question: Why do I receive a "Cannot find macro 
{filename}!{macroname}" error after opening a saved workbook?
Microsoft Excel 97 includes a macro virus protection feature that disables all of the 
macros within a workbook to prevent them from running. While this successfully 
prevents a macro virus from attacking your PC, it also prevents any application 
written in Microsoft Excel from working.

We recommend that you install on your PC, and keep current, one of the many 
commercially available anti-virus software products. This will protect your PC from 
all viruses, not just Microsoft Excel macro viruses.

After you have installed an anti-virus product, disable the Microsoft Excel macro 
virus protection feature as follows:

1. From the Microsoft Excel menu, choose Tools > Options.

2. Select the General tab.

3. Deselect the Macro Virus Protection check box.
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Question: What causes "Null Segment Value in Account" messages or 
"Invalid <field_name>" (when the field value is valid) errors?
Account segment "above prompts" (list of values prompts) must be unique, and 
cannot be the same as any field names used in your journal worksheet. Ensure that 
your "above prompts" are unique using the Define Key Flexfield Segments window 
in GL.

Question: Where are my ADI preferences stored?
ADI 3.0 (or later) stores preferences in the Windows Registry under the keys named 
HKEY_CURRENT_USER/Software/ORACLE/ADI and GLDI. If you upgrade 
from an earlier version of ADI, your custom preferences and values will be 
transferred automatically to the Windows Registry.

Question: Now that I can view my log and output files using the Request 
Center, can I change the report viewer?
Yes. You can use the Request Center options window to define your report viewer.

Question: What should I do if I get General Protection Faults (GPF) and 
other errors?
You can use the ADI Diagnostic Wizard to help solve such problems. This 
interactive tool guides you through a step-by-step process that eliminates many 
known problems. You can run the Diagnostic Wizard by choosing its program icon 
from the Oracle for Windows (or Windows NT) program group.

Question: Do I need to apply the 10SC patch to use ADI security?
No. You can manually set the profile options using the Application Developer 
responsibility. For details, see Enabling Security with ADI in the Oracle Applications 
Desktop Integrator Installation Guide.

Question: What should I do if I get a SQL error when trying to submit an 
FSG report through Reports?
This happens because Reports is unable to locate your printer. If you:

■ Do not want to print reports, set the profile option, Concurrent: Report Copies, 
to 0. 

■ Want to print reports, set the Printer profile option and ensure that the profile 
option, Concurrent: Report Copies, is set to 1 or greater.
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Question: What should I do if I get the message "Data source name not 
found and no default driver specified" when ADI is building a budget 
worksheet?
Make sure that the database names you have defined in ADI do not include special 
characters, such as commas, dollar signs, and pound signs. We recommend that you 
restrict the characters used in your database names to spaces, the characters A 
through Z, and the numbers 0 through 9.

Question: Why doesn't ADI's context-sensitive online help work properly 
with Internet Explorer?
If ADI's web-based online help has been installed locally on your PC, 
context-sensitive online help will not work properly with Internet Explorer. This is 
caused by a problem in Internet Explorer that prevents it from recognizing properly 
formatted URL references when those references are to web pages stored on a local 
drive.

You can resolve this problem by installing your ADI help files on a central web 
server within your organization and accessing online help from there. Note that this 
solution will also save a lot of disk space on the individual PCs within your 
organization since ADI's online help files do not have to be installed on each PC.

Question: Is the system security breached by giving users GWYUID, 
FNDNAM and Connect String information?
No. The transparency of the GWYUID and FNDNAM to users is in accordance with 
AOL security standards for client/server applications. Access to all tables is not 
possible with this information. Users may gain limited access to some basic tables 
through SQL. However, these records can only be viewed, and not updated. If your 
site does not want to expose this information to users, you can do so by defining all 
the database connections a user has access to in a secured DBC directory. Users will 
not be able to view any of the connection details for the fixed set of databases that 
have been defined for them. For details, see Post-Installation Tasks chapter in Oracle 
Applications Desktop Integrator Installation Guide.
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Question: What formatting features are supported in the Web Output 
option?
The Web Output format recognizes the following report formatting features:

■ Column Widths. If there is any value in the column that does not fit within the 
assigned column width, the browser automatically increases the width of the 
entire column to accommodate the entire view.

■ Alignment

■ Font Name

■ Font Size

Table A–1 provides an explanation of how the Microsoft Excel fonts are 
mapped to HTML fonts.

■ Font Types — Bold and Italic

■ Colors — Fore Color and Background Color

■ Images — Background Image and Logo

Features, such as cell borders, background patterns, font underline, page settings, 
custom formatting macros, etc., available in Microsoft Excel are not supported in 
Web Output.

Table A–1 Microsoft Excel Fonts Mapped to HTML

Microsoft Excel Font Size HTML Font Size

Size < 10 Size = 1

Size >= 10 and Size < 12 Size = 2

Size >= 12 and Size < 14 Size = 3

Size >= 14 and Size < 18 Size = 4

Size >= 18 and Size < 24 Size = 5

Size >= 24 and Size < 36 Size = 6

Size >= 36 Size = 7
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A.2 Functional Issues
This section attempts to answer some of the frequently asked questions on 
functional issues.

Question: Where can I find documentation for ADI?
ADI documentation is available from the following sources: 

■ Online help (Click Help from anywhere within ADI) 

■ Oracle ADI Tutorial and Oracle Applications Desktop Integrator User Guide. These 
documents can be downloaded from http://docs.oracle.com. They may also be 
ordered through Oracle Documentation Sales.

■ Oracle Applications Desktop Integrator Installation Guide explains how to install 
ADI. This document can be downloaded from http://docs.oracle.com.

Question: What Releases of Microsoft Excel does ADI support?
■ Support for Microsoft Excel 97 (Office 97) became available with ADI Release 

2.1.

■ Support for Microsoft Excel 2000 became available with ADI Release 6.0.

■ Support for Microsoft Excel XP became available with ADI Release 7.1.

■ Support for Microsoft Excel 2003 became available with ADI Release 7.1.

Question: How does ADI relate to Oracle Financial Analyzer? 
The ADI Budget Wizard provides a spreadsheet-based budget entry screen that 
facilitates simple data entry and modeling in a disconnected environment. Oracle 
Financial Analyzer provides complex budget modeling in a distributed 
environment. 

The ADI Report Wizard provides a spreadsheet-based reporting tool for quickly 
creating and running financial reports. Oracle Financial Analyzer provides online 
analytical processing (OLAP) and reporting with balance drill down, as well as 
report pivoting, within a distributed environment. 

Question: Can ADI be used with Lotus 1-2-3?
No, there are no current plans to provide Lotus support. ADI runs in Microsoft 
Excel only. 

http://docs.oracle.com
http://docs.oracle.com


Functional Issues

Oracle ADI Frequently Asked Questions A-9

Question: What languages are available for ADI?
For details about languages supported by ADI, see Section C.5, "Specifying 
Language Options".

Question: What security is available for ADI? 
ADI enforces the same username, password, and responsibility security as Oracle 
Applications. Also, you may choose to use function security or profile options, both 
defined in Oracle Applications. 

See the Oracle Applications Desktop Integrator Installation Guide for specific security 
information.

Question: How can I change the budget name, organization, currency, or 
period range of an existing budget worksheet?
From the ADI toolbar, choose Ledger > Budget Wizard > Edit Budget Criteria. 

Question: How can I use a single ADI worksheet with several 
databases?
You can create a worksheet for each database in a single workbook, and then copy 
and paste or create cell references from one worksheet to the other.

Question: Are there plans to support table-validated value sets within 
ADI?
This feature became available with ADI Release 2.0.

Question: What does it mean when I receive the messages: This action 
cannot be completed because the Microsoft Excel - Sheet1 application 
[EXCEL] is busy. Microsoft Excel is not running, or is unavailable.
This message appears if you are in cell ’EDIT’ mode when you try to perform 
another action. If you exit edit mode by leaving the active cell, you will not get this 
message.

Note: Segment value security became available with ADI Release 
2.0.
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Question: How can a character-mode GL customer obtain and use ADI?
Order the ADI software, which is free for supported customers. Character-mode 
users can then communicate with their database using ADI, which interacts with 
GL's open interfaces Applications_INTERFACE (using Journal Import) and 
Applications_BUDGET_INTERFACE (using Budget Upload).

Question: Can I download actuals and use them as a basis for a budget?
Yes. The Budget Wizard allows you to download budgets and actuals into separate 
worksheets in the same workbook. You can then copy and paste your actual 
amounts into your budget worksheet or create cell references from your actuals 
worksheet to your budget worksheet. You can also create a budget model that 
references your actual amounts.

Question: Now that I can use Reports to get my FSG output into 
Microsoft Excel, what happens if my report exceeds the Microsoft Excel 
16,000 line limitation?
Report output is not bound by the Microsoft Excel line limitation. The Request 
Center automatically splits report output into 16,000 line blocks for Microsoft Excel 
7, and 65,000 line blocks for Microsoft Excel 97, and it places them separate 
worksheets within the workbook. If you fill a workbook, the Request Center 
automatically opens another workbook and continues adding worksheets.

Question: Does ADI support cross-validation rules?
ADI enforces cross-validation rules if you set the GL profile option, Flexfields: 
Validate on Server, to Yes. This feature became available with ADI Release 2.0.

Question: What does it mean when I try to view an FSG report and I get a 
Reports window to format my report? 
In Production 15, we modified the FSG engine to add a method for the Request 
Center to determine how to segment the output since the different output regions 
(Report Heading, Column Headings, Line Items, and Amounts) can have different 
formats.

When running against Production 14, this feature is not available. Therefore, before 
the output is automatically loaded into Microsoft Excel, a Request Center window 
pops-up with a sample of the actual output and prompts you to position a few 
pointers to mark the region boundaries. This window is similar to Microsoft Excel's 
Text Import feature, but easier to use (with drag and drop). Also, the Request 
Center uses default positioning that will work with most reports. 
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Question: Can I use ADI if I require Budget Journals?
Yes. You can use the Journal Wizard, which performs uploads through the journal 
API and creates journals. You cannot use the Budget Wizard since it uploads using 
the budget API, which does not create journals. Therefore, create budgets in a 
standard budget worksheet, and then cut and paste the amounts into a journal 
worksheet for uploading.

Question: Can I insert rows with new code combinations for upload after 
downloading a budget?
Yes. ADI includes the Budget Wizard, which you can use to insert new budget 
accounts. From the ADI toolbar, choose Ledger > Insert Budget Account. Note that 
the added accounts must fall into the budget organization that was originally 
downloaded.

Question: Can I create and upload a new budget worksheet without first 
doing a budget download?
No. You must create the budget worksheet in Microsoft Excel first, even if you have 
to download a single account. If you want to upload data from another source, 
create the budget worksheet, then use Microsoft Excel's cell referencing or cut and 
paste functions to transfer amounts into the worksheet.

Question: Is it possible to permit users to download without giving them 
upload privileges (without defining a password for the budget 
organization)?
Yes. The ADI security profile options, available in GL, provide this level of control. 
For details about enabling security within ADI, see Oracle Applications Desktop 
Integrator Installation Guide.

Question: Why do my period names appear as numbers after retrieving 
report output into Microsoft Excel using Reports?
Microsoft Excel converts any value that looks like a date into its numeric equivalent. 
To ensure that Microsoft Excel treats your period names as labels, put at least one 
space before the &POI token in the report definition column headings.

Question: Are Standard (Variable Format) reports available for all Oracle 
Applications?
Release 11i supports Standard (Variable Format) reports for GL, Oracle Assets and 
Oracle Accounts Receivable.



Functional Issues

A-12 Oracle Applications Desktop Integrator User Guide

Question: Can I submit report sets through the Request Center?
Report set submission is not yet supported, but you can publish report sets through 
the Request Center.

Question: Can I perform cell level formatting with report themes?
Yes. You can format financial reports at the cell level using report themes. For more 
information, see Section 9.9, "Applying Cell Level Formatting" in Chapter 9, "Using 
the Request Center".

Question: Is ADI a web-enabled product?
No. ADI is a client/server application. However, ADI can be implemented in a 
three tier architecture using environments such as CitrixWinFrame and Windows 
Terminal Server.

If you are using only Journal Wizard in ADI, then you may use Oracle Web ADI, 
which is a web-enabled product that has implemented Journal Wizard functionality 
using the Internet Computing Architecture. Physical Inventory, Create Assets, and 
Budget Wizard functionality will soon be available in Web ADI.

Question: Can I run a financial statement between different sets of 
books?
Yes. If the set of books contain the same chart of accounts and if the set of books for 
the report is determined based on the user's responsibility. If the set of books for the 
report is defined within the report itself, you must first make a copy of the report 
using Report Wizard, and then change the set of books in the definition of the 
report copy.

Question: Can I drill down on a financial report amount generated by a 
row or column calculation using the Analysis Wizard?
No. You can drill down only on financial report amounts associated with account 
segments.

Question: Why aren't custom filters working on account segment values 
in budget worksheets?
You may notice unpredictable results when you apply a custom filter to an account 
segment value column of your budget worksheet. This is because Microsoft Excel 
treats the values in these columns as text, rather than numeric. We recommend that 
you check your results carefully. Also, you may find that you need to precede your 
specified filter value with a single or double quote character. For example, >= "3750. 
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Question: Why do I receive the message "Select an amount on a 
Financial Report worksheet..." when I attempt to use the Analysis 
Wizard?
If multiple copies of Microsoft Excel are running on your PC, ADI is unable to 
correctly determine which copy to use with the Analysis Wizard. You can resolve 
this one of two ways:

■ Close all copies of Microsoft Excel except the one from which you want to drill 
down.

■ Enable the environment option. Double-click Drill Enabled on the Default Drill 
Options window in the Analysis Wizard, and then select the amount on which 
you want to drill down by double-clicking on the amount.

Question: Why does the Analysis Wizard display an amount that is 
different from the original financial report amount I drilled down upon?
There are several reasons why the drill down results of the Analysis Wizard can 
differ from the amount on the financial report. This may occur when:

■ Your report format is different from the original entry. For example, your report 
format may be set to 000,000 compared to your original entry which contained 
two decimal places 000,000.00.

■ You change the drill down period or amount type in the Analysis Wizard 
context window.

■ The amount in the financial report is an expanded row of a line item. In this 
case, the drill down will show the total of all expanded rows for the current line 
item.

■ If a column from the original column set fails to be included, then drill down 
may incorrectly calculate the period for the drill. Change the period using the 
context window.

■ Flexfield segment security rules may prevent a user with a particular 
responsibility from using the drill down feature to view original journal entries 
created under a different responsibility.

■ Journals may have been posted after the report was run.
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Question: When I upload my asset worksheet, I receive an error 
message stating that certain fields in my worksheet must have a value. 
When I check the worksheet, the fields do contain values. Why do I 
receive this error message?
Table A–2 describes the dependent fields in the Asset worksheet. Dependent fields 
depend on other fields for complete validation.

ADI cannot validate Oracle Assets business rules if the dependent field is placed in 
the Header Region of the asset worksheet and the independent field is placed in the 
Lines Region of the worksheet. 

For example, if the field, YTD Depreciation (dependent field), is placed in the 
Header Region and the field, Cost (independent field), is placed in the Lines Region, 
the following error is displayed in the worksheet Message column upon upload: 
"YTD Depreciation must have a value."

To correct or avoid this error, you can:

■ Place both dependent and independent fields in the Header Region.

■ Place both dependent and independent fields in the Lines Region.

■ Place the independent field in the Header Region and the dependent field in the 
Lines Region.

Question: Can I access GL Account Hierarchy Editor through ADI?
The GL Account Hierarchy Editor is available through ADI 3.2 and higher. It 
supports the following releases:

■ Character Mode: 10.6, 10.7

■ Smart Client: 10.6 Prod 15, 10.7 Prod 16

Table A–2 Dependent Fields in the Asset Worksheet

This field is dependent on... This independent field

YTD Depreciation Cost

Salvage Value Cost

Depreciation Reserve Cost

Date Placed in Service Category

Original Depr Start Date Conversion Date
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■ NCA: 10.7, 11.0.0+

■ Applications: 11i

The Account Hierarchy Editor is available in English language only.

Question: Why can't I access the Switch Themes feature from the 
Request Center?
The Switch Themes feature is available for use only with spreadsheet output with 
ADI Releases 3.2 and earlier. You cannot use this feature to switch themes for web 
or text output. Also, you cannot apply cell level formatting with Switch Themes.

For ADI releases 4.0 and higher, you can republish your worksheet using a different 
theme. Republishing allows you to apply themes for any output type: spreadsheet, 
web, or text. Also, ADI releases 4.0 and higher support cell level formatting.

Question: When I specify a BMP file as the company logo in my Theme, 
why does the resulting spreadsheet output display an icon with a GIF 
filename?
To insert bitmap image files into Themes, choose Insert > Picture from the Microsoft 
Excel toolbar. Do not insert your images by choosing Insert > Object from the 
Microsoft Excel toolbar. 

Question: How can I enter both numbers and letters into an accounting 
flexfield without having it converted into an exponential number during 
upload?
From the ADI toolbar, choose Options > General Options > Settings (tab). Deselect 
the Zero Pad Account Values check box.

Question: Are there naming conventions to use with my ADI 
worksheets?
You can use any name you like. Be sure to eliminate any spaces in your worksheet 
name. Microsoft Excel macros do not function correctly if there are spaces in the 
worksheet name. See the following examples:

■ Test1.xls - correct

■ Test 1.xls - incorrect
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Question: What do I do when the data columns in my standard report 
are not split in the right places?
You can create a theme or modify an existing theme to match the widths of the 
columns in your theme with those in the report output. You can use the Import 
Wizard to easily match theme columns with report output columns. To align 
columns:

1. Publish your report to text format using the Request Center.

2. Open the text file in Microsoft Excel using the Import Wizard.

3. Set the boundaries for each column within the Import Wizard in Microsoft 
Excel.

4. Use these column widths in your theme.

5. Save your theme and use it to publish the report.

Question: Does ADI provide descriptive flexfield validation?
No. ADI does not provide descriptive flexfield validation.

Question: Does Analysis Wizard support Consolidated Balance 
Inquiries?
No. You may drill down to the journal details of a consolidated parent Set of Books, 
but you cannot drill into the subsidiary balance that was consolidated to the parent.
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B
Importing Text Files

This appendix contains an overview of the Import Text File feature and it discusses 
how to use it to import data into a worksheet and create mapping templates for 
future conversions. Sections in this chapter include:

■ Section B.1, "Overview of Importing Text Files"

■ Section B.2, "Importing Data into a Worksheet"

■ Section B.3, "Creating Mapping Templates"



Overview of Importing Text Files

B-2 Oracle Applications Desktop Integrator User Guide

B.1 Overview of Importing Text Files
The Import Text File feature allows you to import data from legacy systems, third 
party payables applications, barcode scanners, or any other flat data file sources to 
asset or inventory worksheets. While importing data, you can create mapping 
templates to map fields in your source file to fields in your asset or inventory 
worksheets. After creating the mapping template, you can save it and apply it for 
future conversions.

B.2 Importing Data into a Worksheet
To import data into your worksheet:

1. Open an asset or physical inventory worksheet.

2. From the ADI toolbar, choose Assets > Import Text File.

The Import Text File window opens.

3. Click Find beside the Choose Source File field to locate the source file you want 
to import, and then select it.

4. Select the First Row Contains Field Names check box to include the first row of 
your data file that contains header information.

5. In the Delimiter region, select the appropriate delimiter. Options are: Tab, 
Comma, Semicolon, or Other. 

If you choose Other, enter the delimiter used in your data file in the field beside 
the Other option.

6. From the Choose Mapping menu, select the appropriate mapping template. If 
you do not select a mapping template, ADI applies the default template. For 
details, see Section B.3, "Creating Mapping Templates".

7. Click OK to import data.

B.3 Creating Mapping Templates
Mapping templates allow you to map data in a data file to the fields on your asset 
or inventory worksheets. After creating a mapping template, you can save it and 
apply it for future conversions.

The Mapping window allows you to create, edit, view, copy, rename or delete a 
mapping template. Also, mapping templates can be made available to other users 
by making them public.
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B.3.1 Creating Mapping Templates
To create a mapping template:

1. Open an asset or physical inventory worksheet.

2. From the ADI toolbar, choose Assets > Import Text File.

The Import Text File window opens.

3. Click Find beside the Choose Source File field to locate the source file you want 
to import, and select it.

4. Click Actions beside the Choose Mapping menu.

5. Click New, and then enter a name for the mapping template.

The Mapping window opens. This window comprises two panes: Import File 
Fields and Excel Spreadsheet Fields.

6. Select the Public check box to make this mapping template available to other 
users.

7. Drag and drop the required fields from your source file and use the directional 
buttons to arrange the fields in the mapping template.

8. Click OK to create the mapping template.

9. Optionally choose Actions > View/Edit to view or edit an existing template.

10. Optionally choose Actions > Copy, Rename or Delete to copy, rename or delete 
an existing template.
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C
Toolbar and Other Options

This appendix discusses how to specify toolbar options, general options, ledger 
options, request center options and language options. Sections in this chapter 
include:

■ Section C.1, "Specifying Toolbar Options"

■ Section C.2, "Specifying General Options"

■ Section C.3, "Specifying Ledger Options"

■ Section C.4, "Specifying Request Center Options"

■ Section C.5, "Specifying Language Options"
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C.1 Specifying Toolbar Options
To change toolbar options:

1. From the ADI toolbar, choose > Options > Toolbar > Toolbar Options.

The Toolbar Options window opens. This window comprises two pages: Move 
Icons and Add Icons.

2. Optionally, in the Move Icons page, you can add icons from the Available Icons 
list pane to the Toolbar Icons pane to add the icons to your ADI toolbar.

3. Optionally, in the Add Icons page, add icons. For example, you can add 
ADIQCSTD.EXE, from the BIN directory where you have installed ADI, to add 
the Request Center Options button to the Available Icons pane. Move this icon 
to the Toolbar Icons page to add this icon to your ADI toolbar.

4. Optionally, to remove icons from the Toolbar Icons pane, select the icon, and 
then click Delete.

5. Optionally, choose > Options > Toolbar > Switch Orientation to change the 
toolbar from the vertical position to a horizontal position or vice versa.

6. Optionally, choose > Options > Toolbar > Reset Icons to reset icons on the 
toolbar.

C.2 Specifying General Options
To specify general options:

1. From the ADI toolbar, choose > Options > General Options.

The General Options window opens. It comprises four pages: Worksheet 
Colors, Theme Defaults, Settings and Installation.

2. Optionally, in the Worksheet Colors page, select default color settings for 
journal, budget, report, and asset worksheets.

3. Optionally, in the Theme Defaults page, select defaults for new report themes.

Report theme defaults are also used when the theme you specify for publishing 
a report does not exist or is damaged.

4. Optionally, in the Settings page, change options as required. Table C–1 
describes the options available in the Settings page.
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5. Optionally, in the Installation page, change options as required. Table C–2 
describes the options available in the Installation page.

Table C–1 Settings Page in the General Options window

Option Description

Start ADI when Opening 
Workbook

Select this option if you want ADI to start automatically (if it is 
not already running) whenever you open a budget, journal, or 
report worksheet in Excel. 

Start Request Center at 
Signon

Select this option if you want the Request Center to start 
automatically when you start ADI.

Show Upload Success 
Indicator

Select this option if you want ADI to display upload success 
indicators on your budget, journal, and asset worksheets. The 
indicators tell you whether related budget, journal, or asset 
lines were uploaded successfully.

Zero Pad Account Values Select this option if you want account segment values to be 
zero padded. For example, an account number of 50, where 
the segment is four characters in length, will display as 0050.

Enable Hot keys Select this option to enable the special hot keys that are 
mapped from your keyboard to ADI’s functions. This is an 
alternative to using a mouse.

Always on Top Select this option to force Windows to always display the 
toolbar on top of all other open windows.

Tip Wizard Select this option if you want to use the Microsoft Agent. In 
the Character File window, enter the path name for the 
character you wish to use. Click Show Characters to test and 
display the Agent.

Table C–2 Installation Page in the General Options window

Option Description

Run Custom Macros Functionality reserved for a future version.

In a future version of ADI, you will be able to run custom 
macros before and after certain ADI processes.

Perform Self-Check at 
Startup

Select this option if you want ADI to perform a self-check 
when you start the system.

Play Sounds for Events Select this option if you want ADI to play sounds for events 
such as error messages.

Write Statistics Files for 
Support

Select this option if you want ADI to gather statistics when 
you run performance testing scenarios. 
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C.3 Specifying Ledger Options
To specify ledger options:

1. From the ADI toolbar, choose > Options > Ledger Options.

The Ledger Options window opens. This window comprises four pages: 
Budget, Journal, Report Definition, and Report Analysis.

2. In the Budget page, select the required options. Table C–3 describes the options 
available in the Budget page of the Ledger Options window.

3. In the Journal page, select the required options.

Accessibility Mode Select this option when using a screen reader. 

Directory and Files region Used to specify the Integrator Directory, User Settings 
Directory, Integrator Program Filename, and Applications 
Program Filename. Do not modify these directories and files 
region without verifying with your system administrator.

Table C–3 Budget Page of the Ledger Options window

Option Description

Decimal Places The number of decimal places (up to five) ADI displays for all 
values in your worksheet. The default is Database, which 
draws the decimal places option from your GL database.

Minimum Width of Value 
Columns

The Microsoft Excel column width to use as the minimum 
width for each of your budget worksheet value columns.

Update Budget Status Select this option if you want ADI to automatically update the 
budget status information on the Create Budget Worksheet 
window anytime you make changes to your budget worksheet 
parameters.

Generate Axes Select this option to include these values as labels on the axes 
of your graphs.

Include Budgets and 
Actuals

Select this option if you want ADI to create graphs for both 
your budget and actual values in the Microsoft Excel 
workbooks where you have elected to include both budget 
and actual amounts.

Table C–2 Installation Page in the General Options window

Option Description
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The Journal page allows you to change the appearance of fields and hints in 
your journal worksheet. While fields appear as row and column headings in 
your template, hints appear as the detail information below or to the right of the 
headings. Table C–4 describes the options in the Journal page of the Ledger 
Options window.

4. In the Report Definition page, select the required options. Table C–5 describes 
the options in the Report Definition page of the Ledger Options Window.

Table C–4 Journal Page of the Ledger Options window

Option Description

Default Number of Rows Select or enter a value from 1 to 65,500 for the number of 
journal lines you want to display in your journal worksheet.

Minimum Width of Value 
Columns

Select or enter a value from 1 to 20 for the minimum width to 
use while displaying amount fields.

Header region (Field 
Name, Context, and Field 
Value)

Used to set the display widths for Field Name, Context, and 
Field Value in a journal worksheet header. Width is expressed 
as the number of Microsoft Excel worksheet columns used to 
display the item. The range of values is 1 to 10 columns. Select 
or enter a valid value for each item in the template header.

Table C–5 Report Definition page of the Ledger Options Window

Option Description

Rows Number of rows to use for the new report worksheets.

Columns Number of columns to use for the new report worksheets.

Column Width Width to use for each column definition.

Line Item Width Width of the report area where the row labels appear.

Format Format mask to use for amounts in the report.

Factor The factor (billions, millions, thousands, units, or percentiles) 
to use for displaying numeric values.

Indicator The colors to use to display the account assignments, 
calculations, and exceptions report indicators on your report 
worksheet. Report indicators are small symbols that appear to 
the left of your row definitions or above your column 
definitions. They indicate the number of account ranges 
assigned to a row or column, and whether there are 
calculations defined or column exceptions applied. 
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5. In the Report Analysis page, select the required options. Table C–6 describes the 
options available in the Report Analysis Page of the Ledger Options window.

Copy Options When you use the Report Wizard, the following options 
determine whether the copy check boxes are selected or 
deselected in the wizard windows. You can set the following 
defaults:

■ Make Copy Default — If you select Yes, the copy check 
boxes are selected whenever you create new report objects 
or define a new report as you are guided through the 
wizard windows. 

■ Enforcement Level — These settings determine which 
ADI prompts to display as you move through the wizard 
windows.

■ Prompt — ADI prompts you to make a copy, or use the 
original report or report object as your are guided 
through the report wizard.

■ Do Not Prompt — ADI does not display a prompt.

■ Enforce Default — ADI enforces the setting you select in 
the Make Copy Default field. If set to Yes, you cannot 
change the check box settings as you are guided through 
the report wizard.

Note: These options are overridden if the ADI 
security-related profile options are defined in GL.

Table C–6 Report Analysis Page of the Ledger Options Window

Option Description

Grouped Select this option to display account segments together as one 
value.

Individually Select this option to display account segments separately.

Note: You must select this option if you want to perform 
multidimensional analysis of your drill down data.

Balancing Segment/Cost 
Center Segment/Account 
Segment

Select this option to include descriptions for various segments.

Including descriptions affect the performance of drill downs. 
Oracle suggests that you include descriptions only for critical 
account segments.

Table C–5 Report Definition page of the Ledger Options Window

Option Description
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C.4 Specifying Request Center Options
To specify request center options:

1. From the ADI toolbar, choose > Options > Request Center Options.

The Options window opens.

2. Select or enter the required options. Table 9–8 describes the options available in 
the Request Center Options window.

Account Type Automatically shows the account type when you drill down to 
detail accounts.

Zero Balances Select this option if you do not want zero balance amounts to 
be displayed in drill windows.

Outline Indicators Select this option to display expand/collapse indicators in 
drill windows. This option is useful when you are performing 
multidimensional analysis.

Show Totals Select this option to automatically include totals for the rows 
and columns in drill windows.

Minimum Amount Width Select this option to enter the minimum column width to use 
for the amount columns in drill windows.

Double Click Drill 
Enabled

Select this option to enable the ability to drill down by 
choosing an amount from one of the displayed drill windows. 
You can also use this feature to drill down on amounts from 
your spreadsheet-published report output, that is, you do not 
have to choose the Analysis Wizard from the ADI toolbar.

Hide Windows When 
Navigating

Select this option to close the active drill window when you 
drill up to the previous or down to the next drill window. 
Only one drill window will be open at any time.

Maximum Active Drills Enter a number for the maximum number of drill context 
windows you want to activate at one time.

Note: If you have too many drill windows open at the 
same time, it can affect system performance.

Table C–6 Report Analysis Page of the Ledger Options Window

Option Description
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3. Click OK after changing the options.

C.5 Specifying Language Options
Languages supported by ADI include:

Arabic, Brazilian, Portuguese, Canadian French, Czech, Danish, Dutch, English, 
Finnish, French, German, Greek, Hebrew, Hungarian, Italian, Japanese, Korean, 
Latin American, Spanish, Norwegian, Polish, Portuguese, Romanian, Russian, 
Simplified Chinese, Slovak, Spanish, Swedish, Thai, Traditional Chinese, and 
Turkish.

Table 9–8 Request Center Options

Option Description

Update Every Select this option to specify the time interval for ADI to 
monitor requests. For example, if you set the interval to 60, the 
system checks every 60 seconds to see if your request has 
completed processing.

Query Last Select this option to specify the number of requests to be 
retrieved in the Select Request to Monitor window when you 
query reports.

Flash Notification Select this option to specify the number of times the Request 
Center title bar should flash when a request is completes.

Display Select this option to limit the number of Oracle application 
requests monitored by the Request Center. If you select the All 
option, you can monitor requests from all installed Oracle 
Applications.

Output Viewer Select this option to choose the program you want to use to 
view the report output or request logs whenever you click the 
View Output/Log icon on the Request Center toolbar. You can 
enter the path and program name directly, or click Find to 
search your computer for the program you want.

Printer Settings Select this option to specify a default font to use when printing 
reports to a local printer.

Language Options Select this option to change the language that the Request 
Center uses in windows, menus, and tool tips.
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To change language options:

1. From the ADI toolbar, choose > Options > Language Options.

The Language Options window opens.

2. In the Language region, select Use default to use U.S. English. 

3. To use any other language, select Specific, and then select the language from the 
list.

4. Click OK to apply your language selections.
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D
Command Line Submission and Publishing

Options for FSG Reports

This appendix discusses the command line submission and publishing options for 
financial statement (FSG) reports. Sections in this chapter include:

■ Section D.1, "Overview of Submission and Publishing Options"

■ Section D.2, "Prerequisites"

■ Section D.3, "Input Parameters"
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D.1 Overview of Submission and Publishing Options
You can submit and publish FSG reports by specifying the required parameters to a 
command line utility, ADIQCCOM.EXE, allowing for the process to be integrated 
with a third-party scheduler.

D.1.1 Specifying Default Values
Where a value contains a comma, you must use a second comma to indicate that the 
comma is part of the string and not the delimiter. For example, “General Ledger,, 
Vision Operations (USA)”. When you have to use the default value, ensure that you 
leave a space between the commas, that is, “, ,”.

Any value that is not indicated as required (for details, see Table D–1, "Input 
Parameters for FSG Reports"), may be left out, and will have a default value 
included during submission or publishing. 

D.2 Prerequisites
Prerequisites are as follows:

■ Only FSG reports can be submitted and published using ADIQCCOM.EXE.

■ Only the Local - Web Page output option is available.

■ If the Request Center is already connected, the publishing utility uses the same 
username and responsibility. The utility does not recheck the 
username/password/responsibility. It assumes that the security details have 
not changed since the first time the user signed on to a database using the 
Request Center, and that the PC on which the executable is running is secure.

■ The utility accepts only single requests. Any concurrent requests, while 
processing an existing request, will be rejected.

Note: For better performance, Oracle recommends that you 
should specify values for the parameters, period, date, rounding 
option, and currency, rather than using default values.
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D.3 Input Parameters
Table D–1 describes the input parameters for publishing and submitting FSG 
reports from the command line.

Table D–1 Input Parameters for FSG Reports

Name Required Type Description Values Default

Username Yes Security Oracle Applications Username. -- --

Password Yes Security Password for Oracle Applications 
Username.

-- --

Instance Yes Security Database name as defined in the ADI 
Sign On window.

-- --

Responsibility Yes Security Responsibility you want to use. It is 
case sensitive.

-- --

Report Type -- Submission The utility supports only financial 
statement (FSG) reports.

F F

Report Name Yes Submission Report name you want to generate. It 
is case sensitive.

-- --

Period Yes Submission – 
Financial Statement

FSG parameter. Allows you to specify 
a period for the report. When you do 
not specify the period, it uses the latest 
used period. Period is case sensitive.

-- --

Date Yes Submission – 
Financial Statement

Allows you to specify dates for the 
period. By default, it selects the closest 
valid date for the supplied period to 
today’s date. Format: YYYY/MM/DD.

-- --

Content Set -- Submission – 
Financial Statement

Allows you to override the content set 
in the Report Definition.

-- --

Segment 
Override

-- Submission – 
Financial Statement

Allows you to specify segment 
override values for the account 
segments you want to override.

-- --

Rounding 
Option

Yes Submission – 
Financial Statement

Allows you to use rounding option for 
calculations. You can use either 
Calculate then Round (C) or Round 
then Calculate (R). 

It checks for the rounding option 
defined in the Report Definition. If it is 
not defined in the Report Definition, it 
defaults to Calculate then Round.

C, R C
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Currency Yes Submission – 
Financial Statement

Allows you to specify the currency for 
the report. By default, it selects the 
currency from the Report Definition. If 
no currency is defined for the Report 
Definition, it uses the currency of the 
set of books.

-- --

Exceptions 
Only

-- Submission – 
Financial Statement

Exceptions only flag. Y, N N

Output Type -- Publish Only Local - Web Page is supported. L L

Publish -- Publish Publishes the report automatically 
after it finishes running.

Y, N Y

Prompt -- Publish If you specify Y, prompts the user 
before publishing the report.

Y, N N

Theme Yes Publish Publishing parameter. Allows you to 
specify the path to the theme you want 
to use in publishing the report.

-- --

Publish To -- Publish – Local Allows you to specify the path and 
filename for the report. By default, it 
publishes the report to the Temp 
directory and the filename will be 
“name_of_the_report.htm”.

-- --

Launch 
Browser

-- Publish – Web Page If you specify Y, it displays the 
completed report in a browser when it 
finishes publishing.

Y, N N

Include 
Spreadsheet

-- Publish –Financial 
Statement - Web 
Page

If you specify Y, it publishes a 
spreadsheet version of the report, and 
includes a link in the web page to 
retrieve this spreadsheet.

Y, N Y

Link Reports -- Publish If you specify Y, it provides an option 
to link separate reports that are 
generated when an FSG report is run 
with a content set.

Y, N Y

Separate 
Directories

-- Publish If you specify Y, it provides an option 
to create separate directories for each 
report generated when an FSG report 
is run with a content set.

Y, N Y

Table D–1 Input Parameters for FSG Reports

Name Required Type Description Values Default
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The publishing utility updates a log file, ADIQCCOM.LOG, and this log file is 
available from the same directory where ADIQCCOM.EXE is being executed. For 
every submission, it provides information, such as timestamp, time taken to process 
the submission, whether it was successful or not, and the parameters. 

D.3.1 Usage Examples
To specify input parameters:

1. Go the command prompt of the drive where you have installed ADI.

2. Specify the following parameters. This is an example of calling the executable 
with all parameters.

ADIQCCOM OPERATIONS, WELCOME, VISION, General Ledger,, Vision 
Operations (USA), F, Company Balance Sheet, Feb-02, 2002/02/28, , , C, USD, 
N, L, Y, N, C:\orant\GLDI90\THEMES\VISION11\CompBalSheet_Print.xls, 
C:\Documents\Company_Balance_Sheet.HTM, N, Y, Y, Y

3. Specify the following parameters. This is an example of calling the executable 
with less parameters by utilizing the defaults.

ADIQCCOM OPERATIONS, WELCOME, VISION, General Ledger,, Vision 
Operations (USA), , Company Balance Sheet, , , , , , , , , , , 
C:\orant\GLDI90\THEMES\VISION11\CompBalSheet_Print.xls, 
C:\Documents\Company_Balance_Sheet.HTM, , , , 

4. Optionally, open the ADIQCCOM.LOG to check your submission status.
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E
ADI Toolbar and Request Center Shortcut

Keys

This appendix provides ADI toolbar and Request Center shortcut keys. Sections in 
this chapter include:

■ Section E.1, "ADI Toolbar Shortcut Keys"

■ Section E.2, "Request Center Shortcut Keys"
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E.1 ADI Toolbar Shortcut Keys
Table E–1 describes the ADI toolbar shortcut keys.

Table E–1 ADI Toolbar Shortcuts

Function Shortcut

About ADI Ctrl + Shift + Alt + Y

Analyze Report Ctrl + Shift + Alt + Z

Apply Budget Note Ctrl + Shift + N

Apply Budget Rule Ctrl + Shift + Z

Change Responsibility Ctrl + Shift + R

Create Assets

Trace

Ctrl + Shift + Alt + S

Ctrl + Shift + Alt + T

Create Graph Ctrl + Shift + G

Define Report Ctrl + Shift + D

Enter Budgets Ctrl + Shift + B

Enter Journals Ctrl + Shift + T

Exit ADI Ctrl + Shift + X

General Ledger Options

Show Header

Ctrl + Shift + Alt + G

Ctrl + Shift + Alt + H

General Options

Reset Filter

Ctrl + Shift + Alt + Q

Ctrl + Shift + Alt + R

Help ■ Ctrl + Shift + H

■ Ctrl + Shift + I

■ Ctrl + Shift + J

■ Ctrl + Shift + K

Import Text File

Show Trim

Ctrl + Shift + Alt + L

Ctrl + Shift + Alt + M

Information Ctrl + Shift + Y

Insert Budget Account Ctrl + Shift + Alt + I

Language Options Ctrl + Shift + C
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List of Values Ctrl + Shift + L

Minimize Ctrl + Shift + M

Options Menu Ctrl + Shift + O

Oracle Applications Ctrl + Shift + A

Record Physical Inventory Ctrl + Shift + Alt + V

Request Center Ctrl + Shift + W

Request Center Options

Enable ADI Toolbar

Ctrl + Shift + Alt + W

Ctrl + Shift + Alt + X

Sign on Ctrl + Shift + S

Start Excel ■ Ctrl + Shift + E

■ Ctrl + Shift + F

Submit Ctrl + Shift + Q

Submit Asset Ctrl + Shift + Alt + A

Submit Budget

Clear Trace

Debug

Ctrl + Shift + Alt + B

Ctrl + Shift + Alt + C

Ctrl + Shift + Alt + D

Submit Journal Ctrl + Shift + Alt + J

Submit Physical Inventory Ctrl + Shift + Alt + P

Submit Report Ctrl + Shift + V

Tip Wizard Enable/Disable Ctrl + Shift + Alt + U

Tip Wizard Options Ctrl + Shift + Alt + K

Toolbar Options

Show Content

Ctrl + Shift + Alt + N

Ctrl + Shift + Alt + O

Upload to Interface Ctrl + Shift + U

View Account Hierarchy Editor

Show Filter

Ctrl + Shift + Alt + E

Ctrl + Shift + Alt + F

Wizard Options Ctrl + Shift + P

Table E–1 ADI Toolbar Shortcuts

Function Shortcut
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E.2 Request Center Shortcut Keys
Table E–2 describes the Request Center shortcut keys.

Table E–2 Request Center Shortcuts

Function Shortcut

Add Request to Hotlist Ctrl+Alt+Q

Applications Desktop Integrator Ctrl+Alt+A

Cancel Request Ctrl+Alt+C

Change Responsibility Ctrl+Alt+G

Disconnect Ctrl+Alt+I

Exit Ctrl+Alt+X

Format Report Output Ctrl+Alt+F

Help Ctrl+Alt+H

Minimize Ctrl+Alt+N

Monitor Request Ctrl+Alt+M

Options Ctrl+Alt+O

Oracle Applications Ctrl+Alt+L

Print output/Log Ctrl+Alt+T

Publish Output Ctrl+Alt+P

Publish Report and Request Sets Ctrl+Alt+U

Report Manager Tools Ctrl+Alt+E

Show Request Details Ctrl+Alt+D

Signon Ctrl+Alt+S

Stop Monitoring All Requests Ctrl+Alt+J

Stop Monitoring Selected Requests Ctrl+Alt+K

Submit Report Ctrl+Alt+R

View Output/Log Ctrl+Alt+V
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A
account assignments

adding to row or columns, 4-9
account hierarchies

viewing in Account Hierarchy Editor, 6-8
Account Hierarchy Editor

add hierarchies, 6-8
add new child values, 6-4
add new parent values, 6-3
adding parent/child ranges, 6-5
creating rollup groups, 6-12
duplicate parent hierarchies, 6-9
find segment values, 6-11
merging child ranges, 6-6
modify segment value description, 6-7
opening, 6-3
overview, 6-2
prerequisites, 6-2
using, 6-2
viewing account hierarchies, 6-8

account segments
change display characteristics, 2-7

ad hoc reports
specifying report objects, 9-15
submit using Request Center, 9-5

ADI
features, 1-3
language options, C-8
logging in, 1-4
new features, 1-3
overview, 1-2
signing on, 1-4
toolbar (using), 1-5

ADIQCCOM
input parameters, D-3
overview, D-2
prerequisites, D-2
specifying default values, D-2
usage examples, D-5

Analysis Wizard
creating pivot information, 5-6
filter information in drill down windows, 5-6
overview, 5-2
prerequisites, 5-2
selecting account range, 5-5
starting, 5-4
viewing detail accounts, 5-6
viewing subledger details, 5-7
viewing summary accounts, 5-5

applications database
using, 1-6

applying attributes
using Request Center, 9-13

asset data
post from interface table to Oracle Assets, 7-7
upload to Oracle Assets, 7-5

Asset Wizard
create layout templates, 7-4
creating asset worksheets, 7-2
overview, 7-2
post assets, 7-7
upload asset data (overview), 7-5
upload asset data to interface table, 7-6

asset worksheets
creating, 7-2

attributes
applying using Request Center, 9-13
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AutoReduction, 1-9
AutoSelection, 1-8

B
blank report

creating, 4-5
budget

adding budget notes, 2-4
creating journal entries, 3-8
graphically viewing budgets, 2-15
import balance from Interface Table to GL, 2-14
specifying criteria, 2-6
update balances from ADI, 2-10
upload from ADI to GL, 2-12
upload worksheet to Interface Table, 2-12

budget account
inserting new, 2-3

budget balances
import from Interface Table to GL, 2-14
update manually, 2-10
update using budget rules, 2-10
updating, 2-10

budget notes
using, 2-4

budget parameters
changing, 2-6

budget values
creating graph, 2-15

Budget Wizard
adding budget notes, 2-4
change account segment display 

characteristics, 2-7
changing budget parameters, 2-6
graphically viewing budgets, 2-15
import budget balances, 2-14
inserting budget account, 2-3
overview, 2-2
specifying budget criteria, 2-6
specifying worksheet options, 2-8
update balances manually, 2-10
update budget balances (overview), 2-10
update budget balances using rules, 2-10
upload budget balance to Interface Table, 2-12
upload budgets from ADI to GL, 2-12

working with open budget worksheets, 2-9
budget worksheet

creating, 2-2
limiting accounts, 2-7
opening, 2-4
saving to disk, 2-4
working with open worksheets, 2-9

C
cancelling requests

using Request Center, 9-31
child ranges

merging in Account Hierarchy Editor, 6-6
child values

add in Account Hierarchy Editor, 6-4
column exceptions

defining, 4-12
column set, 1-9
command line

submission and publishing options, D-2
comparison program

viewing results in Inventory Wizard, 8-7
content sets

adding hierarchy, 4-14
creating, 4-13
managing, 4-13
overview, 1-9
specifying hierarchy attributes, 4-15

Create Asset Wizard
create layout templates, 7-4
creating asset worksheets, 7-2
overview, 7-2
post assets, 7-7
upload asset data, 7-5
upload asset data to interface table, 7-6

creating
journal entries, 3-7
journal worksheet, 3-2
physical inventory worksheet, 8-2

customizing
journal worksheet, 3-4
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D
database

using applications database, 1-6
display group, 1-10

E
encumbrances

creating journal entries, 3-8

F
foreign actuals

creating in Journal Wizard, 3-8
formatting reports

apply formatting for expanded rows, 9-27
token description for all reports, 9-22
tokens in report themes, 9-21
using line item token images, 9-24
using line item tokens, 9-23

FSG reports
inputs parameters for ADIQCCOM, D-3

functional actuals
creating journal entries, 3-8

G
General Ledger

Report Wizard, 4-2
graph

creating graphs with budget values, 2-15
graphically viewing budgets, 2-15

H
hierarchies

add in Account Hierarchy Editor, 6-8
specifying attributes for content sets, 4-15

I
import

budget balances from Interface Table to 
GL, 2-14

import data

to worksheet, B-2
import text files

overview, B-2
interface table

importing journals to GL, 3-14
Inventory Wizard

creating physical inventory worksheet, 8-2
overview, 8-2
prerequisites, 8-2
upload inventory data, 8-4
upload inventory data from worksheet, 8-5
viewing results of comparison program, 8-7

J
journal entries

creating, 3-7
creating with ADI, 3-7
upload from worksheet to interface table, 3-12
uploading, 3-10

journal upload process
profile options, 3-10

Journal Wizard
creating budget entries, 3-8
creating encumbrances, 3-8
creating foreign actuals entries, 3-8
creating functional actuals, 3-8
creating journal entries, 3-7
creating journal worksheet, 3-2
customizing journal worksheets, 3-4
customizing worksheet, 3-4
overview, 3-2

journal worksheet
creating, 3-2
creating additional worksheets, 3-4
customizing, 3-4
opening saved worksheet, 3-4
saving to disk, 3-4

journals
importing from interface table to GL, 3-14

L
language

options for ADI, C-8
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ledger options
specifying for toolbar, C-4

limiting
accounts in Budget Wizard, 2-7

line item image tokens
formatting reports, 9-24

line item tokens
description, 9-23

M
mapping templates

create, B-2

O
output type options

specifying using Request Center, 9-10

P
parent hierarchies

duplicate in Account Hierarchy Editor, 6-9
parent values

add in Account Hierarchy Editor, 6-3
parent/child ranges

adding in Account Hierarchy Editor, 6-5
Physical Inventory Wizard

creating physical inventory worksheet, 8-2
overview, 8-2
prerequisites, 8-2
upload inventory data, 8-4
upload inventory data from worksheet, 8-5

post assets
from interface table to Oracle Assets, 7-7

profile option
Concurrent: Report Copies, A-5

profile options
Create Group ID, 3-11
FA: Security Profile, 7-2
Flexfields: Validate On Server, 3-11
GL AHE: Saving Allowed, 6-2
GLDI: Allow Drilldown Across Books, 5-3
GLDI: Analysis Wizard Privileges, 5-3
GLDI: Balance by Accounting Date, 3-11

GLDI: Converted Entry Threshold, 3-11
GLDI: Force Full Validation, 3-11
GLDI: Force Journal to Balance, 3-11
GLDI: Journal Source, 3-8
GLDI: Maximum Effective Ranges for 

Drilldown, 5-3
publishing reports

using Request Center, 9-8

R
Record Physical Inventory Wizard

creating physical inventory worksheet, 8-2
overview, 8-2
prerequisites, 8-2
upload inventory data, 8-4
upload inventory data from worksheet, 8-5
viewing results of comparison program, 8-7

reduction criteria, 1-9
report

change row/column properties, 4-9
create blank, 4-5
create using report components, 4-6
load existing, 4-8
opening saved report, 4-8
publish automatically using Request 

Center, 9-16
publish manually using Request Center, 9-17
save to database, 4-12
save to local disk, 4-13
specify publishing options, 9-16
specify report printing options, 9-14
specify report submission options, 9-14
submit financial statements using Request 

Center, 9-5
submit RXi reports using Request Center, 9-7
submit using Request Center, 9-3

report formatting
applying cell level formatting, 9-25
formatting individual cells, 9-25

report log
viewing, 9-28

report objects
specifying for ad hoc reports, 9-15

report output
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viewing, 9-28
report publishing options

specifying, 9-16
report themes

overview of using tokens, 9-21
Report Wizard, 4-2

adding account assignments, 4-9
adding hierarchy to content sets, 4-14
adding or deleting rows and columns, 4-8
change row/column properties, 4-9
content sets (managing), 4-13
create blank report, 4-5
create report using report components, 4-6
creating content set, 4-13
defining column exceptions, 4-12
interface, 4-2
managing content sets, 4-13
opening existing report, 4-8
opening saved report, 4-8
overview, 4-2
performing row/column calculations, 4-10
save reports to database, 4-12
save reports to local disk, 4-13
specifying hierarchy attributes, 4-15
tools, 4-3

Request Center
applying attributes, 9-13
applying themes, 9-10
cancelling requests, 9-31
changing template options, 9-8
formatting with line Item tokens, 9-23
monitor requests, 9-28
opening publishing page, 9-10
overview, 9-2
publishing report automatically, 9-16
publishing report manually, 9-17
publishing reports, 9-8
report printing options, 9-14
report submission options, 9-14
requests (start monitoring), 9-29
requests (stop monitoring), 9-31
shortcut keys, E-4
specify report publishing options, 9-16
specifying options, 9-3, C-7
specifying output type options, 9-10

starting, 9-3
submit ad hoc reports, 9-5
submit financial statements, 9-5
submitting reports, 9-3
submitting RXi report, 9-7
submitting standard reports, 9-4
theme (changing current), 9-18
theme (creating), 9-18
themes, 9-17
themes (applying), 9-10
themes (customizing), 9-19
themes (formatting with tokens), 9-21
tokens in report themes, 9-21
using themes, 9-17

requests
monitor using Request Center, 9-28

responsibility
changing, 1-8
choosing, 1-7

rollup groups
creating in Account Hierarchy Editor, 6-12

row set, 1-9
row/column calculations

performing, 4-10
RXi reports

submitting, 9-7

S
segment values

find in Account Hierarchy Editor, 6-11
modify description in Account Hierarchy 

Editor, 6-7
shortcut keys

ADI toolbar, E-2
Request Center, E-4

standard reports
submitting, 9-4

standard variable format reports
token description, 9-23

T
templates

changing options using Request Center, 9-8
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create layouts in Create Asset Wizard, 7-4
create mapping templates, B-2

themes
applying, 9-10
changing current, 9-18
creating, 9-18
customizing, 9-19
overview, 9-17
tokens in reports, 9-21

tokens
description for all reports, 9-22
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